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Sammanfattning

Calligra Sheets är ett fullständigt kalkylprogram.



Handbok Calligra Sheets

Kapitel 1

Inledning

Den här handboken är tillägnad minnet av Visicalc.

VIKTIGT
Besök gärna http://docs.kde.org för uppdaterade versioner av detta dokument.

Calligra Sheets är ett kalkylprogram med fullständig funktionalitet. Det är en del av Calligra
produktivitetssviten för KDE.

Exempel på övriga Calligra-program är bland annat Calligra Words (ordbehandling) och Calligra
Stage (skapa OH-presentationer).

Du kanske också vill besöka http://www.kde.org för mer information om KDE i allmänhet, eller
Calligras webbplats på http://www.calligra.org.
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Kapitel 2

Calligra Sheets grunder

Pamela Robert
Översättare: Stefan Asserhäll

NOT
Liksom övriga KDE, har Calligra Sheets många inställningsmöjligheter, som kan orsaka problem för
läsare som försöker jämföra texten i ett dokument som det här, med vad de ser i den version av Calligra
Sheets som kör på deras skrivbord. För att skära bort några av möjligheterna till förvirring, föreslår vi
att du väljer de förvalda alternativen på alla sidor i Calligra Sheets inställningsdialogruta när du först
börjar använda Calligra Sheets (de erhålls genom att välja Inställningar → Anpassa Tables...).

2.1 Kalkylblad för nybörjare

Det här avsnittet försöker förklara, med hjälp av exempel, vad ett kalkylprogram som Calligra
Sheets i själva verket gör, och varför det är ett så användbart verktyg när man måste hantera tal.
Om du redan har använt ett kalkylprogram, så kanske du vill gå direkt till nästa avsnitt.

Det första du ska göra, är att starta Calligra Sheets. Du kan göra det genom att vänsterklicka på
Calligra Sheets ikon, om det finns en på skrivbordet eller i panelen, eller du kan välja Kontor
→ Calligra Sheets i programstartmenyn.
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När det har startat får du valet att öppna senaste dokument, skapa ett nytt dokument från en mall
(med mallkategorier) eller öppna ett befintligt dokument. Välj kategorin Allmänt till vänster och
välj mallen Tomt arbetsblad. Klicka därefter på knappen Använd den här mallen.

Om du tittar på Calligra Sheets när det väl har startat, ser du en tabell med tomma rektangulä-
ra celler, arrangerade i rader med nummer och kolumner med bokstäver. Det är här som data,
formler, text eller diagram matas in.

Skriv nu in den text och de värden som visas i de fem första raderna på skärmbilden ovan, i
samma celler på kalkylbladet. Ignorera vad som finns på rad 7 för ögonblicket. För att skriva in
något i en cell, markera först cellen genom att vänsterklicka inne i den, skriv därefter vad du vill,
och tryck sedan på Enter eller använd piltangenterna för att flytta markeringen till en annan cell.

Vad vi har skrivit in hittills skulle kunna vara en enkel budget för följande två månader, som
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listar hur mycket vi tänker spendera på Mat, Bostad, Kläder och Övriga kostnader. Välj nu cell
B7 (kolumn B, rad 7), skriv in =B2+B3+B4+B5 och tryck på Enter. Eftersom detta börjar med
tecknet =, anser Calligra Sheets att det är en formel, något som måste beräknas, i det här fallet
genom att summera värden i de fyra cellerna B2 till B5, och vad som visas i cell B7 är resultatet
av beräkningen.

Du skulle kunna skriva in en liknande formel i cell C7, utom att i det här fallet skulle det behöva
vara =C2+C3+C4+C5, men det finns ett enklare sätt, nämligen att kopiera innehållet i cell B7 och
klistra in det i C7. Calligra Sheets justerar automatiskt cellreferenserna från B.. till C.. när värdet
klistras in.
Just nu kanske du tycker att Calligra Sheets inte gör mer än du skulle kunna hantera med penna,
papper och en miniräknare, och det kan vara riktigt, men kom ihåg att det här är ett mycket
litet exempel på ett kalkylblad, som gör enkla beräkningar med ett fåtal värden. För alla rimligt
stora tabeller med värden eller data, är det mycket snabbare och noggrannare att använda ett
kalkylblad för att göra beräkningarna, än att göra dem för hand.

Dessutom låter ett kalkylblad dig leka ‘Vad händer om?’ Eftersom varje formel automatiskt räk-
nas om så fort något av de värden som den beror på ändras, så kan man snabbt se vad som
händer om något av dem ändras. Med vårt exempel, så kan man se effekten av att reducera kost-
naden för mat i december, genom att helt enkelt skriva in ett nytt värde i cell C2. Eller om ett
kalkylblad noggrant modellerade växthuseffekten, skulle man till exempel kunna se effekten av
en 50 procentig minskning av metankoncentrationen.

2.2 Markera celler

Du kan välja en enda cell, eller ett rektangulärt område, i kalkyltabellen. De markerade cellerna
visas med en tjock svart kant.

DU KAN VÄLJA EN ENSAM CELL PÅ ETT AV FÖLJANDE SÄTT

• vänsterklicka på den

• skriv in cellreferensen (till exempel B5) i cellreferensrutan i vänsterkanten av Celleditorn un-
der verktygsalternativ och tryck på Enter

• använd menyalternativet Gå → Gå till cell...

Du kan också flytta runt med piltangenterna. Genom att trycka på tangenten Enter flyttas den
nuvarande markeringen ett steg uppåt, neråt, åt vänster eller åt höger, beroende på inställningen
på sidan Diverse i Calligra Sheets inställningsdialogruta.

Om du håller nere Skift-tangenten medan piltangenterna används, så flyttas markeringen till
början eller slutet av blocket med använda celler.

För att välja ett område med celler, dra musmarkören över det önskade området med vänster
musknapp nertryckt, eller skriv in referenserna för övre vänstra och nedre högra cellen skilda av
ett kolon i cellreferensrutan Celleditor (till exempel B7:C14 ) och tryck på Enter, eller skriv in
cellreferenserna med ett liknande format i dialogrutan som visas med Gå → Gå till cell....
Du kan också välja ett område med celler genom att markera cellen i ett hörn av det önskade om-
rådet, och sedan hålla nere Skift-tangenten medan vänster musknapp används för att markera
cellen i motsatt hörn.
För att välja celler som inte är intilliggande, klicka på den första cellen du vill markera och håll
därefter ner Ctrl-tangenten medan övriga celler markeras.

För att välja en hel rad eller kolumn med celler, vänsterklicka på radnumret till vänster om ta-
bellen eller kolumnens bokstav över tabellen. För att välja intilliggande rader och kolumner, dra
muspekaren över motsvarande radnummer eller kolumnbokstäver med vänster musknapp ner-
tryckt.

För att välja rader eller kolumner av celler som inte är intilliggande, klicka på det första radnum-
ret eller den första kolumnbokstaven och håll därefter ner Ctrl-tangenten medan övriga rader
eller kolumner markeras.
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2.3 Skriva in data

Att skriva in data in en cell kan vara så enkelt som att markera cellen, skriva data, och därefter
trycka på Enter eller flytta markeringen till en annan cell med någon av piltangenterna. Beroende
på hur du skriver in data, tolkas det av Calligra Sheets som ett tal, datum, tid eller text:

• Nummer skrivs in på det självklara sättet, 123, -123, 456,7 eller med vetenskaplig notation
1,2E-5.

• Datum ska skrivas in med ‘systemformatet’, som det definieras i systeminställningarnas di-
alogruta Region → Land/region och språk → Datum och tid. Om du till exempel använder
formatet ÅÅÅÅ-MM-DD, ska du skriva in 2012-03-30 för 30:e mars, 2012. Inledande nollor
kan utelämnas i dagen och månaden och bara den sista eller de två sista siffrorna av året måste
skrivas in om datumet gäller nuvarande århundrade, till exempel 9-1-9 för 9:e januari, 2009.

• Tider ska också skrivas in med ‘systemformatet’. Om du till exempel använder en 24-
timmarsklocka, skriv då in tider som TT:MM eller TT:MM:SS, som 9:42 eller 22:30:52.

• Calligra Sheets definierar all inmatad data som ‘text’ om det inte kan tolkas som ett nummer,
datum eller tid.

NOT
Normalt högerjusterar Calligra Sheets nummer, datum och tider inne i en cell, och vänsterjusterar allt
annat. Detta kan vara en användbar indikation på om du skrev in ett datum eller en tid med rätt format.
Men kom ihåg att sättet som objekt visas kan ändras, genom att ändra cellformatet.

Huvudrutan för textinmatning under verktygsalternativen i Celleditor tillhandahåller ett enkelt
sätt att redigera innehållet av en markerad cell. Tryck på Enter eller vänsterklicka på den grö-
na bocken när du är nöjd med det du skrivit in, eller klicka på det röda korset för att avbryta
redigeringen.

2.3.1 Generellt cellformat

Calligra Sheets använder cellformatet ‘Generellt’ som förval. Så länge det formatet används, de-
tekterar Calligra Sheets automatiskt den verkliga datatypen beroende på aktuell celldata. Om du
till exempel skriver in text i en cell och senare skriver in ett tal i samma cell, tolkar Calligra Sheets
automatiskt det nya värdet som ett tal. Om du vill definiera datatypen själv, kan du explicit ange
den under cellformat. Du kan ändra formatet tillbaka till ‘Generellt’ när som helst.

2.4 Kopiera, klippa ut och klistra in

Vid första påseendet, verkar Calligra Sheets Klipp ut, Kopiera och Klistra in likna samma funk-
tioner i andra KDE-program. När en cell eller flera celler har markerats, kan du välja Kopiera
eller Klipp ut i menyn Redigera eller i menyn som visas genom att hålla nere höger musknapp
på en markerad cell, eller genom att använda snabbtangenterna Ctrl+C eller Ctrl+X. Därefter kan
du flytta markeringen till cellen där du vill klistra in, och välja Klistra in eller trycka på Ctrl+V.
Det finns dock vissa hårfina skillnader som hör ihop med de här funktionerna i Calligra Sheets,
som beskrivs nedan.
Om en cell innehåller en formel, så kopieras själva formeln istället för resultatet som visas. Om
formeln innehåller en referens till en annan cell, så ändras referensen av operationerna Klipp ut
eller Kopiera och Klistra in så att den pekar på cellen som har samma relativa position som ori-
ginalcellen. Om till exempel cell A2 innehåller formeln =B3 och den kopieras till C4, så kommer
cell C4 att innehålla =D5.
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Det här kan verka vara ett ganska konstigt sätt att göra en kopia, men i 99 procent av fallen är
detta exakt vad man vill ha (om det inte är det, se avsnittet om absoluta cellreferenser). I den
enkla shoppinglistan som visas nedan, så ska cell D2 innehålla =B2 * C2, D3 ska vara =B3 *
C3, D4 ska vara =B4 * C4 och så vidare. Istället för att behöva skriva in en annorlunda formel
i varje cell, så kan man bara skriva in den första formeln i D2 och sedan kopiera den till cellerna
nedanför, och låta Calligra Sheets justera cellreferenserna så att de passar.

2.4.1 Kopiera och klistra in cellområden

I exemplet ovan kan D2 kopieras till alla tre cellerna D3 till D5 på en gång, genom att bara kopiera
D2 och därefter välja hela cellområdet innan man klistrar in.

Ett rektangulärt område med celler kan klippas ut eller kopieras på en gång genom att välja
området innan man klipper ut eller kopierar. Man väljer därefter övre vänstra hörnet på området
där resultatet ska klistras in, innan man klistrar in.

Om man klipper ut eller kopierar ett rektangulärt område med celler, till exempel B2:C3, och
klistrar in det i ett större område som A10:D13 så upprepas mönstret i det ursprungliga området
för att fylla det större området.

Calligra Sheets tillhandahåller också en metod för att ‘dra och kopiera’ celler till andra celler ome-
delbart nedanför eller till höger om de ursprungliga cellerna. För att använda den här metoden,
välj cellerna som ska kopieras och placera därefter muspekaren över den lilla svarta fyrkanten
i nedre högra hörnet av de markerade cellerna, så att markören ändras till en pil med två hu-
vuden. Håll därefter nere vänster musknapp medan de markerade cellerna dras så långt som
önskas. Observera att cellreferenserna i formler inkrementeras enligt den relativa positionsänd-
ringen. Absoluta referenser ändras inte.

2.4.2 Andra inklistringslägen

En cell kan innehålla text, ett värde eller en formel, och kan också innehålla särskild teckensnitts-,
kant- eller bakgrunds-formateringsinformation. Calligra Sheets har speciella versioner av Klistra
in, som låter dig hantera den här informationen på olika sätt.

Redigera → Klistra in special... visar dialogrutan Klistra in special. Genom att välja lämpligt
alternativ i den vänstra delen av dialogrutan, kan du välja att klistra in Allting, bara Text, cellens
Format, en eventuell Kommentar i cellen eller Allting utan kant. Alternativen i nedre delen av
dialogrutan låter dig utföra enkel aritmetik med ett cellområde.

Klistra in och infoga... infogar de kopierade cellerna i tabellen genom att flytta celler som annars
skulle skrivas över ett lämpligt antal rader eller kolumner neråt och till höger. Det kan också
användas för att infoga hela kopierade rader eller kolumner i tabellen.
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2.5 Infoga och ta bort

Använd tangenten Delete eller Redigera → Rensa → Innehåll för att ta bort texten, värdet eller
formeln från markerade celler, rader eller kolumner utan att påverka någonting annat.

För att ta bort allt i markerade celler, rader eller kolumner, även kommentarer och särskild for-
matering, använd alternativet Alla i menyn Redigera → Rensa, eller i menyn som visas när du
högerklickar på en markering.

För att helt och hållet ta bort markerade rader eller kolumner från tabellen, använd alternativen
Ta bort rader, eller Ta bort kolumner från menyn som visas med höger musknapp.

Om du markerar en eller flera celler och väljer Ta bort celler... i menyn som visas med höger
musknapp, kan du välja om andra celler på arbetsbladet ska flyttas upp eller åt vänster för att
fylla i utrymmet som lämnas av cellen eller cellerna som du har valt att ta bort.

Om du vill infoga nya tomma rader eller kolumner på bladet, markera raderna eller kolumnerna
där du vill att de nya raderna eller kolumnerna ska placeras, och välj alternativen Infoga rader
eller Infoga kolumner i menyn som visas med höger musknapp.

Du kan infoga nya celler på arbetsbladet genom att markera området där du vill att de ska visas,
och sedan välja alternativet Infoga celler... i menyn som visas med höger musknapp. Du blir då
tillfrågad om de befintliga cellerna i det markerade området ska flyttas ner eller till höger för att
ge utrymme för de nya.

2.6 Enkla summor

Om det första tecknet i en cell är ett likhetstecken (=) antar Calligra Sheets att cellens innehåll är
en formel som ska beräknas. Resultatet av beräkningen visas i cellen, istället för själva formeln.
Skriv till exempel in =2+3 i en cell, så ska resultatet 5 visas.

Mer användbart är att en formel kan innehålla referenser till andra celler, så att =B4+A3 beräknar
summan av värden i cellerna B4 och A3, och den här beräkningen uppdateras så fort cellerna B4
eller A3 ändras.
Förutom addition, kan en formel använda symbolen - för subtraktion, * för multiplikation och /
för att utföra division. Runda parenteser ( och ) kan också användas som i vanlig algebra, så att
du kan skriva in sammansatta formler såsom =((B10 + C3) *5 - F11) / 2 .
Celler som innehåller en formel, markeras med en liten blå triangel i nedre vänstra hörnet om
kryssrutan Visa formelindikering i dialogrutan Format →Arbetsblad →Egenskaper för arbets-
blad är markerad.
Calligra Sheets innehåller också ett stort antal inbyggda formler för beräkningstillämpningar in-
om statistik, trigonometri och finans. Hur de används betraktas mer ingående i ett senare avsnitt i
handboken, men om du redan är intresserad nu, välj Funktion... i menyn Infoga och titta igenom
dialogrutan Funktion som visas.

För tillfället kan formeln SUM vara intressant, eftersom den beräknar summan av alla värden i ett
angivet område med celler. Till exempel så beräknar =SUM(B4:C10) summan av alla värden i
cellområdet B4 till C10.
Om Calligra Sheets visar en rad med symbolen # när du har skrivit in formeln, så betyder det här
oftast att det inte går att tolka vad du har skrivit in, men om raden med # slutar med en liten röd
pil, betyder det bara att cellen inte är bred nog att visa hela resultatet. I detta fall bör du antingen
göra cellen bredare eller ändra formatet så att resultatet får plats.

2.6.1 Räkna om

Om rutan Automatisk omräkning i dialogrutan Format →Arbetsblad →Egenskaper för arbets-
blad är markerad, så räknar Calligra Sheets om värden i celler så fort något som påverkar dem
ändras.
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När Automatisk omräkning inte är markerad för nuvarande arbetsblad, kan du begära att Calli-
gra Sheets utför en omräkning när som helst, genom att använda alternativen Räkna om arbets-
blad eller Räkna om dokument i menyn Verktyg eller snabbtangenterna Skift+F9 eller F9.

2.7 Sortera data

I det enkla exemplet nedan, består data av namn och länder för ett antal berg, tillsammans med
deras höjd över havet. Calligra Sheets låter oss sortera sådan data på olika sätt.

Vi kanske vill sortera data så att namnen är i alfabetisk ordning. Markera området som innehåller
data (A2:C7 i detta fall) och välj Sortera... i menyn Data för att göra det. Det visar dialogrutan
Sortera.
Sortering görs alfanumeriskt, och är normalt skiftlägeskänslig. Nummer kommer före stora bok-
stäver, som kommer före små bokstäver, så att celler som innehåller Cykel, bar, 77 och Båge
skulle sorteras i följande ordning: 77 Båge Cykel bar.

Välj att sortera enligt rader eller kolumner i rutan Riktning i dialogrutan. Om du markerar rutan
Första raden innehåller kolumnrubriker eller Första kolumnen innehåller radrubriker ingår
inte data i första raden eller kolumnen i sorteringen.

Raderna eller kolumnerna sorteras i angiven ordning, vilket kan ändras med knapparna Flytta
upp och Flytta ner. Med användning av exemplet på skärmbilden ovan, att välja kolumn B som
första nyckel och kolumn C som andra, skulle sortera data enligt land, och för varje land, enligt
höjd.

Avmarkera alternativet Skiftlägeskänslig för att få en sortering som inte beror på bokstävernas
storlek, och byt sorteringsordning mellan Stigande och Fallande genom att klicka på cellerna i
kolumnen Sorteringsordning.

Sidan Detaljer > > i dialogrutan låter dig sortera genom att använda ordningen hos objekt som
januari, februari, ... istället för alfanumeriskt. Cellformatet flyttas med cellinnehållet om du väljer
Kopiera cellformatering (kanter, färger, textstil).

2.8 Statusradens summeringsräknare

Vänstra delen av statusraden visar en summering av värden i markerade celler. Beroende på in-
ställningen i kombinationsrutan Funktion som visas i statusraden på sidan Gränssnitt i Calligra
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Sheets inställningsdialogruta, kan summeringen vara:

Inget

Ingen summeringsberäkning utförs.

Normal
Värdet som visas är medelvärdet av alla värden i de markerade cellerna.

Antal
Värdet som visas är antalet celler som innehåller numeriska värden.

AntalA
Värdet som visas är antalet celler som inte är tomma.

Max
Värdet som visas är maximum av alla värden i de markerade cellerna.

Min
Värdet som visas är minimum av alla värden i de markerade cellerna.

Summa
Värdet som visas är summan av alla värden i de markerade cellerna.

Beräkningsmetoden kan också ändras genom att högerklicka på resultatområdet för summe-
ringsberäkningen i statusraden, och välja ett alternativ i menyn som visas.

2.9 Spara ditt arbete

Calligra Sheets sparar hela dokumentet, som kan innehålla mer än ett arbetsblad, som en enda
dokumentfil.
Om du har skapat ett nytt dokument, eller vill spara en befintlig med ett annat namn, använd
Arkiv → Spara som.... Det visar KDE:s vanliga dialogruta Spara dokument som. Välj katalog
där du vill spara dokumentet, och skriv in ett lämpligt filnamn i textrutan Namn. Calligra Sheets-
dokument sparas normalt automatiskt med filändelsen .ods, så du behöver inte lägga till det här
till filnamnet, men försäkra dig om att alternativet Filter: är inställt på OASIS OpenDocument
kalkylark.

För att spara dokumentet utan att ändra namn, använd bara Arkiv → Spara.

Du kan också spara ett Calligra Sheets-dokument med ett främmande format, genom att välja
formatat i kombinationsrutan Filter:.
När du sparar en ändrad version av ett befintligt dokument, så behåller Calligra Sheets den
föregående versionen som en säkerhetskopia, och lägger till symbolen ~ i slutet på filnamnet.

Calligra Sheets erbjuder ett visst skydd mot att förlora arbete på grund av en datorkrasch eller på
grund av att du stängt Calligra Sheets utan att spara det nuvarande dokumentet. Detta görs ge-
nom att automatiskt spara den senaste versionen av dokumentet som du arbetar med med några
minuters mellanrum med ett ändrat filnamn. Versionen som sparas automatiskt tas normalt bort
när du sparar dokumentet nästa gång, så att den bara finns om den är aktuellare än versionen
som du sparar för hand. När du öppnar ett dokument, kontrollerar Calligra Sheets om en ver-
sion som sparats automatiskt finns, och om en sådan hittas, får du erbjudande om att öppna den
i stället.
Automatiskt sparade dokument sparas med ett filnamn på formen .ditt_filnamn.autosave (ob-
servera den inledande punkten), så att blad1.ods skulle sparas automatiskt som .blad1.ods.au
tosave. Funktionen för att spara automatiskt kan anpassas i inställningsdialogrutan.
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2.9.1 Mallar

Om du kommer att skapa många liknande dokument, kan du spara tid och besvär genom att
först skapa en mall och sedan använda den som grund till de enskilda dokumenten.

För att göra det, skapa först ett dokument som innehåller de gemensamma delarna, och spara den
sedan som en mall genom att välja Arkiv → Skapa mall från dokument. När detta görs öppnas
dialogrutan Skapa en mall. Skriv in namnet på den nya mallen i textrutan Namn: och klicka på
Ok. Nästa gång du skapar ett nytt dokument genom att välja Arkiv → Ny eller nästa gång du
startar Calligra Sheets, så ger dialogrutan Välj dig möjlighet att skapa det nya dokumentet från
din mall.
Dialogrutan Skapa en mall låter dig också välja en annan bild som visas ovanför mallnamnet
i startdialogfönstret, och låter dig spara mallarna med olika gruppnamn, som visas som olika
flikar i dialogfönstret.

Mallar lagras som .kst-filer under ~/.kde/share/apps/tables/templates/ .

2.10 Skriva ut ett kalkylblad

Att skriva ut ett kalkylblad görs helt enkelt genom att välja Arkiv → Skriv ut..., som visar KDE:s
vanliga dialogruta Skriv ut där du kan välja, bland andra alternativ, skrivaren som ska användas,
antal kopior och om alla eller bara valda sidor ska skrivas ut.

Normalt skriver Calligra Sheets ut alla objekt på det nuvarande arbetsbladet, men du kan be-
gränsa detta genom att först markera området du vill skriva ut, och sedan välja Ange utskrifts-
intervall i undermenyn Format → Utskriftsintervall.

Calligra Sheets skriver ut så många sidor som behövs för att få med alla objekt på det nuvarande
arbetsbladet. Du kan snabbt se hur ett arbetsblad delas i skilda sidor för utskrift genom att mar-
kera rutan Visa → Visa sidkanter. Kanterna för varje sida som skrivs ut markeras då med röda
linjer på arbetsbladet.

Välj Arkiv → Förhandsgranska utskrift..., för en mer detaljerad vy av vad som kommer att skic-
kas till skrivaren, inklusive allt som du har begärt ska finnas med i sidhuvud och sidfot (se ne-
dan).

För att förbättra utseendet på utskriften, kan du ändra teckensnitt, färger, kanter och storlekar för
cellerna på arbetsbladet, se avsnittet Formatera kalkylblad för mer information om hur man gör
detta.
Du kan också använda dialogrutan Sidlayout, som visas genom att välja Format → Sidlayout...,
för att ändra orientering på de utskrivna sidorna, pappersstorlek (den bör vara lämplig för skri-
varen) och storleken på marginalerna.

Arbetsblad ger fler alternativ. Rutan Utskriftsinställningar låter dig välja om rutnät, kommen-
tarindikering och formelindikering, objekt och diagram ska skrivas ut eller inte. Rutan Upp-
repningar på varje sida tillhandahåller ett alternativt sätt att begränsa utskriften till en del av
arbetsbladet och låter dig upprepa valda kolumner eller rader på varje utskriven sida. I rutan
Skalning kan du ställa in en skalfaktor eller begränsa antal sidor för utskrift.
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Kapitel 3

Formatera kalkylblad

Pamela Robert
Raphael Langerhorst
Anne-Marie Mahfouf
Översättare: Stefan Asserhäll

3.1 Cellformat

För att ändra format och utseende på markerade celler, rader eller kolumner använd alternativet
Cellformat... i menyn Format eller från menyn som visas med höger musknapp.

Det visar dialogrutan Cellformat som har flera flikar:
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3.1.1 Dataformat och representation

Sidan Dataformat i dialogrutan Cellformat, låter dig styra hur värden i cellen visas.

Övre delen av den här sidan låter dig välja format som används vid visning av numeriska värden,
datum eller tider. En Förhandsgranskning låter dig se det nya formatets effekt.

Du kan ställa in samma dataformat för en rad eller kolumn genom att markera raden eller ko-
lumnen och anropa dialogrutan Cellformat med höger musknapp.

NOT
Du kan öka decimala precisionen för vilket nummer som helst med formaten Generellt, Nummer,

Procent, Valuta eller Vetenskaplig med ikonen Öka precision i formatverktygsraden.
Du kan minska decimala precisionen för vilket nummer som helst med formaten Generellt, Nummer,

Procent, Valuta eller Vetenskaplig med ikonen Minska precision i formatverktygsraden.

Generellt
Det här är förvalt format och Calligra Sheets detekterar automatiskt den verkliga datatypen
beroende på aktuell data i cellen. Normalt högerjusterar Calligra Sheets nummer, datum
och tider i en cell, och vänsterjusterar allt annat.
Om det generella formatet inte passar dig kan du byta till ett specifikt format bland alter-
nativen nedanför.

Nummer
Notationen för nummer använder den notation som du väljer globalt i systeminställning-
arna med Region → Land/region och språk → Siffror. Siffror högerjusteras normalt.

Procent
När du har ett nummer i aktuell cell och ändrar cellformat från Generellt till Procent, mul-
tipliceras den aktuella cellens nummer med 100.
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Om du till exempel skriver in 2 och ställer in cellformatet till Procent, blir numret 200 %.
Genom att byta tillbaka till Generellt cellformat återställs det till 2.

Du kan också använda procentikonen i formatverktygsraden.

Valuta
Formatet Valuta konverterar numret till valutanotation med inställningarna som fastställts
globalt i systeminställningarna med Region → Land/region och språk → Valuta. Valuta-
symbolen visas, och precisionen blir den som ställts in i systeminställningarna.
Du kan också använda ikonen Valutaformat i verktygsraden Format för att ställa in cellfor-

matet så att det ser ut som din aktuella valuta:

Vetenskaplig

Det vetenskapliga formatet ändrar numret så att vetenskaplig notation används. Till exem-
pel ändras 0,0012 till 1,2E-03. Genom att gå tillbaka till Generellt cellformat visas 0,0012
igen. Det generella celldataformatet behåller inte vetenskaplig notation, så om du vill ha
denna notation måste du ange det med det här menyalternativet.

Bråkdel
Bråkformatet ändrar numret till ett bråk. Exempelvis kan 0,1 ändras till 1/8, 2/16, 1/10, etc.
Du definierar bråkets typ genom att välja den i fältet till höger. Om det exakta bråket inte
är möjligt med bråkläget du väljer, väljes det närmaste möjliga värdet. Om vi exempelvis
har 1,5 som nummer, och väljer Bråk och Sextondelar 1/16, är texten som visas i cellen ˝1
8/16˝, vilket är ett exakt bråk. Om du har 1,4 som nummer i cellen och väljer Bråk och
Sextondelar 1/16, visar cellen ˝1 6/16˝, vilket är det närmaste sextondelsbråket.

Datum
När du skriver in ett datum ska du använda ett av formaten som ställs in i systeminställ-
ningarna under Region → Land/region och språk → Datum och tid. Det finns två format
som ställs in där: datumformatet och det korta datumformatet.
Ett slumpmässigt naturligt tal NN transformeras till datumet den 30:de december 1899
(som är 0) med antal dagar NN tillagda. Om du till exempel har en cell med 100 och du
väljer formatet Datum, visas ˝1900-04-09˝ i cellen, vilket är 100 dagar efter 30:de december
1899. Startdatum är två dagar för tidigt eftersom det fanns ett fel i Lotus 123, som förblev på
samma sätt i Excel för att behålla samma funktion. Det är ändå bara några få som behöver
räkna från 1:a januari 1900, och att till exempel lägga till 9 dagar till 1:a november 2000 ger
dig 10:e november 2000, så alla normala beräkningar med datum är riktiga.

NOT
När en cell har formatet Datum kan du dra cellen neråt som du gör med nummer så får följande
celler också datum, där varje datum ökas med en dag.

Tid
Det här formaterar cellinnehållet som en tid. För att skriva in en tid ska du använda
Tidsformat som ställs in i systeminställningarna under Region → Land/region och språk
→ Datum och tid. I dialogrutan Cellformat kan du ställa in hur tiden ska visas genom att
välja ett av de tillgängliga tidsformaten. Förvalt format är systemformatet som ställs in i
systeminställningarna. När numret i cellen inte är vettigt som en tid, visar Calligra Sheets
00:00 med det globala formatet du har i systeminställningarna.

Datum och tid
Det här formaterar cellinnehållet som datum och tid. För att skriva in ett datum och
en tid ska du använda Tidsformat som ställs in i systeminställningarna under Region
→ Land/region och språk → Datum och tid. I dialogrutan Cellformat kan du ställa in hur
datum och tid ska visas genom att välja ett av de tillgängliga datum- och tidsformaten.
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Förvalt format är systemformatet som ställs in i systeminställningarna. När numret i cellen
inte är vettigt som datum och tid, visar Calligra Sheets 00:00 med det globala formatet du
har i systeminställningarna.

Text
Det här formaterar cellinnehållet som en text. Det kan vara användbart om du vill att ett
nummer ska behandlas som text istället för ett nummer, till exempel för ett postnummer.
Att ställa in ett nummer med textformat vänsterjusterar det. När nummer formateras som
text kan de inte användas i beräkningar eller formler. Det ändrar också hur cellen justeras.

Egen

Fungerar inte ännu. Kommer att aktiveras i nästa utgåva.

Nedre delen av sidan Dataformat låter dig lägga till ett Prefix som en $ symbol i början av varje
värde, eller ett Postfix som ˝ kr˝ i slutet. Du kan också styra hur många siffror som visas efter
decimalkommat för numeriska värden, om positiva värden visas med ett inledande plustecken
och om negativa värden visas med röd färg.

3.1.2 Teckensnitt och textinställningar

Sidan Teckensnitt låter dig välja teckensnittsfamilj, Stil:, Storlek:, Vikt: och Färg: för nuvarande
cell, inklusive några ytterligare alternativ som understruken eller överstruken text. Den nedre
delen av sidan visar en förhandsgranskning av det valda textformatet.

Förvalt teckensnitt ställs in för alla celler i menyn Format → Stilhantering med stilen som för
närvarande används.

Stil:
Välj teckensnittets stil för cellerna som för närvarande är markerade. När du markerar flera
celler med olika stilar, ställs den visade stilen in till Varierade (ingen ändring) och genom
att lämna den sådan behålls alla de nuvarande stilinställningarna för varje cell. Att till ex-
empel ändra till Romersk ändrar alla markerade cellers textstil till Romersk.
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Storlek:
Välj teckenstorlek för cellerna som för närvarande är markerade. När du markerar flera
celler med olika storlekar, ställs den visade storleken in till (inget värde visas) och genom
att lämna den sådan behålls alla de nuvarande storleksinställningarna för varje cell. Att till
exempel ändra till 14 ändrar alla markerade cellers teckenstorlek till 14.

Vikt:
Välj teckensnittets vikt för cellerna som för närvarande är markerade. När du markerar
flera celler med olika vikter, ställs den visade vikten in till Varierade (ingen ändring) och
genom att lämna den sådan behålls alla de nuvarande viktinställningarna för varje cell. Att
till exempel ändra till Fet ändrar alla markerade cellers textvikt till Fet.

Färg:
Välj färg för den aktuella cellens text. Genom att klicka på färgraden får du fram KDE:s
vanliga färgvalsdialogruta, där du kan välja den nya färgen.

Understruken
Stryker under texten i aktuell markerad cell om markerat. Det är inte normalt markerat.

Stryk över
Texten i aktuell cell blir överstruken om det här är markerat. Det är inte normalt markerat.

3.1.3 Textposition och rotation

Under fliken Position kan du styra positionen för text inne i en cell genom att göra lämpliga val
i sektionerna Horisontell och Vertikal, eller genom att välja värde på Indentering. Du kan också
låta text visas vertikalt istället för horisontellt, eller till och med i en vinkel.

Horisontell
Ställ in innehållets horisontella position i cellen. Standard är förval och ställs in från for-
matet du väljer. Vänster betyder att innehållet visas till vänster i cellen. Centrerat betyder
att innehållet är i mitten horisontellt i cellen. Höger betyder att innehållet visas till höger i
cellen.
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Vertikal
Ställ in innehållets vertikala position i cellen. Överst betyder att innehållet visas till längst
upp i cellen, Mitten betyder att innehållet är i mitten vertikalt i cellen. Underst betyder att
innehållet visas längst ner i cellen.

Textalternativ
Det här är bara tillgängligt när rotationen är 0. Radbryt text radbryter texten så att den
passar i den tidigare cellstorleken. Om det inte är markerat, förblir texten på en rad.
Vertikal text visar texten vertikalt.

Rotation
Texten visas orienterad med vinkeln du ställer in här. Positiva värden flyttar den moturs
och negativa värden flyttar den medurs.

Sammanfoga celler

Om markerat får det här samma effekt som Format → Sammanfoga celler. Minst två sam-
manhängande celler måste vara markerade. De sammanhängande cellerna sammanfogas
då till en större.
När en sammanfogad cell markeras och det här avmarkeras, återställs cellerna till sina
ursprungliga storlekar som innan de sammanfogades. Det får samma effekt som Format
→ Dela upp cell.

Indentera
Ställ in hur mycket indentering som används i cellen när du väljer åtgärderna Öka inden-
tering eller Minska indentering i verktygsraden. Åtgärderna är inte normalt aktiverade i
verktygsraden.

Cellstorlek
Här ställer du in cellens storlek, antingen en egen bredd och höjd eller förvald bredd och
höjd.

3.1.4 Cellkant
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Fliken Kant låter dig ställa in utseende på cellkanter. Om du har valt mer än en cell kan du
använda olika stilar på kanter mellan cellerna och de som omger det markerade området.

Välj först mönster och färg i sektionen Mönster under fliken Kant och tilldela sedan olika delar
av kanten genom att klicka på lämplig knapp i sektionen Kant, eller på en av knapparna i Förval.
Den vänstra knappen i Förval rensar alla tidigare tilldelade kanter. Observera att du också kan
lägga till en diagonal linje som överkorsar cellen.

3.1.5 Cellbakgrund

Cellens bakgrundsmönster och färg kan väljas på sidan Bakgrund.

Välj helt enkelt det önskade mönstret, och välj därefter mönstrets färg och bakgrundsfärgen.

Längst ner på sidan ser du en förhandsgranskning av den inställda cellbakgrunden.
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3.1.6 Cellskydd

Du kan ändra sättet som innehållet i en cell är skyddat på sidan Cellskydd.

Alla celler skyddas normalt (det betyder att cellinnehållet inte kan ändras), och för att cellskydd
ska vara aktivt måste du också skydda bladet med menyn Verktyg → Skydda arbetsblad... och
tillhandahålla ett lösenord. Du kan också dölja cellens formel för att skydda sättet du beräknar
formeln. Det kräver också att bladet är skyddat för att fungera. Du kan dölja cellinnehållet med
Dölj allt, och återigen krävs att bladet är skyddat. Du kan ta reda på mer om alla inställningarna
i kapitlet Avancerad användning av Calligra Sheets under avsnittet Skydd.

Dölj allt

Det här döljer cellinnehållet och fungerar bara när bladet är skyddat, vi&#314;ket betyder
att ändring av cellegenskapen Dölj allt inte har någon effekt om inte bladet är skyddat. Om
cellen själv är skyddad eller inte spelar ingen roll.
När Dölj allt är markerat, är Skyddat och Dölj formel inaktiverade, eftersom när bladet
är skyddat döljer Dölj allt cellinnehållet och formeln och maskerar och skyddar på så sätt
cellens innehåll.

Skyddat

Om markerad, är cellinnehållet skyddat. Det är förvalt beteende. Du måste skydda hela
bladet med menyn Verktyg → Skydda arbetsblad... för att det individuella cellskyddet ska
fungera. När en cell är skyddad kan dess innehåll inte ändras.

Dölj formel

Om det här är markerat är cellen fortfarande synlig, Dess innehåll visas dock inte i formel-
raden. Att dölja formeln fungerar bara för celler som innehåller formler, så att användaren
inte kan visa formeln. Bladet måste också vara skyddad för att det ska fungera.

Skriv inte ut text
Om du markerar Skriv inte ut text skrivs inte cellens text ut. Den är normalt inte markerad,
vilket betyder att cellinnehållet alltid normalt skrivs ut.
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3.2 Villkorliga cellegenskaper

Du kan också ändra utseende på en cell beroende på det värde den innehåller, som till exempel
är användbart om du använder Calligra Sheets för att hålla reda på hushållsutgifter och vill
färglägga alla värden som är större än, låt oss säga, 10 000 kr.

För att göra detta markera cellen eller cellerna och välj sedan Villkorliga stilar... i menyn Redige-
ra. Då visas dialogrutan Villkorliga stilar, där du kan ändra teckensnitt och färg på en cell som
när värdet uppfyller ett eller flera villkor. Observera att det andra och tredje villkoret gäller bara
om de tidigare villkoren inte uppfylls.

Använd Rensa → Villkorliga stilar i menyn Redigera för att ta bort alla villkorliga egenskaper
från markerade celler.

3.3 Ändra cellstorlekar

Fliken Position i dialogrutan Cellformat låter dig ändra storlek på de markerade cellerna. Ob-
servera att ändra höjd på en ensam cell ändrar höjden på alla celler i den raden, och på samma
sätt påverkar en ändring av bredden hela kolumnen.

Du kan också välja raderna eller kolumnerna som ska ändras och sedan välja Ändra storlek
på rad... eller Ändra storlek på kolumn... från menyn som visas med höger musknapp, eller i
menyerna Format → Rad och Format → Kolumn.

Om du flyttar muspekaren så att dess spets pekar på linjen mellan två radnummer till vänster
i Calligra Sheets fönster, så ändras markören till två parallella linjer, med en kort pil från varje
linje. När markören ser ut så här, kan du hålla nere vänster musknapp och dra kanten mellan
de två raderna, för att ändra höjden på den övre raden. En liknande teknik kan användas för att
ändra bredden på en kolumn.

För att ställa in radhöjd eller kolumnbredd till minimum som behövs för att visa innehållet, mar-
kera hela raden eller kolumnen, och högerklicka på rad- eller kolumnrubriken. Välj Justera rad
eller Justera kolumn i menyn som visas. Raden eller kolumnen ändras till minimum som behövs.
Du kan också markera en ensam cell eller intervall av celler, och antingen välja Justera rad och
kolumn från menyn som visas med högerklick eller menyn Format.

Du kan göra ett antal intilliggande rader eller kolumner till samma storlek genom att välja Format
→ Rad → Utjämna rad eller Format → Kolumn → Utjämna kolumn.

3.4 Slå ihop celler

Det är ofta praktiskt att ha en cell som utbreder sig över två eller flera kolumner eller längs mer
än en rad. Det här kan göras genom att slå ihop två eller flera celler till en. Markera cellerna som
ska slås ihop, och välj sedan Format → Sammanfoga celler.

För att vända på åtgärden, markera den sammanslagna cellen och välj Dela upp celler i menyn
Format.

3.5 Dölja rader och kolumner

Ett färdigt kalkylblad kan ofta fås att se snyggare ut genom att dölja celler som innehåller mel-
lansteg i beräkningen, så att bara viktiga indata- och resultatområden visas.

Du kan dölja markerade rader och kolumner i Calligra Sheets genom att använda alternativen
Dölj rader och Dölj kolumner i menyn Format → Rad, Format → Kolumn eller menyer som
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visas med höger musknapp. Dolda rader och kolumner visas inte på skärmen, och finns inte
med på en utskrift.

Att dölja celler på det här sättet gör dem också något svårare att ända av misstag.

För att dölja en rad eller kolumn, välj Rad → Visa rader... eller Kolumn → Visa kolumner... i
menyn Format. Du kan markera vilket antal rader som helst att visa i dialogrutan som öppnas.

3.6 Egenskaper för arbetsblad

Du kan antingen komma åt det aktuella arbetsbladets egenskaper genom att högerklicka på ar-
betsbladets flik och välja Egenskaper för arbetsblad eller genom att använda menyn Format
→ Arbetsblad → Egenskaper för arbetsblad. Observera att du bara kan komma åt arbetsbladets
egenskaper när dokumentet eller arbetsbladet inte är skyddade.

Du kan ställa in olika egenskaper som är giltiga på aktuellt arbetsblad. Genom att klicka på Ok
verkställs dina ändringar och Förval återställer förvalda inställningar.

Layoutriktning:

Låter dig välja bladets orientering. Förval är att bladets första kolumn är till vänster. Om
du väljer Höger till vänster, är den första kolumnen till höger och de övriga läggs till från
höger till vänster.

Dölj noll

Om den här rutan är markerad, så visas alla celler som innehåller värdet noll som tomma.

Automatisk omräkning

Den här inställningen styr om formler automatiskt beräknas om när värdet i någon cell de
refererar till ändras.

Visa kolumn som nummer
Om den här rutan är markerad visas kolumnrubriker som nummer istället för bokstäver.
Bokstäver är förval.
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Använd LC-läge

Om den här rutan är markerad visas cellreferensen till vänster i formelraden med LC-läge
(dvs. L2C3) istället för dess normala form B3. Det verkar inte vara särskilt användbart för
närvarande.

Konvertera första bokstaven till stor bokstav
Markeras den här rutan, så konverteras automatiskt första bokstaven i all text som du skri-
ver in till stor bokstav.

Visa rutnät
Om markerat visas rutnätet (cellernas gränser). Det är förval. Om du avmarkerar det, döljs
rutnätet.

Visa sidkanter
Om du markerar det här alternativet ritas sidkanterna på det nuvarande bladet. Normalt
visas inte sidkanterna. Det är användbart att se sidkanterna om du vill skriva ut bladet.

Visa formel
Om den här rutan är markerad, så visar Calligra Sheets själva formeln i celler istället för
resultatet.

Visa formelindikering

Om den här rutan är markerad visar Calligra Sheets en liten blå triangel i nedre vänstra
hörnet av celler som innehåller formler. Det är användbart om du vill skydda celler med
formler.

Visa kommentarindikering

Om den här rutan är markerad så markeras celler som innehåller kommentarer med en
liten röd triangel i övre högra hörnet.
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Kapitel 4

Avancerad användning av Calligra
Sheets

Pamela Robert
Anne-Marie Mahfouf
Översättare: Stefan Asserhäll

4.1 Serier

När man skapar ett kalkylblad, behöver man ofta lägga till serier med värden, som 10, 11, 12 ..., i
en rad eller kolumn. Det finns flera sätt man kan göra det i Calligra Sheets.

För en enkel kort serie som 5, 6, 7, 8... så är metoden ‘dra och kopiera’ enklast. Skriv in startvärdet
i startcellen och nästa värde i serien i en intilliggande cell. Markera därefter båda cellerna, och
flytta muspekaren så att den befinner sig på den lilla fyrkanten i nedre högra hörnet. Markören
ändras till en diagonal pil med två huvuden. Håll sedan nere vänster musknapp medan cellerna
dras neråt eller tvärs över sidan enligt behov.

Stegstorleken beräknas som skillnaden mellan de två startvärden du skriver in. Om du till ex-
empel skriver in 4 i cell A1 och 3,5 i A2, och därefter väljer båda cellerna och drar och kopierar
dem neråt, så beräknas stegstorleken som värdet i A2 minus värdet i A1, -0,5 i det här fallet, så
du får serien 4, 3,5, 3, 2,5, 2...

Metoden att ‘dra och kopiera’hanterar till och med serier där stegvärdet inte är ett konstant värde,
utan en serie själv. Så om du startar med 1, 3, 4, 6, utökar dra och kopiera det till 1, 3, 4, 6, 7, 9, 10,
12, ..., där stegvärdet i exemplet är serien 2, 1, 2, 1, ...

Calligra Sheets känner också igen några särskilda ‘serier’, som veckodagarna. Försök att skriva
in fredag i en cell och lördag i cellen nedanför (observera de små bokstäverna) och använd
sedan dra och kopiera på dem. För att se vilka särskilda serier som är tillgängliga, och kanske
skapa egna, välj Verktyg → Egna listor... .

Om du markerar en cell och väljer Serier... i menyn Infoga ser du dialogrutan Serier. Den är
användbar för att skapa serier som är för långa för att skapas på ett enkelt sätt med dra och
kopiera metoden, eller för att skapa geometriska serier, såsom 1, 1,5, 2,25, 3,375... där stegvärdet,
1,5 i detta fall, används som multiplikator.

Om serietypen som du vill ha är för komplicerad för någon av de tidigare metoderna, fundera
på att använda en formel och dra och kopiera den. För att till exempel skapa en serie med värden
2, 4, 16, 256 ... skriv in 2 i A1, =A1*A1 i A2, och dra och kopiera A2 neråt.
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4.2 Formler

4.2.1 Inbyggda funktioner

Calligra Sheets har ett enormt antal inbyggda matematiska och andra funktioner, som kan an-
vändas i en formelcell. De kan visas och kommas åt genom att markera en cell och sedan välja
Funktion... i menyn Infoga. Då visas dialogrutan Funktion.

Markera funktionen du vill använda i listrutan till vänster i dialogrutan. Fliksidan Hjälp visar då
en beskrivning, returtypen, syntax, parametrar och exempel för funktionen. Dessutom tillhanda-
håller sidan ofta länkar till liknande funktioner. Tryck sedan på knappen med den nedåtriktade
pilen för att klistra in den i textredigeringsrutan längst ner i dialogrutan.

Fliken Parametrar visas därefter för att låta dig skriva in parametrarna för funktionen du just har
valt. Om du vill skriva in ett specifikt värde för en parameter, skriv bara in det i motsvarande
textruta på sidan Parametrar. För att skriva in en cellreferens istället för ett värde, vänsterklicka
på motsvarande textruta på sidan Parametrar, och vänsterklicka sedan på kalkylbladets cell.

Istället för att använda fliken Parametrar, kan cellreferenser som B6 skrivas in genom att direkt
skriva dem i redigeringsrutan längst ner i dialogrutan Funktion. Om ett uttryck har mer än en
parameter, avdela dem med ett semikolon (;).

Att trycka på knappen Ok infogar funktionen i nuvarande cell och stänger dialogrutan Funktion.

Du kan förstås klara dig utan dialogrutan Funktion och helt enkelt skriva in hela uttrycket i
huvudrutan för textinmatning under verktygsalternativen för Celleditorn. Funktionsnamn är
inte skiftlägeskänsliga. Glöm inte att alla uttryck måste början med tecknet =.

4.2.2 Logiska jämförelser

Logiska funktioner som IF(), AND(), OR() accepterar parametrar som har ett logiskt (Booleskt)
värde ˝True˝ (sant) eller ˝False˝ (falskt). Den här sortens värde kan skapas av andra logiska
funktioner som ISEVEN() eller genom att jämföra värden i kalkylarkets celler med jämförelseut-
trycken som visas i den följande tabellen.

Uttryck Beskrivning Exempel

== är lika med A2==B3 är sant om värdet i
A2 är lika med värdet i B3

!= är inte lika med A2!=B3 är sant om värdet i
A2 är skilt från värdet i B3

<> är inte lika med Samma som A2!=B3

< är mindre än A2<B3 är sant om värdet i
A2 är mindre än värdet i B3

<= är mindre än eller lika med
A2<=B3 är sant om värdet i
A2 är mindre än eller lika
med värdet i B3

> är större än A2>B3 är sant om värdet i
A2 är större än värdet i B3

>= är större än eller lika med
A2>=B3 är sant om värdet i
A2 är större än eller lika
med värdet i B3

Så om du skriver in =IF(B3>B1;˝STÖRRE˝;˝˝) i en cell så visar den STÖRRE om värdet i B3
är större än det i B1, annars är cellen tom.
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4.2.3 Absoluta cellreferenser

Om en formel innehåller en cellreferens, så ändras referensen normalt när cellen kopieras till en
annan plats på arbetsbladet. För att förhindra detta beteende, lägg till symbolen $ före kolumnens
bokstav, radens nummer eller båda.

• Om A1 innehåller formeln =D5 så blir den =E6 om cellen kopieras till B2 (det normala beteen-
det).

• Om A1 innehåller formeln =$D5 så blir den =D6 om cellen kopieras till B2 (kolumnbokstaven
ändras inte).

• Om A1 innehåller formeln =D$5 så blir den =E5 om cellen kopieras till B2 (radnumret ändras
inte).

• Om A1 innehåller formeln =$D$5 så förblir den =D5 om cellen kopieras till B2 (varken ko-
lumnbokstaven eller radnumret ändras).

När du skriver in eller redigerar en cellreferens i en formel, så kan snabbtangenten F4 användas
för att stega igenom de här fyra möjligheterna.

Namngivna celler kan användas på ett liknande sätt för att inkludera en oföränderlig cellreferens
i en formel.

4.3 Aritmetik med klistra in special

Ibland kan du vilja lägga till ett enda värde till ett antal celler, eller subtrahera ett värde från dem,
eller multiplicera eller dividera dem alla med ett enda värde. Alternativet Klistra in special...
låter dig göra detta på ett snabbt och enkelt sätt.

Skriv först in ändringsvärdet i en ledig cell på kalkylarket och Kopiera det. Välj sedan cellområ-
det du vill ändra, välj Klistra in special... i menyn Redigera eller menyn som visas med höger
musknapp, och välj Addition, Subtraktion, Multiplikation eller Division i sektionen Operation
i dialogrutan.

Du kan också tilldela olika ändringsvärden till olika rader eller kolumner i området som ska
ändras, genom att kopiera ett område som innehåller önskade ändringsvärden innan området
som ska ändras väljes, och göra Klistra in special.... Om du till exempel skriver in 5 i cell A1, 10
i cell B1, markerar båda cellerna och gör Kopiera, följt av Klistra in special... Addition i cellerna
A10 till D15, så adderas 5 till A10:A15 och C10:C15, medan 10 adderas till B10:B15 och D10:D15.

Observera att ett ändringsvärde kan vara en formel istället för ett enkelt numeriskt värde. Om
det är en formel, så justerar Calligra Sheets cellreferenserna som vid en vanlig Klistra in.

4.4 Fältformler

Calligra Sheets låter dig använda formler vars resultat är en matris, eller ett intervall av värden.
Normalt visas bara det första värdet i en cell. Om du vill visa hela matrisen, använd helt enkelt
Ctrl-Alt-Retur när formeln redigeras, så konverteras den till en fältformel, som upptar granncel-
ler efter behov.
Celler som ingår i en fältformel är låsta för redigering.
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4.5 Målsökning

Calligra Sheets kan användas för att lösa algebraiska uttryck som x + xˆ2 = 4 eller för vilket värde
på x är x + x i kvadrat lika med 4?
Med exemplet skulle du kunna skriva in =A2+A2*A2 i A1 och sedan antingen prova olika värden
i A2 till resultatet i A1 är så nära 4 som du vill, eller helst använda Calligra Sheets funktion
Målsök..., som automatiskt justerar värdet i en cell för att försöka få värdet i en annan cell så
nära ett slutresultat som möjligt.

Den aktiveras genom att välja Målsök... i menyn Data. Då visas en dialogruta där du ska skriva
in referensen till målcellen (A1 i det här fallet) i rutan Ge cell:, målvärdet själv (4) i rutan Värdet:
och referensen till cellen som ska ändras (A2) i rutan Genom att ändra cell:. Observera att du
måste ha skrivit in något startvärde i cellen som ska ändras innan du startar Målsök.

Genom att trycka på knappen Ok startas beräkningen. När den är klar och om en lösning har hit-
tats, tryck på knappen Ok för att acceptera resultatet eller Avbryt för att behålla det ursprungliga
värdet.

4.6 Pivot-tabeller

Calligra Sheets kan användas för att skapa pivot-tabeller med användning av data i den aktuella
tabellen.
Funktionen kan utföras genom att alternativet Pivot... i menyn Data. Nedan finns ett exempel på
generering av en pivot-tabell.

Anta att vi har följande data.

Vi vill skapa en pivot-tabell enligt våra krav. Vi väljer alltså Data → Pivot....
Dialogrutan som visas låter oss välja datakälla. Data kan tas från det nuvarande arbetsbladet eller
från en extern källa som en databas eller en ODS-fil.

40

http://en.wikipedia.org/wiki/Pivot_table


Handbok Calligra Sheets

Här är dialogrutan som låter användaren anpassa pivot-tabellen. Kolumnrubrikerna i källdata
konverteras till etiketter som fungerar som arbetsfält. Etiketterna kan dras och släppas på tre
områden (Rader, Kolumner eller Värden) för att skapa pivot-tabellen. Valen kan återställas med
knappen Återställ drag och släpp.

I vårt exempel dras Namn till Rader, Kategori till Kolumner, Poäng till Värden. Användardefini-
erade funktioner som summa, medelvärde, max, min, antal, etc. kan väljas i listan Välj alternativ.

Knappen Lägg till filter kan användas för att öppna filterdialogrutan för att filtrera önskad data.
Genom att använda rutan kan flera filter baserade på kolumnrubrikerna och deras förhållande
definieras (Och eller Eller). Det ger fullständig frihet att anpassa utdata.

Summera rader och Summera kolumner: Att markera dessa gör det möjligt att automatiskt sum-
mera motsvarande rader eller kolumner i pivot-tabellen.
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4.7 Att använda mer än ett arbetsblad

När du påbörjar ett nytt tomt dokument med Calligra Sheets så skapas ett antal tomma arbets-
blad. Antalet blad som skapas bestäms av den valda mallen.

Infoga → Blad lägger till ett nytt blad i dokumentet.

Du kan också byta mellan arbetsblad genom att använda Ctrl+Page Down för att gå till nästa
blad, och Ctrl+Page Up för att gå till föregående.

Arbetsblad ges standardnamnen Blad 1, Blad 2... Du kan ge ett blad ett annat namn genom att
högerklicka på fliken och välja Byt namn på blad....

För att ta bort ett blad från dokumentet, använd alternativet Ta bort blad i den sammanhangsbe-
roende menyn som visas när du högerklickar på fliken för bladet som du vill ta bort.

Andra alternativ i undermenyn Format → Arbetsblad låter dig visa eller dölja ett blad på i stort
sett samma sätt som rader och kolumner kan döljas.

Om du vill att en formel på ett blad ska referera till en cell på ett annat blad, måste cellreferensen
börja med tabellnamnet följt av ett utropstecken (!). Om du till exempel skriver in =Blad2!A2
i en cell på blad 1, så hämtar den cellen värdet från A2 på blad 2. Observera att bladnamn är
skiftlägeskänsliga.

4.7.1 Konsolidera data

Du kan ha skapat ett dokument som innehåller flera arbetsblad med liknande data, men till
exempel för olika månader under året, och vill ha ett sammanfattningsblad som konsoliderar
(t.ex. summa eller medelvärde) värden för motsvarande data på övriga blad.

Den här uppgiften kan göras något lättare genom att använda alternativet Konsolidera... i menyn
Data.
Genom att välja det här alternativet så visas dialogrutan Konsolidera.

För var och en av indatatabladen, skriv in en referens till dataområdet som önskas i rutan Re-
ferens:. Tryck sedan på Lägg till för att överföra referensen till rutan Angivna referenser:. Refe-
rensen ska innehålla namnet på bladet som innehåller indata, som Januari!A1:A10, och kan
skrivas in automatiskt genom att välja motsvarande område på lämplig blad.

När referenserna har angetts för alla indatabladen, välj då cellen på bladet där du vill att övre
vänstra hörnet för det konsoliderade resultatet ska visas. Välj därefter lämplig funktion i kombi-
nationsrutan Funktion: och tryck på knappen Ok.

Om du klickar på Detaljer > > i dialogrutan och markerar rutan Kopiera data, så placeras värden
från konsolideringen i målcellerna istället för formler för att beräkna dem.

4.8 Infoga ett diagram

Du kan infoga ett diagram på ett arbetsblad för att ge en grafisk bild av data.

Aktivera först panelen Lägg till form genom att använda menyalternativet Inställningar →
Paneler.
Markera därefter området med celler som innehåller data och välj Diagram under Lägg till form.
Dra markören över bladet medan du håller nere vänster musknapp, för att ange området där
du vill att diagrammet ska visas. Det finns ingen anledning att vara alltför noggrann vid detta
tillfälle, eftersom diagramstorleken lätt kan ändras när som helst. När du släpper musen, så visas
dialogrutan Diagram alternativ.

Dataområdet är redan ifyllt med det markerade cellområdet i förväg. Välj första raden och ko-
lumnen som rubriker, markera Datamänger i rader och klicka på knappen Ok. Dialogrutan för-
svinner och diagrammet visas inbäddat i arbetsbladet.
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Välj nu Redigeringsverktyg för diagram i panelen Verktyg och redigera diagrammets egenska-
per som diagramtyp, etiketter och axlar under Diagramredigering.

För att flytta, ändra storlek eller till och med ta bort det inbäddade diagrammet, byt till verktyget
Grundläggande formbehandling och klicka var som helst i diagramområdet. Det ska nu visas
med en grön kant och med en liten gul fyrkant i varje hörn och mitt på varje sida.

Om du flyttar markören över någon av fyrkanterna, så ska den ändras till en pil med dubbla
huvuden. Du kan ändra storlek på diagrammet genom att dra en av de här fyrkanterna med
vänster musknapp nertryckt. För att ta bort diagrammet, högerklicka på en av fyrkanterna och
välj Ta bort.

För att flytta diagrammet, flytta markören in i diagrammet. Markören ska då ändras till ett kors.
Tryck på vänster musknapp, så kan du dra diagrammet dit du vill ha det.

För att återställa diagrammet till dess normala utseende, klicka bara var som helst utanför dia-
gramområdet.

För att ändra formatet på själva diagrammet, vänsterklicka två gånger inne i diagramområdet.
Diagrammets Diagramredigering ska då visas i fönstret. Därefter kan du använda verktygen för
att ändra diagrammet.

4.9 Infoga extern data

Du kan infoga data från en textfil eller från klippbordet i ett arbetsblad, genom att först markera
cellen där du vill att det övre vänstra värdet för infogad data ska hamna, och sedan välja Från
textfil... eller Från klippbordet... i undermenyn Infoga → Extern data.

I båda fall antar Calligra Sheets att data är på CSV-form och visar en dialogruta som låter dig
styra hur data hämtas från filen eller klippbordet och placeras i arbetsbladets celler.

Om det finns stöd för det i systemet, så kan Calligra Sheets också infoga data från en SQL-databas
på ett arbetsblad. Detta görs genom att använda alternativet Infoga → Extern data → Från data-
bas....
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4.10 Länkceller

En cell på ett kalkylblad kan länkas till en åtgärd, så att ett vänsterklick på cellen, till exempel,
kan öppna en webbläsare. För att få en cell att bete sig på detta sätt, markera den och välj Infoga
→ Länk.... Då visas dialogrutan Infoga länk, som låter dig välja mellan fyra olika sorters länkar:

• En Internet-länkcell, försöker öppna den förvalda webbläsare med webbadressen som skrivs
in i textrutan Internetadress: i dialogrutan Infoga länk, när den klickas. Det kan till exempel
vara http://www.calligra.org.

• Genom att klicka på en cell som innehåller en Brev-länk, öppnas e-postprogrammet med
adressen som skrivs in i textrutan E-post: som adressen Till:. Exempelvis anonym@exempe
l.com.

• En Arkiv-länkcell innehåller sökvägen till en fil eller katalog, som skrivs in i textrutan Filplats:,
och försöker öppna filen eller katalogen med ett lämpligt program när den klickas.

• Länktypen Cell innehåller en Calligra Sheets cellreferens, som skrivs in i textrutan Cell eller
namngivet område. Ett vänsterklick på den här sortens länkcell gör att Calligra Sheets fokus
flyttas till den cellen.

Alla fyra sorters länk kräver att en lämplig text skrivs in i fältet Text att visa i dialogrutan Infoga
länk. Det är texten som syns i cellen.

4.11 Giltighetskontroll

Calligra Sheets kan automatiskt kontrollera giltigheten på inmatad data med ett antal kriterier,
och visa en meddelanderuta om data är ogiltigt.

För att aktivera funktionen, markera cellerna som ska övervakas och välj Data → Giltighet.... Då
visas Calligra Sheets dialogruta Giltighet, som har tre fliksidor.

Välj vilken sorts data som anses vara giltig på sidan Villkor med kombinationsrutan Tillåt:, och
definiera därefter det giltiga intervallet för värden genom att välja en av alternativen i kombi-
nationsrutan Data: och skriva in ett lämpligt värde eller lämpliga värden i en eller båda redige-
ringsrutor.

När du har gjort detta, byt till fliken Felvarning. Här kan du välja typ av meddelanderuta
(Stoppa, Varning eller Information) som visas när ett ogiltigt värde skrivs in, och ange med-
delanderutans titel och meddelande.
Observera att den här funktionen bara kontrollerar data som du skriver in in cellen. För ett sätt att
kontrollera resultat från formelceller, se avsnittet Villkorliga cellegenskaper i den här handboken.

4.12 Skydd

4.12.1 Dokumentskydd

Att skydda dokumentet betyder att en användare inte kan lägga till eller ta bort arbetsblad utan
lösenordet. Att skydda dokumentet skyddar inte celler.

Välj Verktyg → Skydda dokument.... En dialogruta dyker upp och frågar efter ett lösenord. Mä-
taren av lösenordets säkerhet anger om lösenordet är säkert nog. Ju längre indikeringen är desto
säkrare är lösenordet.
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Lösenordet krävs för att ta bort skyddet från dokumentet.

När ett dokument är skyddat, kan du inte:

• Byta namn på ett arbetsblad

• Infoga ett arbetsblad

• Ta bort ett arbetsblad

• Dölja ett arbetsblad

• Visa ett arbetsblad

• Se arbetsbladens egenskaper

• Sammafoga eller dela upp celler
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4.12.2 Arbetsbladsskydd

Att skydda ett arbetsblad betyder att skydda innehållet i alla skyddade celler och objekt på ar-
betsbladet. Skyddet kan tas bort från enskilda celler eller ett antal markerade celler, se nästa
avsnitt.
Välj Verktyg → Skydda arbetsblad... för att skydda ett arbetsblad. En dialogruta dyker upp och
frågar efter ett lösenord. Mätaren av lösenordets säkerhet anger om lösenordet är säkert nog. Ju
längre indikeringen är desto säkrare är ditt lösenordet.

Detta lösenord krävs sedan för att ta bort skyddet från arbetsbladet.

När ett arbetsblad är skyddat, kan du inte:

• Infoga något objekt eller diagram

• Formatera någon cell

• Infoga en rad eller kolumn

• Redigera och ändra cellinnehåll

• Ändra något innehåll på arbetsbladet

NOT
Att skydda ett arbetsblad är särskilt användbart för att förhindra att formler raderas av misstag.

4.12.3 Skydd av celler eller markerade celler

VARNING
Cellskydd är normalt aktivt för alla celler och får effekt när du aktiverar skydd av arbetsbladet. Om du
alltså behåller normalvärdet och skyddar arbetsbladet, är alla celler skyddade.

Om du bara vill att vissa celler ska vara skyddade, måste det normala skyddet stängas av för alla
andra celler. Du kanske till exempel vill att de flesta celler ska acceptera inmatning av använda-
ren, så du avmarkerar Skyddad för dem, och väljer att behålla celler skyddade som ska förbli
oförändrade (som rubriker). Du behöver alltså tre steg för att bara skydda vissa celler: Ta bort
skyddet från alla celler, markera cellerna du vill skydda och skydda dem, skydda därefter till sist
hela arbetsbladet.
För att ta bort skydd från alla celler:

• Markera hela kalkylbladet med musen.

• Välj Format → Cellformat... i menyraden.

• Gå till fliken Cellskydd i dialogrutan som dyker upp.

• Markera Dölj allt och avmarkera Skyddat för att ta bort skyddet från alla celler. Cellerna är
nu oskyddade.

För att skydda ett område med markerade celler, eller för att skydda celler som inte gränsar till
varandra:

• Markera cellområdet som ska skyddas eller använda Ctrl-tangenten för att markera celler som
inte ligger intill varandra.
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• När alla önskade celler är markerade, gå till menyn Format → Cellformat....

• Gå till fliken Cellskydd i dialogrutan som dyker upp.

• Klicka på rutan intill Skyddat och klicka därefter på Ok.

När cellerna väl är markerade för att skyddas, måste skyddsalternativet aktiveras på arbetsblads-
nivå, vilket betyder att du måste skydda hela arbetsbladet för att skyddet för cellerna ska få effekt:

• Välj Verktyg → Skydda arbetsblad....

• I dialogrutan som visas, tillhandahåll ett säkert lösenord, och bekräfta det genom att skriva in
det igen. Klicka på knappen Ok.

• Skyddade celler på ett skyddat arbetsblad kan inte redigeras utan att ta bort skyddet från hela
arbetsbladet, och alla ändringar av arbetsbladet är inaktiverade. Ingen kan till exempel infoga
rader eller kolumner, ändra kolumnbredd eller skapa inbäddade diagram.

4.12.4 Dölj cellformel

Du kan vilja dölja dina formler så att andra inte kan se dem. Normalt är varje cell skyddad och
inte dold, men det är viktigt att komma ihåg att egenskaperna inte har någon effekt om inte själva
arbetsbladet är skyddat.

För att dölja cellformler, markera lämplig cell, cellintervall eller celler som inte ligger intill
varandra med Ctrl och välj därefter menyn Format → Cellformat.... Klicka på fliken Cellskydd i
dialogrutan Cellformat och välj Dölj formel. När arbetsbladet har skyddats är formlernas resul-
tat synligt, men formeln är det inte.

Du måste nu skydda arbetsbladet: Välj Verktyg → Skydda arbetsblad... för att visa dialogrutan
Skydda arbetsblad. Skriv in ett säkert lösenord två gånger för att förhindra att andra tar bort
skyddet från arbetsbladet.

När Dölj formel är aktiverat och Skyddat är inaktiverat, är formeln dold efter att arbetsbladet
har skyddats, men cellinnehållet kan ändras.
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När Dölj formel och Skyddat är aktiverade, är formeln dold efter att arbetsbladet har skyddats,
och cellinnehållet kan inte ändras.

Kom ihåg att det är mycket enkelt att knäcka lösenordet för ett skyddat arbetsblad, så om du är
ute efter verklig säkerhet är det här inte den bästa lösningen.

4.12.5 Dölj allt i cellen

Du kan dölja både formeln och innehållet i cellen genom att välja Dölj allt under fliken Cellskydd
i menyn Format → Cellformat.... I skärmbilden nedan är själva cellen inte skyddad (Skyddat är
avmarkerat), och alltså kan cellinnehållet ändras.

Här är själva cellen skyddad, så den kan inte skrivas över.

4.13 Övriga funktioner

4.13.1 Namnge celler och områden

Du kan ge en cell ett namn som blaha eller vilket område som helst på en blad, genom att
markera cellen eller området och därefter välja Områdesnamn... i menyn som visas med höger
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musknapp. Då visas dialogrutan Områdets namn, där du kan skriva in vilket namn som helst
som du vill ha.
Du kan också namnge en cell eller ett område genom att markera det och sedan skriva in namnet
i den lilla textrutan i vänstra kanten på formelverktygsraden, och skriva över cellreferensen som
normalt visas där.
Om du skriver in ett namn som redan har använts i den här rutan, så ändras markeringen i
Calligra Sheets för att visa den namngivna cellen eller cellerna.

Alternativet Data → Namngivna områden..., visar en lista med befintliga namn och låter dig
ändra Calligra Sheets fokus till vilket som helst av dem, eller låter dig ta bort ett namn.

Namngivna celler är särskilt användbara i formler som ett alternativ till absoluta cellreferenser,
eftersom namnen kan användas istället för normala cellreferenser och ändras inte när cellen som
innehåller formeln kopieras. När ett namn används på det här sättet, ska det omslutas av enkla
citationstecken.
Om cellen A1 till exempel har givits namnet fred, så kan du skriva in en formel som =’fred’
+ 2 i en annan cell, vilket alltid ger resultatet av att addera 2 till innehållet i A1, oberoende vart
formelcellen kopieras.

Observera att cell och områdesnamn hanteras som om de bara har små bokstäver.

4.13.2 Cellkommentarer

En cell kan innehålla en textkommentar, som kan visas medan man arbetar med kalkylbladet,
men som inte skrivs ut och inte normalt syns.

För att lägga till en kommentar, markera cellen och välj Kommentar... i menyn som visas med
höger musknapp, eller i menyn Infoga, och skriv in kommentaren i dialogrutan Cellkommentar
som visas.
För att se kommentaren, låt muspekaren vila över cellen. Kommentaren visas som om den vore
ett verktygstips.

Om du markerar rutan Visa kommentarindikering i dialogrutan Egenskaper för arbetsblad, så
visas en liten röd triangel i övre högra hörnet på celler som innehåller kommentarer.

För att visa dialogrutan, klicka med höger musknapp på arbetsbladets flik längst ner i huvud-
fönstret och välj Egenskaper för arbetsblad i den sammanhangsberoende menyn, eller välj den i
menyn Format → Arbetsblad.

För att ta bort en kommentar från en cell, välj Ta bort kommentar i menyn som visas med höger
musknapp, eller välj Redigera → Rensa → Kommentar.
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Kapitel 5

Att anpassa Calligra Sheets
snabbtangenter och verktygsrader

Pamela Robert
Översättare: Stefan Asserhäll

5.1 Genvägar

För att ändra snabbtangenter som används av Calligra Sheets, välj Inställningar →Anpassa gen-
vägar.... Då startas en dialogruta som visas nedan.

Sök igenom listrutan för att hitta åtgärden som du vill lägga till eller ändra snabbtangent för,
och välj den genom att vänsterklicka på namnet. Genom att skriva in åtgärdens namn i sökraden
längst upp hittar du snabbt önskad åtgärd. Därefter kan du ändra snabbtangent genom att välja
alternativknappen Ingen, Standard eller Egen.
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Nu kan du helt enkelt trycka på tangentkombinationen som du vill ska fungera som snabbtan-
gent, till exempel Ctrl+Skift+S.

5.2 Verktygsrader

Calligra Sheets har sex verktygsrader. Arkiv, Redigera, Navigering, Teckensnitt och Färg/kant.
Var och en kan visas eller inte beroende på valen som görs i menyn Inställningar.

Du kan välja om en verktygsrad visas Längs upp, Till vänster, Till höger eller Längst ner i Cal-
ligra Sheets fönster, genom att högerklicka på verktygsraden, för att visa Verktygsradsmenyn,
och välja i undermenyn Orientering. Verktygsradsmenyn har också undermenyer för att välja
om verktygsraden visar ikoner, text eller båda, och ikonstorleken.

Ett annat sätt att flytta en verktygsrad är att placera muspekaren över de två vertikala raderna
i vänsterkanten av varje verktygsrad, och hålla nere vänster musknapp medan verktygsraden
dras till önskad plats. När verktygsraden dras på det här sättet kan musknappen släppas när
den är en bit från Calligra Sheets fönsterkanter, och du får du en flytande verktygsrad, som inte
är låst till en viss del av Calligra Sheets fönster, och kan i själva verket flyttas utanför fönstret.
För att ta tillbaka en flytande verktygsrad till någon av de traditionella platserna, högerklicka på
namnlisten för att visa Verktygsradsmenyn och välj därefter ett av alternativen i undermenyn
Placering.

Genom att välja Anpassa verktygsrader... i menyn Inställningar, visar en dialogruta som låter
dig lägga till knappar eller ta bort dem från Calligra Sheets verktygsrader.

För att använda dialogrutan Anpassa verktygsrader, välj först en verktygsrad i kombinations-
rutan Verktygsrad:. Fönstret till höger, Nuvarande åtgärder:, visar då knapparna som för närva-
rande finns i verktygsraden. Du kan ta bort en knapp genom att välja den i det här fönstret och
sedan trycka på knappen med vänsterpilen, eller flytta omkring den genom att trycka på uppåt-
och neråtpilarna. För att lägga till en ny knapp i verktygsraden, välj den i listan Tillgängliga
åtgärder:, och tryck sedan på högerpilen.
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Kapitel 6

Calligra Sheets
inställningsdialogruta

Pamela Robert
Översättare: Stefan Asserhäll
Genom att välja Inställningar → Anpassa Calligra Sheets... visas en dialogruta med flera sidor,
som väljes med ikonerna till vänster i dialogrutan, och låter dig ändra många aspekter av hur
Calligra Sheets används.

6.1 Gränssnitt

Markörförflyttning efter tryck på returtangent:
Välj om ett tryck på tangenten Enter flyttar markören Ner, Upp, Höger, Vänster, Ner, första
kolumnen eller Inget vilket bestäms av inställningen i kombinationsrutan.
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Funktion som visas i statusraden:
Den här kombinationsrutan kan användas för att välja beräkning som utförs av statusra-
dens summeringsfunktion.

Enhet:
Välj förvald enhet som används på arbetsbladen.

Indenteringssteg:

Ställ in hur mycket indentering som används i cellen när du väljer åtgärderna Öka inden-
tering eller Minska indentering i verktygsraden. Åtgärderna är inte normalt aktiverade i
verktygsraden.

Ta om hand alla navigeringstangenter under redigering
Ta om hand alla navigeringstangenter, dvs. piltangenterna och tangenterna Page Up, Page
Down, tabulator och bakåttabulator, medan en cell redigeras med den inbyggda editorn
Den inbyggda editorn är den som visas direkt i cellen. Om de tas om hand, används tan-
genterna för navigering i editorn. Annars används de för navigering mellan celler.

Rutan Färger låter dig välja färg på tabellens rutnät. Om du inte vill att rutnätet ska visas alls,
avmarkera Visa rutnät i dialogrutan Format → Arbetsblad → Egenskaper för arbetsblad.
Den här rutan låter dig också välja färgen på linjerna som används för att ange sidkanterna när
alternativet Visa sidkanter i menyn Visa är markerat.
Välj Egen från nuvarande färg för att visa KDE:s vanliga dialogruta Välj färg.

Rutnät
Klicka här för att ändra rutnätets färg, dvs. färgen på varje cells kanter.

Sidkanter
När menyalternativet Visa → Visa sidkanter är markerat, visas sidkanterna. Klicka här för
att välja en annan färg på kanterna än den förvalda röda färgen.

6.2 Öppna/Spara
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Antal filer att visa i listan Senaste filer:
Styr maximalt antal filnamn som visas när du väljer Arkiv → Öppna senaste.

Fördröjning för spara automatiskt:

Här kan du ställa in tiden mellan spara automatiskt, eller stänga av den här funktionen helt
genom att välja Spara inte automatiskt (genom att välja det minsta värdet).

Skapa säkerhetskopia:

Markera den här rutan om du vill att säkerhetskopior ska skapas. Den är normalt markerad.

6.3 Insticksprogram

Markera ett insticksprogram i listan för att aktivera det. Visa dialogrutan Om genom att klicka
på informationsknappen på höger sida om raden i listan.
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6.4 Stavning

Den här sidan låter dig ställa in beteendet hos Calligra Sheets stavningskontroll.

För mer information, se dokumentationen för stavningskontroll.

6.5 Författare

Välj en författarprofil för dokumentet.
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Du kan lägga till en ny profil eller ta bort den nuvarande med knapparna till höger om kombina-
tionsrutan med profiler.
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Kapitel 7

Kommandoreferens

Pamela Robert
Översättare: Stefan Asserhäll

7.1 Menyn Arkiv

Arkiv → Ny (Ctrl+N)

Skapa ett nytt dokument.

Arkiv → Öppna... (Ctrl+O)

Öppna ett befintligt dokument.

Arkiv → Öppna senaste

Öppna ett befintligt dokument genom att välja det från en kombinationsruta med senast
använda filer.

Arkiv → Spara (Ctrl+S)

Spara dokumentet.

Arkiv → Spara som...

Spara och ändra aktuellt dokument med ett nytt namn eller format. Om du vill behålla
dokumentets namn och format, använd Exportera....

Arkiv → Uppdatera

Uppdaterar dokumentet.

Arkiv → Importera...

Importera andra dokument.
Tabeller med data lagras ofta i textfiler, med värden på en rad åtskilda med ett komma-
tecken, mellanslag, tabulatortecken eller annat tecken, till exempel 123, 456, 789, abcd, efgh.
Sådana filer kallas ofta ‘CSV’-filer (Comma Separated Values), även om skiljetecknet inte
måste vara ett kommatecken.
Om du ber Calligra Sheets öppna en textfil, antas att filen är på CSV-format, och en dia-
logruta visas som låter dig ange avgränsaren (skiljetecknet) som används i filen, och som
visar hur datavärden placeras i kalkylbladets olika celler.

Övriga alternativ i den här dialogrutan låter dig ange Format för kalkylbladets celler, om
citationstecken runt text ska tas bort, och om de första raderna i filen ska ignoreras.
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Arkiv → Exportera...

Spara dokumentet till vilket format som helst som stöds. Dokumentet blir inte den expor-
terade filen.

Arkiv → Skicka e-post...

Skicka filen som en bilaga till e-post.

Arkiv → Skapa mall från dokument...

Skapa en Calligra Sheets-mall baserat på det här dokumentet.

Arkiv → Skriv ut... (Ctrl+P)
Skriva ut dokumentet.

Arkiv → Förhandsgranska utskrift...

Visa dokumentet som det kommer att skrivas ut.

Arkiv → Dokumentinformation
Visa eller skriv in information om dokumentet och upphovsmannen.

Arkiv → Stäng (Ctrl+W)

Stäng det nuvarande dokumentet, men låt Calligra Sheets fortsätta köra.

Arkiv → Avsluta (Ctrl+Q)
Avsluta Calligra Sheets.

7.2 Menyn Redigera

Redigera → Ångra (Ctrl+Z)

Ångra senaste åtgärden.

Redigera → Gör om (Ctrl+Skift+Z)

Gör om den senast ångrade åtgärden.

Redigera → Klipp ut (Ctrl+X)

Placera markerade objekt på klippbordet och ta bort dem från den ursprungliga platsen.
Om du därefter gör Klistra in så infogas objekten på den nya platsen.

Redigera → Kopiera (Ctrl+C)

Kopiera markerade objekt till klippbordet.

Redigera → Klistra in (Ctrl+V)

Klistra in objekt från klippbordet i de markerade cellerna.

Redigera → Klistra in special...

Särskilda sorters inklistring. Se avsnitten Andra inklistringslägen och Aritmetik med klistra
in special för mer information.

Redigera → Klistra in och infoga

Flytta antingen innehållet i inklistringsområdet till höger eller ner och klistra in objekt från
klippbordet i de markerade cellerna.
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Redigera → Fyll

Fyller markerat område med värden från den fösta objektuppsättningen. Alla fyra riktning-
ar stöds. Observera att begreppet ˝objektuppsättning˝ beskriver den första uppsättningen
värden som ses i fyllriktningen. Om fyllriktningen är vänster, är den första objektuppsätt-
ningen den sista markerade kolumnen.

Redigera → Sök... (Ctrl+F)

Sök efter celler som innehåller angiven text.

Redigera → Sök igen (F3)

Sök efter nästa cell som innehåller angiven text.

Redigera → Sök föregående (Skift+F3)

Sök efter föregående cell som innehåller angiven text.

Redigera → Ersätt... (Ctrl+R)

Sök och ersätt angiven text i celler.

Redigera → Rensa

Rensa Alla eller Innehåll, Kommentar, Villkorliga stilar, Länkar eller Giltighet från mar-
kerade celler.

Redigera → Ta bort

Ta bort Celler, Kolumner, Rader eller Arbetsblad.

Redigera → Ändra cell (F2)

För att ändra markerad cell på plats.

7.3 Menyn Visa

Visa → Ny vy

Öppna en ny instans av Calligra Sheets med samma dokument.

Visa → Sidkanter
Visa eller dölj markering för sidor vid utskrift på bladet med röda linjer.

Visa → Zooma
Öka eller minska förstoringen som används för att visa kalkylbladet. Intervall från 33 % till
500 %.

7.4 Menyn Gå

I den här menyn finns alternativ för att gå mellan arbetsbladen i dokumentet som för närvarande
är öppet, och Gå till cell för att gå till en enskild cell eller markera ett cellområde.
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7.5 Menyn Infoga

Infoga → Kommentar

Lägg till eller ändra en kommentar.

Infoga → Funktion...

Infoga en matematisk funktion. Se avsnittet Formler för mer information.

Infoga → Serier...

Infoga en serie. Se avsnittet Serier för mer information.

Infoga → Länk...

Infoga en länk till den markerade cellen. Se avsnittet Länkceller för mer information.

Infoga → Specialtecken...

Infoga ett specialtecken i markerad cell.

Infoga → Extern data

Infoga data Från databas..., Från textfil... eller Från klippbordet.... Se avsnittet Infoga ex-
tern data för mer information.

7.6 Menyn Format

Format → Cellformat... (Alt+Ctrl+F)
Formatera markerade celler. Se avsnittet Formatera kalkylblad för mer information.

Format → Stilhantering

Skapa, ändra eller ta bort cellformatstilar.

Format → Stil
Använd en stil för markerade celler. För att hantera stilar använd Format → Stilhantering...

Format → Skapa stil från cell...

Skapar en ny stil från den markerade cellens format. För att hantera stilar använd Format
→ Stilhantering...

Format → Automatisk formatering...

Formatera markerade celler automatiskt: En dialogruta låter dig välja mellan två föreslagna
format.

Format → Sammanfoga celler

Sammanfoga markerade celler.

Format → Dela upp celler

Dela upp tidigare sammanfogade celler.

Format → Justera rad och kolumn
Ställ in rad- och kolumnstorlekar för att visa markerade celler fullständigt.

Format → Rad
Ändra storlek på, utjämna, dölj eller visa rader.
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Format → Kolumn
Ändra storlek på, utjämna, dölj eller visa kolumner.

Format → Blad
Dölj, visa eller anpassa avancerade egenskaper för arbetsblad.

Format → Sidlayout...

Formatera utskriftens layout.

Format → Utskriftsintervall
Ange eller återställ utskriftsintervallet.

7.7 Menyn Data

Data → Sortera...
Sortera data i markerade celler. Se avsnittet Sortera data för mer information.

Data → Text till kolumner...
Det här alternativet försöker tolka texten i den markerade cellen eller de markerade cellerna
som CSV-data, och placerar varje post i en egen cell på raden.

Data → Namngivna områden... (Ctrl+Skift+G)

Visa dialogrutan Namngivna områden för att markera, lägga till, redigera och ta bort
namngivna områden. Se avsnittet Namngivna områden för mer information.

Data → Konsolidera...
Konsoliderar data. Se avsnittet Konsolidera data för mer information.

Data → Delsummor...
Skapa olika sorters delsummor i en databas.

Data → Giltighet...

Ange eller ändra felkontrollkriterier och felvarningsmeddelanden för markerade celler. Se
Giltighetskontroll för mer information.

Data → Målsök...
Öppna dialogrutan för målsökning. Se Målsökning för mer information.

Data → Pivot...
Öppna inställningsdialogrutan för pivot-tabeller. Se Pivot-tabeller för mer information.

7.8 Menyn Verktyg

Verktyg → Stavning...

Kontrollera stavning av ord på arbetsbladet.

Verktyg → Egna listor...

Visa eller justera den särskilda serien med ord som känns igen av Calligra Sheets. Listorna
kan användas för att infoga särskilda serier på arbetsbladet.
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Verktyg → Skydda arbetsblad...

Skydda arbetsbladet med ett lösenord. En dialogruta dyker upp som frågar efter ett lö-
senord. Avmarkeras alternativet frågas du efter lösenordet för att ta bort skyddet från ar-
betsbladet. Att skydda ett arbetsblad betyder att skydda alla celler på bladet. På ett skyddat
blad kan inte cellerna formateras om eller skrivas över.

Verktyg → Skydda dokument...

Skydda hela dokumentet med ett lösenord. En dialogruta dyker upp som frågar efter ett
lösenord. Avmarkeras alternativet frågas du efter lösenordet för att ta bort skyddet från
dokumentet. I ett skyddat dokument kan du inte byta namn på eller flytta ett arbetsblad.
Att skydda dokumentet betyder inte att varje enskild arbetsblad är skyddat.

Verktyg → Räkna om arbetsblad (Skift+F9)

Räkna om formler på det nuvarande bladet.

Verktyg → Räkna om dokument (F9)

Räkna om alla blad.

Verktyg → Kör skriptfil...

Kör det valda externa skriptet i Calligra Sheets. Calligra Sheets stöder skript skrivna i Java-
script, Python och Ruby. Standardexempel på skript finns i undermenyn Verktyg → Skript.

Verktyg → Skript

Här kan man köra skriptet för att exportera eller importera data med diverse format, spa-
ra Calligra Sheets logg i en fil, använda Orca talsyntes för handikappstöd, felsöka Python-
och Ruby-skript eller lägga till ytterligare funktioner för att visa aktiekurser eller väderför-
hållanden. Man kan till och med använda vissa R-funktioner (modulen RPy måste då vara
installerad).

Verktyg → Skripthantering...

Visar dialogrutan Skripthantering för att köra, ladda, ladda ur, installera, avinstallera och
hämta fler skript.

Verktyg → Funktionsoptimering...

Öppnar dialogrutan Funktionsoptimering där du kan välja en objektiv funktionscell, op-
timeringsmål (Maximera, Minimera eller ange Värde) och en uppsättning beslutsparame-
terceller.

7.9 Menyn Inställningar

Inställningar → Visade verktygsrader

Visa eller dölj verktygsraderna: Arkiv, Redigera, Navigering, Teckensnitt, Format och Fär-
g/Kant.

Inställningar → Statusrad

Visa eller dölj statusraden. Statusraden visar ytterligare information om markerade objekt
och snabba beräkningar för markerade celler.

Inställningar → Flikrad

Visa eller dölj flikraden. Alla blad i aktuellt dokument kan kommas åt via flikraden.

Inställningar → Anpassa genvägar...

Anpassa snabbtangenterna som används av Calligra Sheets. Se avsnittet om anpassa snabb-
tangenter för mer information.
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Inställningar → Anpassa verktygsrader...

Anpassa verktygsrader. Avsnittet om anpassa verktygsrader innehåller mer information.

Inställningar → Teman

Välj färgtema för Calligra Sheets fönster Du kan välja ett fördefinierat färgschema eller välja
Inställning... för att öppna färginställningsmodulen i systeminställningarna.

Inställningar → Aktiv författarprofil

Ställ in författarprofilen för nuvarande dokument. Du kan välja en av profilerna som är de-
finierade med Calligra Sheets inställningsfönster, Standardförfattarprofil som definierad
av systeminställningarna eller en tom Anonym profil som bibehåller din integritet.

Inställningar → Anpassa underrättelser...

Anpassa Calligra Sheets underrättelsesystem. Det finns inga åtgärder som du kan bli un-
derrättad om i den nuvarande versionen av Calligra Sheets.

Inställningar → Anpassa Calligra Sheets...

Allmän inställning av Calligra Sheets. Se avsnittet om Calligra Sheets inställning för mer
information.

7.10 Menyn Hjälp

Hjälp → Innehåll... (F1)

Startar KDE:s hjälpsystem med början på hjälpsidorna för Calligra Sheets (det här doku-
mentet).

Hjälp → Vad är det här? (Skift+F1)

Ändrar muspekaren till en kombination av en pil och ett frågetecken. Genom att klicka på
objekt i Calligra Sheets öppnas ett hjälpfönster (om det finns ett för just det här objektet)
som förklarar objektets funktion.

Hjälp → Rapportera fel...

Öppnar dialogrutan för felrapportering där du kan rapportera ett fel eller lämna ett förbätt-
ringsförslag.

Hjälp → Om Calligra Sheets

Det här visar information om version och upphovsmän.

Hjälp → Om KDE

Det här visar KDE:s version och annan grundläggande information.

7.11 Menyn som visas med höger musknapp

Det här avsnittet beskriver alternativen i menyn som visas genom att högerklicka på en markerad
cell eller markerade celler, rad(er) eller kolumn(er).

Cellformat... (Ctrl+Alt+F)
Formatera markerade celler. Se avsnittet Formatera kalkylblad för mer information.
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Klipp ut (Ctrl+X)

Placera markerade objekt på klippbordet. Om du därefter gör Klistra in, så flyttas objekten
från den ursprungliga platsen till den nya.

Kopiera (Ctrl+C)

Kopiera markerade objekt till klippbordet.

Klistra in (Ctrl+V)
Klistra in objekt från klippbordet till de markerade cellerna.

Klistra in special...

Särskilda sorters inklistring. Se avsnitten Andra inklistringslägen och Aritmetik med klistra
in special för mer information.

Klistra in och infoga

Klistra in från klippbordet till de markerade cellerna, och flytta tidigare celler för att ge
plats.

Alla
Ta bort innehållet i markerade celler.

Justera rad och kolumn

Ändra höjd på markerad rad och kolumn för att visa hela celler.

Förval
Ange förvalt format för markerade celler.

Områdesnamn...
Namnge markerat område. Se avsnittet Namngivna områden för mer information.

Ändra storlek på rad...

Ändra höjd på markerad rad.

Justera rad

Ändra höjd på markerad rad för att visa hela celler.

Ändra storlek på kolumn...

Ändra bredd på markerad kolumn.

Justera kolumn

Ändra bredd på markerad kolumn för att visa hela celler.

Infoga celler...

Infoga nya celler vid den markerade platsen, och flytta befintliga celler så att de får plats.

Ta bort celler...
Ta bort markerade celler, och flytta andra celler så att de upptar utrymmet som lämnas av
de borttagna cellerna.

Infoga rader

Infoga nya rader ovanför de markerade raderna.

Ta bort rader
Ta bort markerade rader.

Dölj rader

Döljer markerad(e) rad(er).
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Visa rader
Visar markerad(e) rad(er). För att visa dolda rader måste du markera ett radintervall som
inkluderar de dolda raderna.

Infoga kolumner
Infoga nya kolumner, till vänster om de markerade kolumnerna.

Ta bort kolumner
Ta bort markerade kolumner.

Dölj kolumner
Döljer markerad(e) kolumn(er).

Visa kolumner
Visar markerad(e) kolumn(er). För att visa dolda kolumner måste du markera ett kolum-
nintervall som inkluderar de dolda kolumnerna.

Kommentar...
Lägg till eller ändra en kommentar för den markerade cellen.

Urvalslista...
Låter dig välja och klistra in text från vilken cell som helst bland cellerna som för närvaran-
de är markerade i den valda cellen.

7.12 Andra snabbtangenter

Det här avsnittet beskriver de snabbtangenter i Calligra Sheets som används för åtgärder som
inte syns i någon av menyerna.

Ctrl+H
Visa eller dölj panelerna.

Ctrl+piltangenter
Om den markerade cellen är använd, flytta då cellmarkeringen till början eller slutet av
det använda området i nuvarande rad eller kolumn. Om den markerade cellen inte är an-
vänd, flytta då cellmarkeringen till början eller slutet av det oanvända området med celler
i nuvarande rad eller kolumn.

Ctrl+Skift+piltangenter
Om den markerade cellen är upptagen, markera alla upptagna celler från början till slutet
av blocket med upptagna celler för aktuell rad eller kolumn. Om den markerade cellen inte
är upptagen, markera alla celler som inte är upptagna från början till slutet av blocket med
inte upptagna celler för aktuell rad eller kolumn.

Page Down
Flytta cellmarkeringen 10 celler neråt.

Page Up
Flytta cellmarkeringen 10 celler uppåt.

Ctrl+Page Down
Gå till nästa blad.

Ctrl+Page Up
Gå till föregående blad.

F4
Ändra cellreferensen mellan typerna normal och absolut referens.
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Kapitel 8

Funktioner

Calligra Sheets har en enorm uppsättning inbyggda matematiska och andra funktioner som kan
användas i en formelcell.

8.1 Funktioner som stöds

Det här kapitlet innehåller en kortfattad översikt av alla funktioner som stöds i följande grupper:

Bitoperationer
Konvertering
Databas
Datum och tid
Ingenjörsfunktioner
Ekonomiska
Information
Logiska
Uppslagning och referens
Matematik
Statistiska
Text
Trigonometriska

8.1.1 Bitoperationer

8.1.1.1 BITAND

Funktionen BITAND() utför en OCH-operation bit-för-bit för de två heltalsparametrarna.

Returtyp: Heltal (som 1, 132 eller 2344)

Syntax

BITAND(värde; värde)

Parametrar
Kommentar: Första talet, Typ: Heltal (som 1, 132 eller 2344)
Kommentar: Andra talet, Typ: Heltal (som 1, 132 eller 2344)
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Exempel

BITAND(12;10) returnerar 8 (eftersom decimalt 12 är binärt 1100, decimalt 10 är binärt 1010,
och resultatet av 1100 ˝OCH˝ 1010 är 1000, vilket är heltalet 8).

Liknande funktioner
BITOR
BITXOR

8.1.1.2 BITLSHIFT

Funktionen BITLSHIFT() utför en bit-för-bit vänsterskift av den första parametern. Antal bitar att
skifta med anges av den andra parametern. Observera att ett negativt antal bitar att skifta vänster
blir högerskift.

Returtyp: Heltal (som 1, 132 eller 2344)

Syntax

BITLSHIFT(värde; skiftstorlek)

Parametrar
Kommentar: Första talet, Typ: Heltal (som 1, 132 eller 2344)
Kommentar: Värde att skifta vänster med, Typ: Heltal (som 1, 132 eller 2344)

Liknande funktioner
BITLSHIFT

8.1.1.3 BITOR

Funktionen BITOR() utför en ELLER-operation bit-för-bit för de två heltalsparametrarna.

Returtyp: Heltal (som 1, 132 eller 2344)

Syntax

BITOR(värde; värde)

Parametrar
Kommentar: Första talet, Typ: Heltal (som 1, 132 eller 2344)
Kommentar: Andra talet, Typ: Heltal (som 1, 132 eller 2344)

Exempel

BITOR(12;10) returnerar 14 (eftersom decimalt 12 är binärt 1100, decimalt 10 är binärt 1010,
och resultatet av 1100 ˝ELLER˝ 1010 är 1110, vilket är heltalet 14).

Liknande funktioner
BITAND
BITXOR
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8.1.1.4 BITRSHIFT

Funktionen BITRSHIFT() utför en bit-för-bit vänsterskift av den första parametern. Antal bitar att
skifta med anges av den andra parametern. Observera att ett negativt antal bitar att skifta höger
blir vänsterskift.
Returtyp: Heltal (som 1, 132 eller 2344)

Syntax

BITRSHIFT(värde; skiftstorlek)

Parametrar
Kommentar: Första talet, Typ: Heltal (som 1, 132 eller 2344)
Kommentar: Värde att skifta höger med, Typ: Heltal (som 1, 132 eller 2344)

Liknande funktioner
BITLSHIFT

8.1.1.5 BITXOR

Funktionen BITXOR() utför en exklusiv ELLER-operation bit-för-bit för de två heltalsparamet-
rarna.
Returtyp: Heltal (som 1, 132 eller 2344)

Syntax

BITXOR(värde; värde)

Parametrar
Kommentar: Första talet, Typ: Heltal (som 1, 132 eller 2344)
Kommentar: Andra talet, Typ: Heltal (som 1, 132 eller 2344)

Exempel

BITXOR(12;10) returnerar 6 (eftersom decimalt 12 är binärt 1100, decimalt 10 är binärt 1010,
och resultatet av 1100 ˝exklusiv ELLER˝ 1010 är 0110, vilket är heltalet 6).

Liknande funktioner
BITAND
BITOR

8.1.2 Konvertering

8.1.2.1 ARABIC

Funktionen ARABIC() konverterar ett romerskt tal till ett nummer.

Returtyp: Heltal (som 1, 132 eller 2344)

Syntax

ARABIC(tal)

Parametrar
Kommentar: Tal, Typ: Text

Exempel

ARABIC(˝IV˝) returnerar 4

68



Handbok Calligra Sheets

Exempel

ARABIC(˝XCIX˝) returnerar 99

Liknande funktioner
ROMAN

8.1.2.2 ASCIITOCHAR

Funktionen ASCIITOCHAR() returnerar tecknet för varje angiven ASCII-kod

Returtyp: Text

Syntax

ASCIITOCHAR(värde)

Parametrar
Kommentar: ASCII-värden att konvertera, Typ: Heltal (som 1, 132 eller 2344)

Exempel

ASCIITOCHAR(118) returnerar ˝v˝

Exempel

ASCIITOCHAR(75; 68; 69) returnerar ˝KDE˝

8.1.2.3 BOOL2INT

Funktionen BOOL2INT() returnerar ett heltal för ett givet booleskt värde. Den här metoden är
avsedd för att använda ett booleskt värde i metoder som kräver ett heltal.
Returtyp: Heltal (som 1, 132 eller 2344)

Syntax

BOOL2INT(värde)

Parametrar
Kommentar: Booleskt värde att konvertera, Typ: Ett booleskt värde (TRUE eller FALSE)

Exempel

BOOL2INT(True) returnerar 1

Exempel

BOOL2INT(False) returnerar 0

Liknande funktioner
INT2BOOL
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8.1.2.4 BOOL2STRING

Funktionen BOOL2STRING() returnerar ett strängvärde för ett givet booleskt värde. Den här
metoden är avsedd för att använda ett booleskt värde i metoder som kräver en sträng.

Returtyp: Text

Syntax

BOOL2STRING(värde)

Parametrar
Kommentar: Booleskt värde att konvertera, Typ: Ett booleskt värde (TRUE eller FALSE)

Exempel

BOOL2STRING(true) returnerar ˝True˝

Exempel

BOOL2STRING(false) returnerar ˝False˝

Exempel

upper(BOOL2STRING(find(˝nan˝;˝banan˝))) returnerar TRUE

8.1.2.5 CARX

Funktionen CARX() returnerar x-positionen motsvarande en punkt i ett polärt koordinatsystem.

Returtyp: Dubbel

Syntax

CARX(radie;vinkel)

Parametrar
Kommentar: Radie, Typ: Dubbel
Kommentar: Vinkel (radianer), Typ: Dubbel

Exempel

CARX(12;1,5707) returnerar 0,00115592

Exempel

CARX(12;0) returnerar 12

Liknande funktioner
CARY
POLA
POLR

8.1.2.6 CARY

Funktionen CARY() returnerar y-positionen motsvarande en punkt i ett polärt koordinatsystem.

Returtyp: Dubbel

Syntax

CARY(radie;vinkel)
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Parametrar
Kommentar: Radie, Typ: Dubbel
Kommentar: Vinkel (radianer), Typ: Dubbel

Exempel

CARY(12;1,5707) returnerar 12

Exempel

CARY(12;0) returnerar 0

Liknande funktioner
CARX
POLA
POLR

8.1.2.7 CHARTOASCII

Funktionen CHARTOASCII() returnerar ASCII-koden för det givna tecknet.

Returtyp: Heltal (som 1, 132 eller 2344)

Syntax

CHARTOASCII(värde)

Parametrar
Kommentar: En sträng med ett tecken att konvertera, Typ: Text

Exempel

CHARTOASCII(˝v˝) returnerar 118

Exempel

CHARTOASCII(r) är ett fel. Tecknet måste anges inom citationstecken.

8.1.2.8 DECSEX

Funktionen DECSEX() konverterar ett flyttalsvärde till tidsvärde.

Returtyp: Dubbel

Syntax

DECSEX(flyttal)

Parametrar
Kommentar: Värde, Typ: Dubbel

Exempel

DECSEX(1,6668) returnerar 1:40

Exempel

DECSEX(7,8) returnerar 7:47
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8.1.2.9 INT2BOOL

Funktionen INT2BOOL() returnerar ett booleskt värde för ett givet heltal. Den här metoden är
avsedd för att använda ett heltal i metoder som kräver ett booleskt värde. Den accepterar bara 0
eller 1. Om något annat värde anges, returneras FALSE.

Returtyp: Ett booleskt värde (TRUE eller FALSE)

Syntax

INT2BOOL(värde)

Parametrar
Kommentar: Heltalsvärde att konvertera, Typ: Heltal (som 1, 132 eller 2344)

Exempel

INT2BOOL(1) returnerar true

Exempel

INT2BOOL(0) returnerar false

Exempel

OR(INT2BOOL(1), false) returnerar true

Liknande funktioner
BOOL2INT

8.1.2.10 NUM2STRING

Funktionen NUM2STRING() returnerar ett strängvärde för ett givet tal. Observera att Calligra
Sheets kan konvertera tal till strängar automatiskt vid behov, så funktionen ska sällan behöva
användas.
Returtyp: Text

Syntax

NUM2STRING(värde)

Parametrar
Kommentar: Tal att konvertera till sträng, Typ: Flyttal (som 1,3, 0,343 eller 253)

Exempel

NUM2STRING(10) returnerar ˝10˝

Exempel

NUM2STRING(2,05) returnerar ˝2,05˝

Exempel

=find(˝101˝;NUM2STRING(A1)) (A1 = 2,010102) returnerar True

Liknande funktioner
STRING
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8.1.2.11 POLA

Funktionen POLA() returnerar vinkeln (i radianer) motsvarande en punkt i ett kartesiskt koordi-
natsystem.

Returtyp: Dubbel

Syntax

POLA(x;y)

Parametrar
Kommentar: Värde i x, Typ: Dubbel
Kommentar: Värde i y, Typ: Dubbel

Exempel

POLA(12;12) returnerar 0,78539816

Exempel

POLA(12;0) returnerar 0

Exempel

POLA(0;12) returnerar 1,5707

Liknande funktioner
POLR
CARX
CARY

8.1.2.12 POLR

Funktionen POLR() returnerar radien motsvarande en punkt i ett kartesiskt koordinatsystem.

Returtyp: Dubbel

Syntax

POLR(x;y)

Parametrar
Kommentar: Värde i x, Typ: Dubbel
Kommentar: Värde i y, Typ: Dubbel

Exempel

POLR(12;12) returnerar 16.9705

Exempel

POLR(12;0) returnerar 12

Liknande funktioner
POLA
CARX
CARY
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8.1.2.13 ROMAN

Funktionen ROMAN() returnerar talet i romerskt format. Talet ska vara ett positivt heltal. Den
valfria parametern Format anger hur kortfattat svaret ska vara, och har standardvärdet 0.

Returtyp: Text

Syntax

ROMAN(tal)

Parametrar
Kommentar: Nummer, Typ: Heltal (som 1, 132 eller 2344)
Kommentar: Format, Typ: Heltal (som 1, 132 eller 2344)

Exempel

ROMAN(99) returnerar ˝XCIX˝

Exempel

ROMAN(-55) returnerar˝Err˝

Liknande funktioner
ARABIC

8.1.2.14 SEXDEC

Funktionen SEXDEC() returnerar decimalvärdet. Du kan också ange ett tidsvärde.

Returtyp: Dubbel

Syntax

SEXDEC(tidsvärde) eller SEXDEC(timmar;minuter;sekunder)

Parametrar
Kommentar: Timmar, Typ: Heltal (som 1, 132 eller 2344)
Kommentar: Minuter, Typ: Heltal (som 1, 132 eller 2344)
Kommentar: Sekunder, Typ: Heltal (som 1, 132 eller 2344)

Exempel

SEXDEC(1;5;7) returnerar 1,0852778

Exempel

DECSEX(˝8:05˝) returnerar 8,08333333

8.1.2.15 STRING

Funktionen STRING() returnerar ett strängvärde för ett givet tal. Den är samma som funktionen
NUM2STRING.
Returtyp: Text

Syntax

Parametrar
Kommentar: Tal att konvertera till sträng, Typ: Flyttal (som 1,3, 0,343 eller 253)

Liknande funktioner
NUM2STRING
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8.1.3 Databas

8.1.3.1 DAVERAGE

Beräknar medelvärdet i en kolumn i en databas angiven av en uppsättning villkor, för värden
som är tal
Returtyp: FLOAT

Syntax
DAVERAGE(Databas; ˝Rubrik˝; Villkor)

Parametrar
Kommentar: Intervall som anger databasen, Typ: Ett område med strängar
Kommentar: Sträng som markerar kolumn i databasen, Typ: Text
Kommentar: Intervall som anger villkoren, Typ: Ett område med strängar

Exempel
DAVERAGE(A1:C5; ˝Lön˝; A9:A11)

8.1.3.2 DCOUNT

Räknar celler som innehåller numeriska värden i en kolumn i en databas angiven av en uppsätt-
ning villkor.
Returtyp: FLOAT

Syntax
DCOUNT(Databas; ˝Rubrik˝; Villkor)

Parametrar
Kommentar: Intervall som anger databasen, Typ: Ett område med strängar
Kommentar: Sträng som markerar kolumn i databasen, Typ: Text
Kommentar: Intervall som anger villkoren, Typ: Ett område med strängar

Exempel
DCOUNT(A1:C5; ˝Lön˝; A9:A11)

Liknande funktioner
DCOUNTA

8.1.3.3 DCOUNTA

Räknar celler som innehåller numeriska eller alfanumeriska värden i en kolumn i en databas
angiven av en uppsättning villkor.
Returtyp: FLOAT

Syntax
DCOUNTA(Databas; ˝Rubrik˝; Villkor)

Parametrar
Kommentar: Intervall som anger databasen, Typ: Ett område med strängar
Kommentar: Sträng som markerar kolumn i databasen, Typ: Text
Kommentar: Intervall som anger villkoren, Typ: Ett område med strängar

Exempel
DCOUNTA(A1:C5; ˝Lön˝; A9:A11)

Liknande funktioner
DCOUNT
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8.1.3.4 DGET

Returnerar ett ensamt värde från en kolumn i en databas angiven av en uppsättning villkor.
Funktionen returnerar ett fel om inget värde, eller mer än ett värde finns.

Returtyp: FLOAT

Syntax
DGET(Databas; ˝Rubrik˝; Villkor)

Parametrar
Kommentar: Intervall som anger databasen, Typ: Ett område med strängar
Kommentar: Sträng som markerar kolumn i databasen, Typ: Text
Kommentar: Intervall som anger villkoren, Typ: Ett område med strängar

Exempel
DGET(A1:C5; ˝Lön˝; A9:A11)

8.1.3.5 DMAX

Returnerar det största värdet i en kolumn i en databas angiven av en uppsättning villkor.

Returtyp: FLOAT

Syntax
DMAX(Databas; ˝Rubrik˝; Villkor)

Parametrar
Kommentar: Intervall som anger databasen, Typ: Ett område med strängar
Kommentar: Sträng som markerar kolumn i databasen, Typ: Text
Kommentar: Intervall som anger villkoren, Typ: Ett område med strängar

Exempel
DMAX(A1:C5; ˝Lön˝; A9:A11)

Liknande funktioner
DMIN

8.1.3.6 DMIN

Returnerar det minsta värdet i en kolumn i en databas angiven av en uppsättning villkor.

Returtyp: FLOAT

Syntax
DMIN(Databas; ˝Rubrik˝; Villkor)

Parametrar
Kommentar: Intervall som anger databasen, Typ: Ett område med strängar
Kommentar: Sträng som markerar kolumn i databasen, Typ: Text
Kommentar: Intervall som anger villkoren, Typ: Ett område med strängar

Exempel
DMIN(A1:C5; ˝Lön˝; A9:A11)

Liknande funktioner
DMAX
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8.1.3.7 DPRODUCT

Returnerar produkten av alla numeriska värden i en kolumn i en databas angiven av en uppsätt-
ning villkor.
Returtyp: FLOAT

Syntax
DPRODUCT(Databas; ˝Rubrik˝; Villkor)

Parametrar
Kommentar: Intervall som anger databasen, Typ: Ett område med strängar
Kommentar: Sträng som markerar kolumn i databasen, Typ: Text
Kommentar: Intervall som anger villkoren, Typ: Ett område med strängar

Exempel
DPRODUCT(A1:C5; ˝Lön˝; A9:A11)

8.1.3.8 DSTDEV

Returnerar en uppskattning av standardavvikelsen för en population baserad på ett urval med
användning av alla värden i en kolumn i en databas angiven av en uppsättning villkor.
Returtyp: FLOAT

Syntax
DSTDEV(Databas; ˝Rubrik˝; Villkor)

Parametrar
Kommentar: Intervall som anger databasen, Typ: Ett område med strängar
Kommentar: Sträng som markerar kolumn i databasen, Typ: Text
Kommentar: Intervall som anger villkoren, Typ: Ett område med strängar

Exempel
DSTDEV(A1:C5; ˝Lön˝; A9:A11)

Liknande funktioner
DSTDEVP

8.1.3.9 DSTDEVP

Returnerar den beräknade standardavvikelse baserat på hela populationen med användning av
alla numeriska värden i en kolumn i en databas angiven av en uppsättning villkor.
Returtyp: FLOAT

Syntax
DSTDEVP(Databas; ˝Rubrik˝; Villkor)

Parametrar
Kommentar: Intervall som anger databasen, Typ: Ett område med strängar
Kommentar: Sträng som markerar kolumn i databasen, Typ: Text
Kommentar: Intervall som anger villkoren, Typ: Ett område med strängar

Exempel
DSTDEVP(A1:C5; ˝Lön˝; A9:A11)

Liknande funktioner
DSTDEV
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8.1.3.10 DSUM

Summerar tal i en kolumn i en databas angiven av en uppsättning villkor.

Returtyp: FLOAT

Syntax
DSUM(Databas; ˝Rubrik˝; Villkor)

Parametrar
Kommentar: Intervall som anger databasen, Typ: Ett område med strängar
Kommentar: Sträng som markerar kolumn i databasen, Typ: Text
Kommentar: Intervall som anger villkoren, Typ: Ett område med strängar

Exempel
DSUM(A1:C5; ˝Lön˝; A9:A11)

8.1.3.11 DVAR

Returnerar en uppskattning av variansen för en population baserad på ett urval med användning
av alla värden i en kolumn i en databas angiven av en uppsättning villkor.

Returtyp: FLOAT

Syntax
DVAR(Databas; ˝Rubrik˝; Villkor)

Parametrar
Kommentar: Intervall som anger databasen, Typ: Ett område med strängar
Kommentar: Sträng som markerar kolumn i databasen, Typ: Text
Kommentar: Intervall som anger villkoren, Typ: Ett område med strängar

Exempel
DVAR(A1:C5; ˝Lön˝; A9:A11)

Liknande funktioner
DVARP

8.1.3.12 DVARP

Returnerar den beräknade variansen baserat på hela populationen med användning av alla vär-
den i en kolumn i en databas angiven av en uppsättning villkor.

Returtyp: FLOAT

Syntax
DVARP(Databas; ˝Rubrik˝; Villkor)

Parametrar
Kommentar: Intervall som anger databasen, Typ: Ett område med strängar
Kommentar: Sträng som markerar kolumn i databasen, Typ: Text
Kommentar: Intervall som anger villkoren, Typ: Ett område med strängar

Exempel
DVARP(A1:C5; ˝Lön˝; A9:A11)

Liknande funktioner
DVAR
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8.1.3.13 GETPIVOTDATA

Hämtar summering från en pivåtabell.
Returtyp: FLOAT

Syntax
GETPIVOTDATA(Databas; ˝Försäljning˝)

Parametrar
Kommentar: Intervall som innehåller pivåtabellen, Typ: Ett område med strängar
Kommentar: Namn på fältet som du vill ha summering för, Typ: Text

8.1.4 Datum och tid

8.1.4.1 CURRENTDATE

Funktionen CURRENTDATE() returnerar det aktuella datumet. Den är ekvivalent med funktio-
nen TODAY.
Returtyp: Datum

Syntax
CURRENTDATE()

Parametrar
Exempel

CURRENTDATE() returnerar ˝Lördag 13 april 2002˝

Liknande funktioner
CURRENTTIME
TODAY

8.1.4.2 CURRENTDATETIME

Funktionen CURRENTDATETIME() returnerar det aktuella datumet och tiden.
Returtyp: Datum

Syntax
CURRENTDATETIME()

Parametrar
Exempel

CURRENTDATETIME() returnerar ˝Lördag 13 april 2002 19:12:01˝

8.1.4.3 CURRENTTIME

Funktionen CURRENTTIME() returnerar den aktuella tiden formaterad med lokalaparametrar.
Returtyp: Datum

Syntax
CURRENTTIME()

Parametrar
Exempel

CURRENTTIME() returnerar ˝19:12:01˝
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8.1.4.4 DATE

Funktionen DATE() returnerar datumet formaterat med lokala parametrar.

Returtyp: Text

Syntax
DATE(år;månad;datum)

Parametrar
Kommentar: År, Typ: Heltal (som 1, 132 eller 2344)
Kommentar: Månad, Typ: Heltal (som 1, 132 eller 2344)
Kommentar: Dag, Typ: Heltal (som 1, 132 eller 2344)

Exempel
DATE(2000;5;5) returnerar Fredag 5 Maj 2000

8.1.4.5 DATE2UNIX

Funktionen DATE2UNIX() konverterar ett datum och tidsvärde till Unixtid.

En Unixtid är antalet sekunder efter midnatt den 1:a januari, 1970.

Returtyp: Heltal (som 1, 132 eller 2344)

Syntax
DATE2UNIX(datum)

Parametrar
Kommentar: Datum, Typ: Text

Exempel
DATE2UNIX(˝01/01/2000˝) returnerar 946 684 800

8.1.4.6 DATEDIF

Funktionen DATEDIF() returnerar skillnaden mellan två datum.

Intervall måste vara något av följande: ˝m˝: månad; ˝d˝: dagar; ˝y˝: hela år; ˝ym˝: månad utan
år; ˝yd˝: dagar utan år; ˝md˝: dagar utan månader och år

Returtyp: Heltal (som 1, 132 eller 2344)

Syntax
DATEDIF(första datum; andra datum; intervall)

Parametrar
Kommentar: Första datum, Typ: Text
Kommentar: Andra datum, Typ: Text
Kommentar: Intervall, Typ: Text

Exempel
DATEDIF(A1;A2;˝d˝) där A1 är ˝1:a januari 1995˝ och A2 is ˝15:e juni 1999˝ returnerar
antalet dagar 1626

Exempel
DATEDIF(A1;A2;˝m˝) där A1 är ˝1:a januari 1995˝ och A2 is ˝15:e juni 1999˝ returnerar
antalet månader 53
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8.1.4.7 DATEVALUE

Funktionen DATEVALUE returnerar ett tal som representerar dagen, dvs. antal dagar som har
förflutit sedan 31 december, 1899.
Returtyp: Heltal (som 1, 132 eller 2344)

Syntax
DATEVALUE(datum)

Parametrar
Kommentar: Datum, Typ: Text

Exempel
DATEVALUE(˝2002-02-222˝) returnerar 37309

Liknande funktioner
TIMEVALUE

8.1.4.8 DAY

Funktionerna DAY returnerar dagen för ett datum. Om ingen parameter anges, returneras inne-
varande dag.

Returtyp: Heltal (som 1, 132 eller 2344)

Syntax
DAY(datum)

Parametrar
Kommentar: Datum, Typ: Text

Exempel
DAY(˝2002-02-22˝) returnerar 22

Exempel
DAY(2323,1285) returnerar 11

Liknande funktioner
MONTH
YEAR

8.1.4.9 DAYNAME

Funktionen DAYNAME() returnerar namnet på veckodagen (1..7). I vissa länder börjar veckan
på måndagen, i andra länder är söndagen den första dagen.
Returtyp: Text

Syntax
DAYNAME(veckodag)

Parametrar
Kommentar: Dagens nummer i veckan (1..7), Typ: Heltal (som 1, 132 eller 2344)

Exempel
DAYNAME(1) returns måndag (om veckan börjar på måndag)

Liknande funktioner
WEEKDAY
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8.1.4.10 DAGUNDERÅR

Funktionen DAYOFYEAR() returnerar dagens nummer under året (1...365).
Returtyp: Heltal (som 1, 132 eller 2344)

Syntax
DAYOFYEAR(år;månad;datum)

Parametrar
Kommentar: År, Typ: Heltal (som 1, 132 eller 2344)
Kommentar: Månad, Typ: Heltal (som 1, 132 eller 2344)
Kommentar: Dag, Typ: Heltal (som 1, 132 eller 2344)

Exempel
DAYOFYEAR(2000;12;1) returnerar 336

Exempel
DAYOFYEAR(2000;2;29) returnerar 60

8.1.4.11 DAYS

Funktionen DAYS() returnerar skillnaden mellan två datum i dagar.
Returtyp: Heltal (som 1, 132 eller 2344)

Syntax
DAYS(datum2; datum1)

Parametrar
Kommentar: Första (tidigaste) datumvärdet, Typ: Text
Kommentar: Andra datumvärdet, Typ: Text

Exempel
DAYS(˝2002-02-22˝, ˝2002-02-26˝) returnerar 4

8.1.4.12 DAYS360

Funktionen DAYS360() returnerar antalet dagar från datum1 till datum2 med användning av en
360 dagars kalender, där alla månader antas ha 30 dagar. Om metod är FALSE (normalvärdet) så
används den amerikanska metoden, annars den europeiska.
Returtyp: Heltal (som 1, 132 eller 2344)

Syntax
DAYS360(datum1; datum2; metod)

Parametrar
Kommentar: Datum1, Typ: Text
Kommentar: Datum2, Typ: Text
Kommentar: Metod, Typ: Ett booleskt värde (TRUE eller FALSE)

Exempel
DAYS360(˝2002-02-22˝; ˝2002-04-21˝; FALSE) returnerar 59

Liknande funktioner
DAYS
MONTHS
WEEKS
YEARS
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8.1.4.13 DAYSINMONTH

Funktionen DAYSINMONTH() returnerar antalet dagar i angiven månad och år.

Returtyp: Heltal (som 1, 132 eller 2344)

Syntax

DAYSINMONTH(år;månad)

Parametrar
Kommentar: År, Typ: Heltal (som 1, 132 eller 2344)
Kommentar: Månad, Typ: Heltal (som 1, 132 eller 2344)

Exempel

DAYSINMONTH(2000;2) returnerar 29

8.1.4.14 DAYSINYEAR

Funktionen DAYSINYEAR() returnerar antalet dagar i angivet år.

Returtyp: Heltal (som 1, 132 eller 2344)

Syntax

DAYSINYEAR(år)

Parametrar
Kommentar: År, Typ: Heltal (som 1, 132 eller 2344)

Exempel

DAYSINYEAR(2000) returnerar 366

8.1.4.15 EASTERSUNDAY

Funktionen EASTERSUNDAY() returnerar datumet som motsvarar påsksöndagen för året som
anges som parameter.

Returtyp: Datum

Syntax

EASTERSUNDAY(år)

Parametrar
Kommentar: År, Typ: Heltal (som 1, 132 eller 2344)

Exempel

EASTERSUNDAY(2003) returnerar ˝20 april 2003˝
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8.1.4.16 EDATE

Funktionerna EDATE returnerar datumet som anges av ett givet datum och ett antal månader
före eller efter datumet.
Returtyp: Datum

Syntax

EDATE(datum;månader)

Parametrar
Kommentar: Datum, Typ: Text
Kommentar: Månader, Typ: Heltal (som 1, 132 eller 2344)

Exempel

EDATE(˝2002-02-22˝;3) returnerar ˝2002-05-22˝

Exempel

EDATE(˝2002-03-31˝; -1) returnerar ˝2002-02-28˝

Liknande funktioner
DATE
EOMONTH

8.1.4.17 EOMONTH

Funktionerna EOMONTH returnerar sista dagen under månaden som anges av ett datum och
antalet månader från det datumet.
Returtyp: Datum

Syntax

EOMONTH(datum; månader)

Parametrar
Kommentar: Datum, Typ: Text
Kommentar: Månader, Typ: Heltal (som 1, 132 eller 2344)

Exempel

EOMONTH(˝2002-02-22˝; 3) returnerar ˝2002-05-31˝

Exempel

EOMONTH(˝2002-03-12˝; -1) returnerar ˝2002-02-26˝

Exempel

EOMONTH(˝2002-03-12˝; 0) returnerar ˝2002-03-31˝

Liknande funktioner
EDATE
MONTH
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8.1.4.18 HOUR

Funktionerna HOUR() returnerar timmen för ett datum. Om ingen parameter anges, returneras
innevarande timme.
Returtyp: Heltal (som 1, 132 eller 2344)

Syntax

HOUR(tid)

Parametrar
Kommentar: Tid, Typ: Text

Exempel

HOUR(˝22:10:12˝) returnerar 22

Exempel

HOUR(0,1285) returnerar 3

Liknande funktioner
MINUTE
SECOND

8.1.4.19 HOURS

Funktionen HOURS() returnerar timmarna i ett tidsuttryck.

Returtyp: Heltal (som 1, 132 eller 2344)

Syntax

HOURS(tid)

Parametrar
Kommentar: Tid, Typ: Text

Exempel

HOURS(˝10:5:2˝) returnerar 10

8.1.4.20 ISLEAPYEAR

Funktionen ISLEAPYEAR() returnerar True om angivet år är ett skottår.

Returtyp: Ett booleskt värde (TRUE eller FALSE)

Syntax

ISLEAPYEAR(år)

Parametrar
Kommentar: År, Typ: Heltal (som 1, 132 eller 2344)

Exempel

ISLEAPYEAR(2000) returnerar True
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8.1.4.21 ISOWEEKNUM

Funktionen ISOWEEKNUM() returnerar veckonumret då datumet infaller. Observera att funk-
tionen följer ISO8601-standarden: en vecka börjar alltid på en måndag, och slutar på en söndag.
Första veckan under ett år är veckan som innehåller årets första torsdag.

Returtyp: Heltal (som 1, 132 eller 2344)

Syntax
ISOWEEKNUM(datum)

Parametrar
Kommentar: Datum, Typ: Text

Exempel
ISOWEEKNUM(A1) returnerar 51 när A1 är ˝21:a dec˝.

Liknande funktioner
WEEKNUM

8.1.4.22 MINUTE

Funktionerna MINUTE returnerar minuterna för en tid. Om ingen parameter anges, returneras
innevarande minut.
Returtyp: Heltal (som 1, 132 eller 2344)

Syntax
MINUTE(tid)

Parametrar
Kommentar: Tid, Typ: Text

Exempel
MINUTE(˝22:10:12˝) returnerar 10

Exempel
MINUTE(0,1234) returnerar 57

Liknande funktioner
HOUR
SECOND

8.1.4.23 MINUTES

Funktionen MINUTES() returnerar minuterna i ett tidsuttryck.

Returtyp: Heltal (som 1, 132 eller 2344)

Syntax
MINUTES(tid)

Parametrar
Kommentar: Tid, Typ: Text

Exempel
MINUTES(˝10:5:2˝) returnerar 5
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8.1.4.24 MONTH

Funktionerna MONTH() returnerar månaden för ett datum. Om ingen parameter anges, returne-
ras innevarande månad.
Returtyp: Heltal (som 1, 132 eller 2344)

Syntax

MONTH(datum)

Parametrar
Kommentar: Datum, Typ: Text

Exempel

MONTH(˝2/22/2002-02-22˝) returnerar 2

Exempel

MONTH(2323,1285) returnerar 5

Liknande funktioner
DAY
YEAR

8.1.4.25 MONTHNAME

Funktionen MONTHNAME() returnerar namnet på månaden (1...12).

Returtyp: Text

Syntax

MONTHNAME(tal)

Parametrar
Kommentar: Månadens nummer (1..12), Typ: Heltal (som 1, 132 eller 2344)

Exempel

MONTHNAME(5) returnerar maj

8.1.4.26 MONTHS

Funktionen MONTHS() returnerar skillnaden mellan två datum i månader. Den tredje parame-
tern anger beräkningsläget: Om läget är 0, så returnerar MONTHS() det maximalt möjliga antalet
månader mellan datumen. Om läget är 1, så returnerar den bara antalet hela månader mellan da-
tumen.
Returtyp: Heltal (som 1, 132 eller 2344)

Syntax

MONTHS(datum2; datum1; läge)

Parametrar
Kommentar: Första (tidigaste) datumvärdet, Typ: Text
Kommentar: Andra datumvärdet, Typ: Text
Kommentar: Beräkningsläge, Typ: Heltal (som 1, 132 eller 2344)
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Exempel

MONTHS(˝2002-01-18˝, ˝2002-02-26˝, 0) returnerar 1, eftersom det finns en månad och 8
dagar mellan datumen

Exempel

MONTHS(˝2002-01-19˝, ˝2002-02-26˝, 1) returnerar 0, eftersom det inte finns en hel månad
mellan datumen, med början på månadens första dag

8.1.4.27 NETWORKDAY

Funktionen NETWORKDAY() returnerar antalet arbetsdagar mellan startdatumet och slutdatu-
met.
Helgdagar måste vara något av följande: nummer = dagar att lägga till, ett ensamt datum eller
ett fält med datum.
Returtyp: Heltal (som 1, 132 eller 2344)

Syntax

NETWORKDAY(startdatum; slutdatum; helgdagar)

Parametrar
Kommentar: Startdatum, Typ: Text
Kommentar: Slutdatum, Typ: Text
Kommentar: Helgdagar, Typ: Text

Exempel

NETWORKDAY(˝2001-01-01˝;˝2001-01-08˝) returnerar 5 arbetsdagar

Exempel

NETWORKDAY(˝2001-01-01˝;˝2001-01-08˝;2) returnerar 3 arbetsdagar

8.1.4.28 NOW

Funktionen NOW() returnerar dagens datum. Den är identisk med CURRENTDATETIME, och
tillhandahålls för att fungera ihop med andra program.

Returtyp: Datum

Syntax

NOW()

Parametrar

Exempel

NOW() returnerar ˝lördagen den 13 april 2002 19:12:01˝

Liknande funktioner
CURRENTTIME
TODAY
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8.1.4.29 SECOND

Funktionerna SECOND returnerar sekunden för en given tid. Om ingen parameter anges, retur-
neras innevarande sekund.
Returtyp: Heltal (som 1, 132 eller 2344)

Syntax
SECOND(tid)

Parametrar
Kommentar: Tid, Typ: Text

Exempel
SECOND(˝22:10:12˝) returnerar 12

Exempel
SECOND(0,1234) returnerar 42

Liknande funktioner
HOUR
MINUTE

8.1.4.30 SECONDS

Funktionen SECONDS() returnerar sekunderna i ett tidsuttryck.

Returtyp: Heltal (som 1, 132 eller 2344)

Syntax
SECONDS(tid)

Parametrar
Kommentar: Tid, Typ: Text

Exempel
SECONDS(˝10:5:2˝) returnerar 2

8.1.4.31 TIME

Funktionen TIME() returnerar tiden formaterad med lokala parametrar.
Returtyp: Text

Syntax
TIME(timmar;minuter;sekunder)

Parametrar
Kommentar: Timmar, Typ: Heltal (som 1, 132 eller 2344)
Kommentar: Minuter, Typ: Heltal (som 1, 132 eller 2344)
Kommentar: Sekunder, Typ: Heltal (som 1, 132 eller 2344)

Exempel
TIME(10;2;2) returnerar 10:02:02

Exempel
TIME(10;70;2) returnerar 11:10:0

Exempel
TIME(10;-40;0) returnerar 9:20:0
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8.1.4.32 TIMEVALUE

Funktionen TIMEVALUE() returnerar ett nummer (mellan 0 och 1) som representerar tiden under
dagen.

Returtyp: Flyttal (som 1,3, 0,343 eller 253)

Syntax

TIMEVALUE(tid)

Parametrar
Kommentar: Tid, Typ: Text

Exempel

TIMEVALUE(˝10:05:02˝) returnerar 0,42

Liknande funktioner
DATEVALUE

8.1.4.33 TODAY

Funktionen TODAY() returnerar dagens datum.

Returtyp: Datum

Syntax

TODAY()

Parametrar

Exempel

TODAY() returnerar ˝lördag den 13 april 2002˝

Liknande funktioner
CURRENTTIME
NOW

8.1.4.34 UNIX2DATE

Funktionen UNIX2DATE() konverterar Unixtid till ett datum och tidsvärde.

En Unixtid är antalet sekunder efter midnatt den 1:a januari, 1970.

Returtyp: Datum

Syntax

UNIX2DATE(unixtid)

Parametrar
Kommentar: Unixtid, Typ: Heltal (som 1, 132 eller 2344)

Exempel

UNIX2DATE(0) returnerar 1970-01-01
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8.1.4.35 VECKODAG

Funktionen WEEKDAY() returnerar veckodagen för ett givet datum. Om metoden är 1 (förvalt),
returnerar WEEKDAY() 1 för söndag, 2 för måndag, ... Om metoden är 2, så är måndag 1, tisdag
2, .. och om metoden är 3, så returnerar WEEKDAY() 0 för måndag, 1 för tisdag, ...

Returtyp: Heltal (som 1, 132 eller 2344)

Syntax

WEEKDAY(datum; metod)

Parametrar
Kommentar: Datum, Typ: Text
Kommentar: Metod (valfri), Typ: Heltal (som 1, 132 eller 2344)

Exempel

WEEKDAYS(˝2002-02-22˝, 2) returnerar 5

Liknande funktioner
DAYNAME

8.1.4.36 WEEKNUM

Funktionen WEEKNUM() returnerar ett veckonummer då datumet infaller som inte följer ISO.

Returtyp: Heltal (som 1, 132 eller 2344)

Syntax

WEEKNUM(datum; metod)

Parametrar
Kommentar: Datum, Typ: Text
Kommentar: Metod (valfri), Typ: Heltal (som 1, 132 eller 2344)

Exempel

WEEKNUM(A1; 1) returnerar 11 när A1 är ˝9:e mars 2008˝. Veckonumret under året, när
veckan börjar på söndag (1, det är normalvärdet om Metod utesluts).

Exempel

WEEKNUM(A1; 2) returnerar 10 när A1 är ˝9:e mars 2008˝. Veckonumret under året, när
veckan börjar på måndag (2).

Liknande funktioner
ISOWEEKNUM

8.1.4.37 WEEKS

Funktionen WEEKS() returnerar skillnaden mellan två datum i veckor. Den tredje parametern
anger beräkningsläget: Om läget är 0, så returnerar WEEKS() det maximalt möjliga antalet veckor
mellan datumen. Om läget är 1, så returnerar den bara antalet hela veckor mellan datumen.

Returtyp: Heltal (som 1, 132 eller 2344)

Syntax

WEEKS(datum2; datum1; läge)
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Parametrar
Kommentar: Första (tidigaste) datumvärdet, Typ: Text
Kommentar: Andra datumvärdet, Typ: Text
Kommentar: Beräkningsläge, Typ: Heltal (som 1, 132 eller 2344)

Exempel

WEEKS(˝2002-02-18˝, ˝2002-02-26˝, 0) returnerar 1, eftersom det finns en vecka och en dag
mellan datumen

Exempel

WEEKS(˝2002-19-02˝, ˝2002-19-02˝, 1) returnerar 0, eftersom det inte finns en hel vecka
mellan datumen, med början på veckans första dag (måndag eller söndag, beroende på
landsinställningarna)

8.1.4.38 WEEKSINYEAR

Funktionen WEEKSINYEAR() returnerar antalet veckor i angivet år.

Returtyp: Heltal (som 1, 132 eller 2344)

Syntax

WEEKSINYEAR(år)

Parametrar
Kommentar: År, Typ: Heltal (som 1, 132 eller 2344)

Exempel

WEEKSINYEAR(2000) returnerar 52

8.1.4.39 WORKDAY

Funktionen WORKDAY() returnerar datumet som är antalet arbetsdagar från startdatumet.

Helgdagar måste vara något av följande: nummer = dagar att lägga till, ett ensamt datum eller
ett fält med datum.
Returtyp: Datum

Syntax

WORKDAY(startdatum; dagar; helgdagar)

Parametrar
Kommentar: Startdatum, Typ: Text
Kommentar: Arbetsdagar, Typ: Heltal (som 1, 132 eller 2344)
Kommentar: Helgdagar, Typ: Text

Exempel

Om B9 är ˝2001-01-01˝, D3 är ˝2001-01-03˝, D4 är ˝2003-01-04˝, returnerar WORK-
DAY(B9;2;D3:D4) ˝Fri 5 jan 2001˝
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8.1.4.40 YEAR

Funktionerna YEAR returnerar året för ett datum. Om ingen parameter anges, returneras inne-
varande år.
Returtyp: Heltal (som 1, 132 eller 2344)

Syntax

YEAR(datum)

Parametrar
Kommentar: Datum, Typ: Text

Exempel

YEAR(˝2002-02-22˝) returnerar 2002

Exempel

YEAR(2323,1285) returnerar 1906

Liknande funktioner
DAY
MONTH

8.1.4.41 YEARFRAC

Funktionen YEARFRAC() returnerar antalet hela dagar mellan startdatumet och slutdatumet en-
ligt basen.

Basen måste vara något av följande: 0 = 30/360 Förenta staterna, 1 = Verklig/verklig, 2 = Verkli-
g/360, 3 = Verklig/365, 4 = Europeisk 30/360

Returtyp: Heltal (som 1, 132 eller 2344)

Syntax

YEARFRAC(startdatum; slutdatum; bas)

Parametrar
Kommentar: Första datum, Typ: Text
Kommentar: Andra datum, Typ: Text
Kommentar: Intervall, Typ: Text

8.1.4.42 ÅREN

Funktionen YEARS() returnerar skillnaden mellan två datum i år. Den tredje parametern anger
beräkningsläget: Om läget är 0, så returnerar YEARS() det maximalt möjliga antalet år mellan
datumen. Om läget är 1, så returnerar den bara antalet hela år, med början på första januari och
slut på 31 december.

Returtyp: Heltal (som 1, 132 eller 2344)

Syntax

YEARS(datum2; datum1; läge)

Parametrar
Kommentar: Första (tidigaste) datumvärdet, Typ: Text
Kommentar: Andra datumvärdet, Typ: Text
Kommentar: Beräkningsläge, Typ: Heltal (som 1, 132 eller 2344)
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Exempel

YEARS(˝2001-02-19˝, ˝2002-02-26˝, 0) returnerar 1, eftersom det finns ett år och 7 dagar
mellan datumen

Exempel

YEARS(˝2002-02-19˝, ˝2002-02-26˝, 1) returnerar 0, eftersom det inte finns ett helt år mellan
datumen, med början på årets första dag

8.1.5 Ingenjörsformat

8.1.5.1 BASE

Funktionen BASE() konverterar ett tal från bas 10 till ett strängvärde med en bas för resultatet
från 2 till 36.
Returtyp: Text

Syntax

BASE(tal;bas;noggrannhet)

Parametrar
Kommentar: Nummer, Typ: Flyttal (som 1,3, 0,343 eller 253)
Kommentar: Bas, Typ: Heltal (som 1, 132 eller 2344)
Kommentar: Minimal längd, Typ: Heltal (som 1, 132 eller 2344)

Exempel

BASE(128;8) returnerar ˝200˝

8.1.5.2 BESSELI

Funktionen BESSELI() returnerar den modifierade Bessel-funktionen ln(x).

Returtyp: Flyttal (som 1,3, 0,343 eller 253)

Syntax

BESSELI(X;N)

Parametrar
Kommentar: Där funktionen utvärderas, Typ: Flyttal (som 1,3, 0,343 eller 253)
Kommentar: Funktionens ordning, Typ: Heltal (som 1, 132 eller 2344)

Exempel

BESSELI(0,7;3) returnerar 0,007367374

Liknande funktioner
BESSELJ
BESSELK
BESSELY
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8.1.5.3 BESSELJ

Funktionen BESSELJ() returnerar Bessel-funktionen.

Returtyp: Flyttal (som 1,3, 0,343 eller 253)

Syntax

BESSELJ(X;N)

Parametrar
Kommentar: Där funktionen utvärderas, Typ: Flyttal (som 1,3, 0,343 eller 253)
Kommentar: Funktionens ordning, Typ: Heltal (som 1, 132 eller 2344)

Exempel

BESSELJ(0,89;3) returnerar 0,013974004

Liknande funktioner
BESSELI
BESSELK
BESSELY

8.1.5.4 BESSELK

Funktionen BESSELK() returnerar den modifierade Bessel-funktionen, som motsvarar Bessel-
funktionen utvärderad för rent imaginära argument.

Returtyp: Flyttal (som 1,3, 0,343 eller 253)

Syntax

BESSELK(X;N)

Parametrar
Kommentar: Där funktionen utvärderas, Typ: Flyttal (som 1,3, 0,343 eller 253)
Kommentar: Funktionens ordning, Typ: Heltal (som 1, 132 eller 2344)

Exempel

BESSELK(3;9) returnerar 397,95880

Liknande funktioner
BESSELI
BESSELJ
BESSELY

8.1.5.5 BESSELY

Funktionen BESSELY() returnerar den modifierade Bessel-funktionen, som också kallas Weber-
funktionen eller Neumann-funktionen.
Returtyp: Flyttal (som 1,3, 0,343 eller 253)

Syntax

BESSELY(X;N)

Parametrar
Kommentar: Där funktionen utvärderas, Typ: Flyttal (som 1,3, 0,343 eller 253)
Kommentar: Funktionens ordning, Typ: Heltal (som 1, 132 eller 2344)
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Exempel

BESSELY(4;2) är lika med 0,215903595

Liknande funktioner
BESSELI
BESSELJ
BESSELK

8.1.5.6 BIN2DEC

Funktionen BIN2DEC() returnerar värdet formaterat som ett decimalt nummer.

Returtyp: Heltal (som 1, 132 eller 2344)

Syntax

BIN2DEC(värde)

Parametrar
Kommentar: Värdet att konvertera, Typ: Heltal (som 1, 132 eller 2344)

Exempel

BIN2DEC(˝1010˝) returnerar 10

Exempel

BIN2DEC(˝11111˝) returnerar 31

8.1.5.7 BIN2HEX

Funktionen BIN2HEX() returnerar värdet formaterat som ett hexadecimalt nummer.

Returtyp: Text

Syntax

BIN2HEX(värde)

Parametrar
Kommentar: Värdet att konvertera, Typ: Text
Kommentar: Utmatningens minimala längd, Typ: Heltal (som 1, 132 eller 2344)

Exempel

BIN2HEX(˝1010˝) returnerar ˝a˝

Exempel

BIN2HEX(˝11111˝) returnerar ˝1f˝

8.1.5.8 BIN2OCT

Funktionen BIN2OCT() returnerar värdet formaterat som ett oktalt nummer.

Returtyp: Text

Syntax

BIN2OCT(värde)
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Parametrar
Kommentar: Värdet att konvertera, Typ: Text
Kommentar: Utmatningens minimala längd, Typ: Heltal (som 1, 132 eller 2344)

Exempel

BIN2OCT(˝1010˝) returnerar ˝12˝

Exempel

BIN2OCT(˝11111˝) returnerar ˝37˝

8.1.5.9 COMPLEX

Funktionen COMPLEX(real;imag) returnerar ett komplext tal på formen x+yi.

Returtyp: Text

Syntax

COMPLEX(real;imag)

Parametrar
Kommentar: Realdel, Typ: Flyttal (som 1,3, 0,343 eller 253)
Kommentar: Imaginärdel, Typ: Flyttal (som 1,3, 0,343 eller 253)

Exempel

COMPLEX(1,2;3,4) returnerar ˝1,2+3,4i˝

Exempel

COMPLEX(0;-1) returnerar ˝-i˝

8.1.5.10 CONVERT

Funktionen CONVERT() returnerar en konvertering från ett måttsystem till ett annat.

Massenheter som stöds: g (gram), sg (stycken), lbm (pund), u (atommassa), ozm (ounce), stone,
ton, grain, pweight (pennyweight), hweight (hundredweight).

Längdenheter som stöds: m (meter), in (tum), ft (fot), mi (engelsk mil), Nmi (sjömil), ang (Ång-
ström), parsec, lightyear (ljusår).

Tryckenheter som stöds: Pa (Pascal), atm (atmosfärer), mmHg (millimeter kvicksilver), psi (pund
per kvadrattum), Torr.

Kraftenheter som stöds: N (Newton), dyn, pund.

Energienheter som stöds: J (Joule), e (erg), c (termodynamisk kalori), cal (kalori), eV
(elektronvolt), HPh (hästkraftstimme), Wh (watt-timme), flb (fot-pund), BTU (Brittisk termisk
enhet).

Effektenheter som stöds: W (Watt), HP (hästkraft), PS (metrisk hästkraft).

Magnetiska enheter som stöds: T (Tesla), ga (Gauss).

Temperaturenheter som stöds: C (Celsius), F (Fahrenheit), K (Kelvin).

Volymenheter som stöds: l (liter), tsp (tesked), tbs (matsked), oz (ounce vätska), cup (kopp), pt
(pint), qt (quart), gal (gallon), barrel (tunna), m3 (kubikmeter), mi3 (engelska mil i kubik), Nmi3
(sjömil i kubik), in3 (kubiktum), ft3 (kubikfot), yd3 (kubikyard), GRT eller regton (bruttoregister-
ton).

Ytenheter som stöds: m2 (kvadratmeter), mi2 (engelska mil i kvadrat), Nmi2 (sjömil i kvadrat),
in2 (kvadrattum), ft2 (kvadratfot), yd2 (yard i kvadrat), acre (tunnland), ha (hektar).
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Hastighetsenheter som stöds: m/s (meter per sekund), m/h (meter per timme), mph (engelska
mil per timme), kn (knop).

För enheter i metersystemet kan vilket som helst av följande prefix användas: E (exa, 1E+18), P
(peta, 1E+15), T (tera, 1E+12), G (giga, 1E+09), M (mega, 1E+06), k (kilo, 1E+03), h (hekto, 1E+02),
e (deka, 1E+01), d (deci, 1E-01), c (centi, 1E-02), m (milli, 1E-03), u (mikro, 1E-06), n (nano, 1E-09),
p (pico, 1E-12), f (femto, 1E-15), a (atto, 1E-18).

Returtyp: Flyttal (som 1,3, 0,343 eller 253)

Syntax

CONVERT(Tal; Från enhet; Till enhet)

Parametrar
Kommentar: Nummer, Typ: Flyttal (som 1,3, 0,343 eller 253)
Kommentar: Från enhet, Typ: Text
Kommentar: Till enhet, Typ: Text

Exempel

CONVERT(32;˝C˝;˝F˝) är lika med 89,6

Exempel

CONVERT(3;˝lbm˝;˝kg˝) är lika med 1,3608

Exempel

CONVERT(7,9;˝cal˝;˝J˝) är lika med 33,0757

8.1.5.11 DEC2BIN

Funktionen DEC2BIN() returnerar värdet formaterat som ett binärt nummer.

Returtyp: Text

Syntax

DEC2BIN(värde)

Parametrar
Kommentar: Värdet att konvertera, Typ: Heltal (som 1, 132 eller 2344)
Kommentar: Utmatningens minimala längd, Typ: Heltal (som 1, 132 eller 2344)

Exempel

DEC2BIN(12) returnerar ˝1100˝

Exempel

DEC2BIN(55) returnerar ˝110111˝

8.1.5.12 DEC2HEX

Funktionen DEC2HEX() returnerar värdet formaterat som ett hexadecimalt nummer.

Returtyp: Text

Syntax

DEC2HEX(värde)
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Parametrar
Kommentar: Värdet att konvertera, Typ: Heltal (som 1, 132 eller 2344)
Kommentar: Utmatningens minimala längd, Typ: Heltal (som 1, 132 eller 2344)

Exempel

DEC2HEX(12) returnerar ˝c˝

Exempel

DEC2HEX(55) returnerar ˝37˝

8.1.5.13 DEC2OCT

Funktionen DEC2OCT() returnerar värdet formaterat som ett oktalt nummer.

Returtyp: Text

Syntax

DEC2OCT(värde)

Parametrar
Kommentar: Värdet att konvertera, Typ: Heltal (som 1, 132 eller 2344)
Kommentar: Utmatningens minimala längd, Typ: Heltal (som 1, 132 eller 2344)

Exempel

DEC2OCT(12) returnerar ˝14˝

Exempel

DEC2OCT(55) returnerar ˝67˝

8.1.5.14 DELTA

Funktionen DELTA() returnerar 1 om x är lika med y, annars returneras 0. y har standardvärdet
0.
Returtyp: Flyttal (som 1,3, 0,343 eller 253)

Syntax

DELTA(x; y)

Parametrar
Kommentar: Flyttalsvärde, Typ: Flyttal (som 1,3, 0,343 eller 253)
Kommentar: Flyttalsvärde, Typ: Flyttal (som 1,3, 0,343 eller 253)

Exempel

DELTA(1,2; 3,4) returnerar 0

Exempel

DELTA(3; 3) returnerar 1

Exempel

DELTA(1; TRUE) returnerar 1
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8.1.5.15 ERF

Funktionen ERF() returnerar felfunktionen. Med ett enda argument returnerar ERF() felfunktio-
nen mellan 0 och argumentet.

Returtyp: Flyttal (som 1,3, 0,343 eller 253)

Syntax

ERF(Undre gräns; Övre gräns)

Parametrar
Kommentar: Undre gräns, Typ: Flyttal (som 1,3, 0,343 eller 253)
Kommentar: Övre gräns, Typ: Flyttal (som 1,3, 0,343 eller 253)

Exempel

ERF(0,4) är lika med 0,42839236

Liknande funktioner
ERFC

8.1.5.16 ERFC

Funktionen ERFC() returnerar den komplementära felfunktionen.

Returtyp: Flyttal (som 1,3, 0,343 eller 253)

Syntax

ERFC(Undre gräns; Övre gräns)

Parametrar
Kommentar: Undre gräns, Typ: Flyttal (som 1,3, 0,343 eller 253)
Kommentar: Övre gräns, Typ: Flyttal (som 1,3, 0,343 eller 253)

Exempel

ERFC(0,4) är lika med 0,57160764

Liknande funktioner
ERF

8.1.5.17 GESTEP

Funktionen GESTEP() returnerar 1 om x är större än eller lika med y, annars returneras 0. y har
standardvärdet 0.
Returtyp: Flyttal (som 1,3, 0,343 eller 253)

Syntax

GESTEP(x; y)

Parametrar
Kommentar: Flyttalsvärde, Typ: Flyttal (som 1,3, 0,343 eller 253)
Kommentar: Flyttalsvärde, Typ: Flyttal (som 1,3, 0,343 eller 253)

Exempel

GESTEP(1,2; 3,4) returnerar 0
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Exempel

GESTEP(3; 3) returnerar 1

Exempel

GESTEP(0,4; TRUE) returnerar 0

Exempel

GESTEP(4; 3) returnerar 1

8.1.5.18 HEX2BIN

Funktionen HEX2BIN() returnerar värdet formaterat som ett binärt nummer.

Returtyp: Text

Syntax

HEX2BIN(värde)

Parametrar
Kommentar: Värdet att konvertera, Typ: Text

Exempel

HEX2BIN(˝a˝) returnerar ˝1010˝

Exempel

HEX2BIN(˝37˝) returnerar ˝110111˝

8.1.5.19 HEX2DEC

Funktionen HEX2DEC() returnerar värdet formaterat som ett decimalt nummer.

Returtyp: Heltal (som 1, 132 eller 2344)

Syntax

HEX2DEC(värde)

Parametrar
Kommentar: Värdet att konvertera, Typ: Text

Exempel

HEX2DEC(˝a˝) returnerar 10

Exempel

HEX2DEC(˝37˝) returnerar 55
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8.1.5.20 HEX2OCT

Funktionen HEX2OCT() returnerar värdet formaterat som ett oktalt nummer.

Returtyp: Text

Syntax

HEX2OCT(värde)

Parametrar
Kommentar: Värdet att konvertera, Typ: Text

Exempel

HEX2OCT(˝a˝) returnerar ˝12˝

Exempel

HEX2OCT(˝37˝) returnerar ˝67˝

8.1.5.21 IMABS

Funktionen IMABS() beräknar normen av ett komplext tal på formen x+yi.

Returtyp: Flyttal (som 1,3, 0,343 eller 253)

Syntax

IMABS(komplext tal)

Parametrar
Kommentar: Komplext tal, Typ: Text

Exempel

IMABS(˝1,2+5i˝) returnerar 5,1419

Exempel

IMABS(˝-i˝) returnerar 1

Exempel

IMABS(˝12˝) returnerar 12

8.1.5.22 IMAGINARY

Funktionen IMAGINARY(sträng) returnerar imaginärdelen av ett komplext tal.

Returtyp: Dubbel

Syntax

IMAGINARY(sträng)

Parametrar
Kommentar: Komplext tal, Typ: Text

Exempel

IMAGINARY(˝1,2+3,4i˝) returnerar 3,4

Exempel

IMAGINARY(˝1,2˝) returnerar 0

102



Handbok Calligra Sheets

8.1.5.23 IMARGUMENT

Funktionen IMARGUMENT() beräknar argumentet av ett komplext tal på formenx+yi.
Returtyp: Text

Syntax
IMARGUMENT(komplext tal)

Parametrar
Kommentar: Komplext tal, Typ: Text

Exempel
IMARGUMENT(˝1,2+5i˝) returnerar 0,6072

Exempel
IMARGUMENT(˝-i˝) returnerar -1,57079633

Exempel
IMARGUMENT(˝12˝) returnerar ˝#Div/0˝

8.1.5.24 IMCONJUGATE

Funktionen IMCONJUGATE() beräknar konjugatet av ett komplext tal på formen x+yi.
Returtyp: Text

Syntax
IMCONJUGATE(komplext tal)

Parametrar
Kommentar: Komplext tal, Typ: Text

Exempel
IMCONJUGATE(˝1,2+5i˝) returnerar ˝1,2-5i˝

Exempel
IMCONJUGATE(˝-i˝) returnerar ˝i˝

Exempel
IMCONJUGATE(˝12˝) returnerar ˝12˝

8.1.5.25 IMCOS

Funktionen IMCOS() beräknar cosinus för ett komplext tal.
Returtyp: Text

Syntax
IMCOS(sträng)

Parametrar
Kommentar: Komplext tal, Typ: Text

Exempel
IMCOS(˝1+i˝) returnerar ˝0,83373-0,988898i˝

Exempel
IMCOS(˝12i˝) returnerar 81 377,4
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8.1.5.26 IMCOSH

IMCOSH(sträng) returnerar hyperbolisk cosinus av ett komplext tal.

Returtyp: Text

Syntax

IMCOSH(sträng)

Parametrar
Kommentar: Komplext tal, Typ: Text

Exempel

IMCOSH(˝1+i˝) returnerar ˝0,83373+0,988898i˝

Exempel

IMCOSH(˝12i˝) returnerar 0,84358

8.1.5.27 IMCOT

Funktionen IMCOT() beräknar cotangens för ett komplext tal.

Returtyp: Text

Syntax

IMCOT(sträng)

Parametrar
Kommentar: Komplext tal, Typ: Text

Exempel

IMCOT(˝1+i˝) returnerar ˝0.21762-0.86801i˝

8.1.5.28 IMCSC

Funktionen IMCSC() beräknar cosekant för ett komplext tal.

Returtyp: Text

Syntax

IMCSC(sträng)

Parametrar
Kommentar: Komplext tal, Typ: Text

Exempel

IMCSC(˝1+i˝) returnerar ˝0.62151-0.30393i˝
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8.1.5.29 IMCSCH

IMCSCH(sträng) returnerar hyperbolisk cosekant av ett komplext tal.

Returtyp: Text

Syntax

IMCSCH(sträng)

Parametrar
Kommentar: Komplext tal, Typ: Text

Exempel

IMCSCH(˝1+i˝) returnerar ˝0.30393-i0.62151˝

8.1.5.30 IMDIV

Funktionen IMDIV() dividerar komplexa tal på formen x+yi.

Returtyp: Text

Syntax

IMDIV(värde;värde;...)

Parametrar
Kommentar: Komplext tal, Typ: Ett område med strängar
Kommentar: Komplext tal, Typ: Ett område med strängar
Kommentar: Komplext tal, Typ: Ett område med strängar
Kommentar: Komplext tal, Typ: Ett område med strängar
Kommentar: Komplext tal, Typ: Ett område med strängar

Exempel

IMDIV(1,2;˝3,4+5i˝) returnerar ˝0,111597-0,164114i˝

Exempel

IMDIV(˝12+i˝;˝12-i˝) returnerar ˝0,986207+0,16551i˝

8.1.5.31 IMEXP

Funktionen IMEXP(sträng) beräknar e (basen för naturliga logaritmer) upphöjt till ett komplext
tal.
Returtyp: Text

Syntax

IMEXP(sträng)

Parametrar
Kommentar: Komplext tal, Typ: Text

Exempel

IMEXP(˝2-i˝) returnerar ˝3.99232-6.21768i˝

Exempel

IMEXP(˝12i˝) returnerar ˝0.843854-0.536573i˝
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8.1.5.32 IMLN

Funktionen IMLN(sträng) beräknar den naturliga logaritmen av ett komplext tal.

Returtyp: Text

Syntax

IMLN(sträng)

Parametrar
Kommentar: Komplext tal, Typ: Text

Exempel

IMLN(˝3-i˝) returnerar ˝1,15129-0,321751i˝

Exempel

IMLN(˝12˝) returnerar 2,48491

8.1.5.33 IMLOG10

IMLOG10(sträng) returnerar bas-10 logaritmen av ett komplext tal.

Returtyp: Text

Syntax

IMLOG10(sträng)

Parametrar
Kommentar: Komplext tal, Typ: Text

Exempel

IMLOG10(˝3+4i˝) returnerar ˝0,69897+0,402719i˝

8.1.5.34 IMLOG2

IMLOG2(sträng) returnerar bas-2 logaritmen av ett komplext tal.

Returtyp: Text

Syntax

IMLOG2(sträng)

Parametrar
Kommentar: Komplext tal, Typ: Text

Exempel

IMLOG2(˝3+4i˝) returnerar ˝2,321928+1,337804i˝
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8.1.5.35 IMPOWER

Funktionen IMPOWER(sträng;exp) upphöjer ett komplext tal till en exponent.

Returtyp: Text

Syntax
IMPOWER(sträng)

Parametrar
Kommentar: Komplext tal, Typ: Text
Kommentar: Upphöjt till, Typ: Heltal (som 1, 132 eller 2344)

Exempel
IMPOWER(˝4-i˝;2) returnerar ˝15-8i˝

Exempel
IMPOWER(˝1,2˝;2) returnerar 1,44

8.1.5.36 IMPRODUCT

Funktionen IMPRODUCT() multiplicerar komplexa tal på formen x+yi.

Returtyp: Text

Syntax
IMPRODUCT(värde;värde;...)

Parametrar
Kommentar: Komplext tal, Typ: Ett område med strängar
Kommentar: Komplext tal, Typ: Ett område med strängar
Kommentar: Komplext tal, Typ: Ett område med strängar
Kommentar: Komplext tal, Typ: Ett område med strängar
Kommentar: Komplext tal, Typ: Ett område med strängar

Exempel
IMPRODUCT(1,2;˝3,4+5i˝) returnerar ˝4,08+6i˝

Exempel
IMPRODUCT(1,2;˝1i˝) returnerar ˝1,2i˝

8.1.5.37 IMREAL

Funktionen IMREAL(sträng) returnerar realdelen av ett komplext tal.

Returtyp: Dubbel

Syntax
IMREAL(sträng)

Parametrar
Kommentar: Komplext tal, Typ: Text

Exempel
IMREAL(˝1,2+3,4i˝) returnerar 1,2

Exempel
IMREAL(˝1,2i˝) returnerar 0
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8.1.5.38 IMSEC

Funktionen IMSEC() beräknar sekant för ett komplext tal.

Returtyp: Text

Syntax

IMSEC(sträng)

Parametrar
Kommentar: Komplext tal, Typ: Text

Exempel

IMSEC(˝1+i˝) returnerar ˝0.49833+i0.5910˝

8.1.5.39 IMSECH

IMSECH(sträng) returnerar hyperbolisk sekant av ett komplext tal.

Returtyp: Text

Syntax

IMSECH(sträng)

Parametrar
Kommentar: Komplext tal, Typ: Text

Exempel

IMSECH(˝1+i˝) returnerar ˝0,83373-0,988898i˝

8.1.5.40 IMSIN

Funktionen IMSIN(sträng) beräknar sinus för ett komplext tal.

Returtyp: Text

Syntax

IMSIN(sträng)

Parametrar
Kommentar: Komplext tal, Typ: Text

Exempel

IMSIN(˝1+i˝) returnerar ˝1,29846+0,634964i˝

Exempel

IMSIN(˝1,2˝) returnerar -0,536573
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8.1.5.41 IMSINH

IMSINH(sträng) returnerar hyperbolisk sinus av ett komplext tal.

Returtyp: Text

Syntax
IMSINH(sträng)

Parametrar
Kommentar: Komplext tal, Typ: Text

Exempel
IMSINH(˝1+i˝) returnerar ˝0,63496+1,29846i˝

Exempel
IMSINH(˝1,2˝) returnerar 1,50946

8.1.5.42 IMSQRT

Funktionen IMSQRT(sträng) beräknar kvadratroten ur ett komplext tal.

Returtyp: Text

Syntax
IMSQRT(sträng)

Parametrar
Kommentar: Komplext tal, Typ: Text

Exempel
IMSQRT(˝1+i˝) returnerar ˝1,09868+0,45509i˝

Exempel
IMSQRT(˝1,2i˝) returnerar ˝0,774597+0,774597i˝

8.1.5.43 IMSUB

Funktionen IMSUB() subtraherar komplexa tal på formen x+yi.

Returtyp: Text

Syntax
IMSUB(värde;värde;...)

Parametrar
Kommentar: Komplext tal, Typ: Ett område med strängar
Kommentar: Komplext tal, Typ: Ett område med strängar
Kommentar: Komplext tal, Typ: Ett område med strängar
Kommentar: Komplext tal, Typ: Ett område med strängar
Kommentar: Komplext tal, Typ: Ett område med strängar

Exempel
IMSUB(1,2;˝3,4+5i˝) returnerar ˝-2,2-5i˝

Exempel
IMSUB(1,2;˝1i˝) returnerar ˝1,2-i˝

109



Handbok Calligra Sheets

8.1.5.44 IMSUM

Funktionen IMSUM() summerar komplexa tal på formen x+yi.

Returtyp: Text

Syntax
IMSUM(värde;värde;...)

Parametrar
Kommentar: Komplext tal, Typ: Ett område med strängar
Kommentar: Komplext tal, Typ: Ett område med strängar
Kommentar: Komplext tal, Typ: Ett område med strängar
Kommentar: Komplext tal, Typ: Ett område med strängar
Kommentar: Komplext tal, Typ: Ett område med strängar

Exempel
IMSUM(1,2;˝3,4+5i˝) returnerar ˝4,6+5i˝

Exempel
IMSUM(1,2;˝1i˝) returnerar ˝1,2+i˝

8.1.5.45 IMTAN

IMTANH(sträng) returnerar tangens av ett komplext tal.

Returtyp: Text

Syntax
IMTAN(sträng)

Parametrar
Kommentar: Komplext tal, Typ: Text

Exempel
IMTAN(˝1+i˝) returnerar ˝0,27175+1,08392i˝

Exempel
IMTAN(˝1,2˝) returnerar 2,57215

8.1.5.46 IMTANH

Funktionen IMTANH(sträng) returnerar hyperbolisk tangens av ett komplext tal.

Returtyp: Text

Syntax
IMTANH(sträng)

Parametrar
Kommentar: Komplext tal, Typ: Text

Exempel
IMTANH(˝1+i˝) returnerar ˝1,08392+0,27175i˝

Exempel
IMTANH(˝1,2˝) returnerar 0,83365
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8.1.5.47 OCT2BIN

Funktionen OCT2BIN() returnerar värdet formaterat som ett binärt nummer.

Returtyp: Text

Syntax

OCT2BIN(värde)

Parametrar
Kommentar: Värdet att konvertera, Typ: Text
Kommentar: Utmatningens minimala längd, Typ: Heltal (som 1, 132 eller 2344)

Exempel

OCT2BIN(˝12˝) returnerar ˝1010˝

Exempel

OCT2BIN(˝55˝) returnerar ˝101101˝

8.1.5.48 OCT2DEC

Funktionen OCT2DEC() returnerar värdet formaterat som ett decimalt nummer.

Returtyp: Heltal (som 1, 132 eller 2344)

Syntax

OCT2DEC(värde)

Parametrar
Kommentar: Värdet att konvertera, Typ: Text

Exempel

OCT2DEC(˝12˝) returnerar 10

Exempel

OCT2DEC(˝55˝) returnerar 45

8.1.5.49 OCT2HEX

Funktionen OCT2HEX() returnerar värdet formaterat som ett hexadecimalt nummer.

Returtyp: Text

Syntax

OCT2HEX(värde)

Parametrar
Kommentar: Värdet att konvertera, Typ: Text
Kommentar: Utmatningens minimala längd, Typ: Heltal (som 1, 132 eller 2344)

Exempel

OCT2HEX(˝12˝) returnerar ˝A˝

Exempel

OCT2HEX(˝55˝) returnerar ˝2D˝
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8.1.6 Finansiella

8.1.6.1 ACCRINT

Funktionen ACCRINT returnerar till betalning förfallen ränta för ett värdepapper som ger peri-
odisk ränta. Frekvenser som tillåts är 1 - årsvis, 2 - halvårsvis eller 4 - kvartalsvis. Bas är dagbe-
räkningsmetoden du vill använda: 0: amerikansk 30/360 (standardvärde), 1: verkliga dagar, 2:
verkliga dagar/360 3: verkliga dagar/365 eller 4: europeisk 30/365.

Returtyp: Flyttal (som 1,3, 0,343 eller 253)

Syntax

ACCRINT(utgåva; första räntan, avräkning; räntesats; nominellt värde; frekvens; bas)

Parametrar
Kommentar: Utgåvedatum, Typ: Datum
Kommentar: Första räntan, Typ: Datum
Kommentar: Avräkning, Typ: Datum
Kommentar: Årlig räntesats för värdepapper, Typ: Flyttal (som 1,3, 0,343 eller 253)
Kommentar: Nominellt värde, Typ: Flyttal (som 1,3, 0,343 eller 253)
Kommentar: Antal betalningar per år, Typ: Flyttal (som 1,3, 0,343 eller 253)
Kommentar: Dagberäkningsmetod, Typ: Heltal (som 1, 132 eller 2344)

Exempel

ACCRINT(˝2001-02-28˝; ˝2001-08-31˝; ˝2001-05-01˝; 0,1;1000; 2; 0) returnerar 16 944

Liknande funktioner
ACCRINTM

8.1.6.2 ACCRINTM

Funktionen ACCRINTM returnerar till betalning förfallen ränta för ett värdepapper som ger
ränta vid förfallodatum. Bas är dagberäkningsmetoden du vill använda: 0: amerikansk 30/360
(standardvärde), 1: verkliga dagar, 2: verkliga dagar/360 3: verkliga dagar/365 eller 4: europeisk
30/365.

Returtyp: Flyttal (som 1,3, 0,343 eller 253)

Syntax

ACCRINTM(utgåva; avräkning; räntesats; nominellt värde; bas)

Parametrar
Kommentar: Utgåvedatum, Typ: Datum
Kommentar: Avräkning, Typ: Datum
Kommentar: Årlig räntesats för värdepapper, Typ: Flyttal (som 1,3, 0,343 eller 253)
Kommentar: Nominellt värde, Typ: Flyttal (som 1,3, 0,343 eller 253)
Kommentar: Dagberäkningsmetod, Typ: Heltal (som 1, 132 eller 2344)

Exempel

ACCRINTM(˝2001-02-28˝; ˝2001-08-31˝; 0,1; 100) returnerar 5,0278

Liknande funktioner
ACCRINT
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8.1.6.3 AMORDEGRC

Funktionen AMORDEGRC beräknar amorteringsvärdet för det franska bokföringssystemet med
degressiv värdeminskning.

Returtyp: Flyttal (som 1,3, 0,343 eller 253)

Syntax

AMORDEGRC(kostnad; inköpsdatum; första_period_slutdatum; kvarvarande; period;
räntesats; bas)

Parametrar
Kommentar: Kostnad, Typ: Flyttal (som 1,3, 0,343 eller 253)
Kommentar: Pv, Typ: Flyttal (som 1,3, 0,343 eller 253)
Kommentar: Fv, Typ: Flyttal (som 1,3, 0,343 eller 253)

Exempel

AMORDEGRC( 1000; ˝2006-02-01˝; ˝2006-12-31˝; 10; 0; 0,1; 1 ) returnerar 228

Liknande funktioner
AMORLINC
DB
DDB
YEARFRAC

8.1.6.4 AMORLINC

Funktionen AMORLINC beräknar amorteringsvärdet för det franska bokföringssystemet med
linjär värdeminskning.

Returtyp: Flyttal (som 1,3, 0,343 eller 253)

Syntax

AMORLINC(kostnad; inköpsdatum; första_period_slutdatum; kvarvarande; period; ränte-
sats; bas)

Parametrar
Kommentar: P, Typ: Heltal (som 1, 132 eller 2344)
Kommentar: Pv, Typ: Flyttal (som 1,3, 0,343 eller 253)
Kommentar: Fv, Typ: Flyttal (som 1,3, 0,343 eller 253)

Exempel

AMORLINC( 1000; ˝2004-02-01˝; ˝2004-12-31˝; 10; 0; 0,1; 1 ) returnerar 91,256831

Liknande funktioner
AMORDEGRC
DB
DDB
YEARFRAC
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8.1.6.5 COMPOUND

Funktionen COMPOUND() returnerar värdet av en investering, givet startvärdet, nominell rän-
tesats, kapitalisering och tid. Till exempel: 5 000 kr med 12% ränta som kapitaliseras kvartalsvis
under 5 år blir COMPOUND(5000;0,12;4;5) eller 9 030,56 kr.
Returtyp: Flyttal (som 1,3, 0,343 eller 253)

Syntax
COMPOUND(startvärde;ränta;perioder;perioder_per_år)

Parametrar
Kommentar: Startvärde, Typ: Flyttal (som 1,3, 0,343 eller 253)
Kommentar: Räntesats, Typ: Flyttal (som 1,3, 0,343 eller 253)
Kommentar: Perioder per år, Typ: Flyttal (som 1,3, 0,343 eller 253)
Kommentar: År, Typ: Flyttal (som 1,3, 0,343 eller 253)

Exempel
COMPOUND(5000;0,12;4;5) är lika med 9 030,56

8.1.6.6 CONTINUOUS

Funktionen CONTINUOUS() beräknar värdet av effektiv ränta, givet startvärdet, nominell ränte-
sats och tiden i år. Till exempel: 1000 kr som tjänar 10% under 1 år blir CONTINUOUS(1000;0,1;1)
eller 1105,17 kr.
Returtyp: Flyttal (som 1,3, 0,343 eller 253)

Syntax
CONTINUOUS(startvärde;ränta;år)

Parametrar
Kommentar: Startvärde, Typ: Flyttal (som 1,3, 0,343 eller 253)
Kommentar: Räntesats, Typ: Flyttal (som 1,3, 0,343 eller 253)
Kommentar: År, Typ: Flyttal (som 1,3, 0,343 eller 253)

Exempel
CONTINUOUS(1000;0,1;1) är lika med 1 105,17

8.1.6.7 COUPNUM

Funktionen COUPNUM returnerar antal kuponger som betalas mellan avräkningsdatum och
förfallodatum. Bas är dagberäkningsmetoden du vill använda: 0: amerikansk 30/360 (standard-
värde), 1: verkliga dagar, 2: verkliga dagar/360 3: verkliga dagar/365 eller 4: europeisk 30/365.

Returtyp: Flyttal (som 1,3, 0,343 eller 253)

Syntax
COUPNUM(avräkning; förfaller; frekvens; bas)

Parametrar
Kommentar: Avräkning, Typ: Datum
Kommentar: Förfaller, Typ: Datum
Kommentar: Frekvens, Typ: Flyttal (som 1,3, 0,343 eller 253)
Kommentar: Dagberäkningsmetod, Typ: Heltal (som 1, 132 eller 2344)

Exempel
COUPNUM(˝2001-02-28˝; ˝2001-08-31˝; 2; 0) returnerar 1
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8.1.6.8 CUMIPMT

Beräknar den ackumulerade räntefordran.
Returtyp: Flyttal (som 1,3, 0,343 eller 253)

Syntax

CUMIPMT(räntesats; perioder; värde; start; slut; typ)

Parametrar
Kommentar: räntesats, Typ: Flyttal (som 1,3, 0,343 eller 253)
Kommentar: perioder, Typ: Flyttal (som 1,3, 0,343 eller 253)
Kommentar: värde, Typ: Flyttal (som 1,3, 0,343 eller 253)
Kommentar: start, Typ: Heltal (som 1, 132 eller 2344)
Kommentar: slut, Typ: Heltal (som 1, 132 eller 2344)
Kommentar: typ, Typ: Heltal (som 1, 132 eller 2344)

Exempel

CUMIPMT( 0,06/12; 5*12; 100000; 5; 12; 0 ) är lika med -3562,187023

Liknande funktioner
IPMT
CUMPRINC

8.1.6.9 CUMPRINC

Beräknar den ackumulerade huvudfordran.
Returtyp: Flyttal (som 1,3, 0,343 eller 253)

Syntax

CUMPRINC(räntesats; perioder; värde; start; slut; typ)

Parametrar
Kommentar: räntesats, Typ: Flyttal (som 1,3, 0,343 eller 253)
Kommentar: perioder, Typ: Flyttal (som 1,3, 0,343 eller 253)
Kommentar: värde, Typ: Flyttal (som 1,3, 0,343 eller 253)
Kommentar: start, Typ: Heltal (som 1, 132 eller 2344)
Kommentar: slut, Typ: Heltal (som 1, 132 eller 2344)
Kommentar: typ, Typ: Heltal (som 1, 132 eller 2344)

Exempel

CUMPRINC( 0,06/12; 5*12; 100000; 5; 12; 0 ) är lika med -11904,054201

Liknande funktioner
PPMT
CUMIPMT

8.1.6.10 DB

Funktionen DB() beräknar beräknar värdeminskningen för en tillgång under en given period
med metoden fixerat minskande värde. Månader är valfritt, om de utelämnas antas de vara 12.

Returtyp: Flyttal (som 1,3, 0,343 eller 253)
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Syntax

DB(kostnad; kvarvarande värde; livstid; period [;månader])

Parametrar
Kommentar: Kostnad, Typ: Flyttal (som 1,3, 0,343 eller 253)
Kommentar: Kvarvarande, Typ: Flyttal (som 1,3, 0,343 eller 253)
Kommentar: Livstid, Typ: Flyttal (som 1,3, 0,343 eller 253)
Kommentar: Period, Typ: Flyttal (som 1,3, 0,343 eller 253)
Kommentar: Månad, Typ: Flyttal (som 1,3, 0,343 eller 253)

Exempel

DB(8000;400;6;3) är lika med 1158,40

Exempel

DB(8000;400;6;3;2) är lika med 1783,41

Liknande funktioner
DDB
SLN

8.1.6.11 DDB

Funktionen DDB() beräknar beräknar värdeminskningen för en tillgång under en given period
med metoden aritmetiskt minskande värde. Faktorn är valfri, om den utelämnas antas den vara
2. Alla parametrar måste vara större än noll.

Returtyp: Flyttal (som 1,3, 0,343 eller 253)

Syntax

DDB(kostnad; kvarvarande värde; livstid; period [;faktor])

Parametrar
Kommentar: Kostnad, Typ: Flyttal (som 1,3, 0,343 eller 253)
Kommentar: Kvarvarande, Typ: Flyttal (som 1,3, 0,343 eller 253)
Kommentar: Livstid, Typ: Flyttal (som 1,3, 0,343 eller 253)
Kommentar: Period, Typ: Flyttal (som 1,3, 0,343 eller 253)
Kommentar: Faktor, Typ: Flyttal (som 1,3, 0,343 eller 253)

Exempel

DDB(75000;1;60;12;2) returnerar 1721,81

Liknande funktioner
SLN

8.1.6.12 DISC

Funktionen DISC returnerar diskonto för ett värdepapper. Bas är dagberäkningsmetoden du vill
använda: 0: amerikansk 30/360 (standardvärde), 1: verkliga dagar, 2: verkliga dagar/360 3: verk-
liga dagar/365 eller 4: europeisk 30/365.

Returtyp: Flyttal (som 1,3, 0,343 eller 253)

Syntax

DISC(avräkning; förfaller; nominellt värde; andelsåterköp [; bas ] )
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Parametrar
Kommentar: Avräkning, Typ: Datum
Kommentar: Förfaller, Typ: Datum
Kommentar: Pris per 100 dollar nominellt värde, Typ: Flyttal (som 1,3, 0,343 eller 253)
Kommentar: Andelsåterköp, Typ: Flyttal (som 1,3, 0,343 eller 253)
Kommentar: Dagberäkningsmetod, Typ: Heltal (som 1, 132 eller 2344)

Exempel

DISC(˝2001-02-28˝; ˝2001-08-31˝; 12; 14) returnerar 0,2841

Liknande funktioner
YEARFRAC

8.1.6.13 DOLLARDE

Funktionen DOLLARDE() returnerar priset i dollar uttryckt som ett decimaltal. Dollarbråkdel är
talet som ska konverteras och bråkdel är nämnaren för bråket.
Returtyp: Flyttal (som 1,3, 0,343 eller 253)

Syntax

DOLLARDE(dollarbråkdel; bråkdel)

Parametrar
Kommentar: Dollarbråkdel, Typ: Flyttal (som 1,3, 0,343 eller 253)
Kommentar: Bråk, Typ: Heltal (som 1, 132 eller 2344)

Exempel

DOLLARDE(1,02; 16) - betyder 1 och 2/16 - returnerar 1,125

Liknande funktioner
DOLLARFR
TRUNC

8.1.6.14 DOLLARFR

Funktionen DOLLARFR() returnerar priset i dollar uttryckt som ett bråk. Dollardecimaltal är
talet som ska konverteras, och bråk är nämnaren för bråket.

Returtyp: Flyttal (som 1,3, 0,343 eller 253)

Syntax

DOLLARFR(dollarbråkdel; bråkdel)

Parametrar
Kommentar: Dollardecimaltal, Typ: Flyttal (som 1,3, 0,343 eller 253)
Kommentar: Bråk, Typ: Heltal (som 1, 132 eller 2344)

Exempel

DOLLARFR(1,125; 16) returnerar 1,02. (1 + 2/16)

Liknande funktioner
DOLLARDE
TRUNC
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8.1.6.15 DURATION

Returnerar antalet perioder som behövs för att en investering ska behålla ett önskat värde.

Returtyp: Flyttal (som 1,3, 0,343 eller 253)

Syntax

DURATION(Räntesats; AV; FV)

Parametrar
Kommentar: Hastighet, Typ: Flyttal (som 1,3, 0,343 eller 253)
Kommentar: Aktuellt värde (AV), Typ: Flyttal (som 1,3, 0,343 eller 253)
Kommentar: Framtida värde (FV), Typ: Flyttal (som 1,3, 0,343 eller 253)

Exempel

DURATION(0,1; 1000; 2000) returnerar 7,27

Liknande funktioner
FV
PV

8.1.6.16 DURATION_ADD

Returnerar räntebindningstiden för ett värdepapper med fast räntesats i år.

Returtyp: Flyttal (som 1,3, 0,343 eller 253)

Syntax

DURATION_ADD(Avräkning; Förfaller; Kupong; Avkastning; Frekvens; Bas)

Parametrar
Kommentar: Avräkning, Typ: Datum
Kommentar: Förfaller, Typ: Datum
Kommentar: Kupong, Typ: Flyttal (som 1,3, 0,343 eller 253)
Kommentar: Avkastning, Typ: Flyttal (som 1,3, 0,343 eller 253)
Kommentar: Frekvens, Typ: Flyttal (som 1,3, 0,343 eller 253)
Kommentar: Bas, Typ: Heltal (som 1, 132 eller 2344)

Exempel

DURATION_ADD( ˝1998-01-01˝; ˝2006-01-01˝; 0,08; 0,09; 2; 1 ) returnerar 5,9937749555

Liknande funktioner
MDURATION

8.1.6.17 EFFECT

Funktionen EFFECT() beräknar den effektiva avkastningen för en nominell räntesats (årlig pro-
centuell räntesats, förkortat APR på engelska). Till exempel: 8% ränta med månatlig kapitalise-
ring ger en effektiv avkastning som är EFFECT( 0,08; 12) eller 8,3%.

Returtyp: Flyttal (som 1,3, 0,343 eller 253)

Syntax

EFFECT(nominell;perioder)
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Parametrar
Kommentar: Nominell ränta, Typ: Flyttal (som 1,3, 0,343 eller 253)
Kommentar: Perioder, Typ: Flyttal (som 1,3, 0,343 eller 253)

Exempel

EFFECT(0,08;12) är lika med 0,083

Liknande funktioner
EFFECTIVE
NOMINAL

8.1.6.18 EFFECTIVE

Funktionen EFFECTIVE() beräknar den effektiva avkastningen för en nominell räntesats (årlig
procentuell räntesats, förkortat APR på engelska). Den är samma som funktionen EFFECT.

Returtyp: Flyttal (som 1,3, 0,343 eller 253)

Syntax

EFFECT(nominell;perioder)

Parametrar
Kommentar: Nominell ränta, Typ: Flyttal (som 1,3, 0,343 eller 253)
Kommentar: Perioder, Typ: Flyttal (som 1,3, 0,343 eller 253)

Liknande funktioner
EFFECT

8.1.6.19 EURO

Funktionen EURO() konverterar en Euro till en given nationell valuta i den europeiska monetära
unionen. Valuta är en av följande: ATS (Österrike), BEF (Belgien), DEM (Tyskland), ESP (Spani-
en), EUR (Euro), FIM (Finland), FRF (Frankrike), GRD (Grekland), IEP (Irland), ITL (Italien), LUF
(Luxemburg), NLG (Holland), eller PTE (Portugal).

Returtyp: Flyttal (som 1,3, 0,343 eller 253)

Syntax

EURO(valuta)

Parametrar
Kommentar: Valuta, Typ: Text

Exempel

EURO(˝DEM˝) är lika med 1,95583

Liknande funktioner
EUROCONVERT
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8.1.6.20 EUROCONVERT

Funktionen EUROCONVERT() konverterar ett tal från en nationell valuta till en annan valute i
den europeiska monetära unionen genom att använda Euro som intermediär valuta. Valuta är
en av följande: ATS (Österrike), BEF (Belgien), DEM (Tyskland), ESP (Spanien), EUR (Euro), FIM
(Finland), FRF (Frankrike), GRD (Grekland), IEP (Irland), ITL (Italien), LUF (Luxemburg), NLG
(Holland), eller PTE (Portugal).

Returtyp: Flyttal (som 1,3, 0,343 eller 253)

Syntax

EUROCONVERT(tal; källvaluta; målvaluta)

Parametrar
Kommentar: Nummer, Typ: Flyttal (som 1,3, 0,343 eller 253)
Kommentar: Källvaluta, Typ: Text
Kommentar: Målvaluta, Typ: Text

Exempel

EUROCONVERT(1; ˝EUR˝; ˝DEM˝) är lika med 1,95583

Liknande funktioner
EURO

8.1.6.21 FV

Funktionen FV() beräknar framtida värde av en investering, givet ränta och förfluten tid. Om du
har 1000 kr på ett bankkonto som ger 8% ränta, kommer du efter två år att ha FV(1000;0,08;2)
eller 1166,40 kr.

Returtyp: Flyttal (som 1,3, 0,343 eller 253)

Syntax

FV(aktuellt värde;ränta;perioder)

Parametrar
Kommentar: Aktuellt värde, Typ: Flyttal (som 1,3, 0,343 eller 253)
Kommentar: Hastighet, Typ: Flyttal (som 1,3, 0,343 eller 253)
Kommentar: Perioder, Typ: Flyttal (som 1,3, 0,343 eller 253)

Exempel

FV(1000;0,08;2) är lika med 1166,40

Liknande funktioner
PV
NPER
PMT
RATE
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8.1.6.22 FV_ANNUITY

Funktionen FV_ANNUITY() beräknar framtida värdet av årliga/periodiska insättningar givet
storleken på insättningen, räntesats och antal perioder.Till exempel: om du får 5 000 kr per
år under 20 år och investerar pengarna med 8% ränta, kommer summan efter 20 år vara
FV_ANNUITY(5000;0,08;20) eller 228 810 kr. Denna funktion antar att utbetalningar görs i slutet
på varje period.

Returtyp: Flyttal (som 1,3, 0,343 eller 253)

Syntax
FV_ANNUITY(summa;ränta;perioder)

Parametrar
Kommentar: Betalning per period, Typ: Flyttal (som 1,3, 0,343 eller 253)
Kommentar: Räntesats, Typ: Flyttal (som 1,3, 0,343 eller 253)
Kommentar: Perioder, Typ: Flyttal (som 1,3, 0,343 eller 253)

Exempel
FV_ANNUITY(1000;0,05;5) är lika med 5525,63

8.1.6.23 INTRATE

Funktionen INTRATE returnerar räntesatsen för en fullständig investering i ett värdepapper. Bas
är dagberäkningsmetoden du vill använda: 0: amerikansk 30/360 (standardvärde), 1: verkliga
dagar, 2: verkliga dagar/360 3: verkliga dagar/365 eller 4: europeisk 30/365.

Returtyp: Flyttal (som 1,3, 0,343 eller 253)

Syntax
INTRATE(avräkning; förfaller; investering; andelsåterköp; bas)

Parametrar
Kommentar: Avräkning, Typ: Datum
Kommentar: Förfaller, Typ: Datum
Kommentar: Investering, Typ: Flyttal (som 1,3, 0,343 eller 253)
Kommentar: Andelsåterköp, Typ: Flyttal (som 1,3, 0,343 eller 253)
Kommentar: Dagberäkningsmetod, Typ: Heltal (som 1, 132 eller 2344)

Exempel
INTRATE(˝2001-02-28˝; ˝2001-08-31˝; 1000000; 2000000;1) returnerar 1,98

8.1.6.24 IPMT

IPMT beräknar beloppet för en betalning under en period som gäller ränta.

Räntesats är den periodiska räntesatsen.

Period är amorteringsperioden. 1 för den första och APER för den sista perioden.

APER är det totala antalet perioder som det periodiska beloppet betalas.

AV är aktuellt värde i följden av betalningar.

FV (valfritt) är det önskade (framtida) värdet. Förval: 0.
Typ (valfri) anger utfallsdatum. 1 för betalning i början av en period och 0 (förval) för betalning i
slutet av en period.

Exemplet visar räntan att betala under det sista året för ett treårigt lån. Räntesatsen är 10 procent.

Returtyp: Flyttal (som 1,3, 0,343 eller 253)
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Syntax

IPMT(Räntesats; Period; APER; AV; FV; Typ)

Parametrar
Kommentar: Hastighet, Typ: Flyttal (som 1,3, 0,343 eller 253)
Kommentar: Period, Typ: Flyttal (som 1,3, 0,343 eller 253)
Kommentar: Antal perioder, Typ: Flyttal (som 1,3, 0,343 eller 253)
Kommentar: Aktuella värden, Typ: Flyttal (som 1,3, 0,343 eller 253)
Kommentar: Framtida värde (valfritt), Typ: Flyttal (som 1,3, 0,343 eller 253)
Kommentar: Typ (valfri), Typ: Heltal (som 1, 132 eller 2344)

Exempel

IPMT(0,1;3;3;8000) är lika med -292,45

Liknande funktioner
PPMT
PV
PMT

8.1.6.25 IRR

Funktionen IRR beräknar den interna räntabiliteten för en serie valutaflöden.
Returtyp: Flyttal (som 1,3, 0,343 eller 253)

Syntax

IRR(Värden [; Gissning = 0,1])

Parametrar
Kommentar: Värden, Typ: Flyttal (som 1,3, 0,343 eller 253)
Kommentar: Gissning, Typ: Flyttal (som 1,3, 0,343 eller 253)

Liknande funktioner
XIRR

8.1.6.26 ISPMT

Beräknar räntan som betalas för en given period och investering.

Räntesats är den periodiska räntesatsen.

Period är amorteringsperioden. 1 för den första och APER för den sista perioden.

APER är totalt antal perioder som det periodiska beloppet betalas.

AV är aktuellt värde i följden av betalningar.

Returtyp: Flyttal (som 1,3, 0,343 eller 253)

Syntax

ISPMT(Räntesats; Period; APER; AV)

Parametrar
Kommentar: Hastighet, Typ: Flyttal (som 1,3, 0,343 eller 253)
Kommentar: Period, Typ: Heltal (som 1, 132 eller 2344)
Kommentar: Antal perioder, Typ: Heltal (som 1, 132 eller 2344)
Kommentar: Aktuella värden (AV), Typ: Flyttal (som 1,3, 0,343 eller 253)
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Exempel

ISPMT(0,1; 1; 3; 8000000) är lika med -533333

Liknande funktioner
PV
FV
NPER
PMT
RATE

8.1.6.27 LEVEL_COUPON

Funktionen LEVEL_COUPON() beräknar värdet av en kupongförsedd obligation. Till exempel:
om räntesatsen är 10%, så blir en 1 000 kr obligation med halvårskuponger med en kupongsats
på 13% som förfaller på 4 år värd LEVEL_COUPON(1000;13;2;4;0,1) eller 1 096,95 kr.

Returtyp: Flyttal (som 1,3, 0,343 eller 253)

Syntax

LEVEL_COUPON(nominellt värde;kupongsats;kuponger per år;år;marknadskurs)

Parametrar
Kommentar: Valör, Typ: Flyttal (som 1,3, 0,343 eller 253)
Kommentar: Kupongsats, Typ: Flyttal (som 1,3, 0,343 eller 253)
Kommentar: Kuponger per år, Typ: Flyttal (som 1,3, 0,343 eller 253)
Kommentar: År, Typ: Flyttal (som 1,3, 0,343 eller 253)
Kommentar: Marknadsränta, Typ: Flyttal (som 1,3, 0,343 eller 253)

Exempel

LEVEL_COUPON(1000;0,13;2;4;0,1) är lika med 1 096,95

8.1.6.28 MDURATION

Funktionen MDURATION() beräknar modifierad räntebindningstid för ett värdepapper med fast
räntesats i år.
Returtyp: Flyttal (som 1,3, 0,343 eller 253)

Syntax

MDURATION(Avräkning; Förfaller; Kupong; Avkastning; Frekvens; [ Bas=0 ])

Parametrar
Kommentar: Avräkning, Typ: Flyttal (som 1,3, 0,343 eller 253)
Kommentar: Förfaller, Typ: Flyttal (som 1,3, 0,343 eller 253)
Kommentar: Kupong, Typ: Flyttal (som 1,3, 0,343 eller 253)
Kommentar: Avkastning, Typ: Flyttal (som 1,3, 0,343 eller 253)
Kommentar: Frekvens, Typ: Flyttal (som 1,3, 0,343 eller 253)
Kommentar: Bas, Typ: Heltal (som 1, 132 eller 2344)

Exempel

MDURATION(˝2004-02-01˝; ˝2004-05-31˝; 0,08; 0,09; 2; 0) returnerar 0,316321106

Liknande funktioner
DURATION
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8.1.6.29 MIRR

Funktionen MIRR() beräknar den modifierade internräntan för en serie periodiska investeringar.

Returtyp: Flyttal (som 1,3, 0,343 eller 253)

Syntax

MIRR(värden; investering; återinvestering)

Parametrar
Kommentar: Värden, Typ: Flyttal (som 1,3, 0,343 eller 253)
Kommentar: Investering, Typ: Flyttal (som 1,3, 0,343 eller 253)
Kommentar: Återinvestering, Typ: Flyttal (som 1,3, 0,343 eller 253)

Exempel

MIRR({100;200;-50;300;-200}, 5%, 6%) är lika med 34,2823387842%

Liknande funktioner
IRR

8.1.6.30 NOMINAL

Funktionen NOMINAL() beräknar den nominella (angivna) räntesatsen för en effektiv (årsbase-
rad) räntesats som kapitaliseras med givna intervall. Till exempel: för att tjäna 8% på ett konto
med månatlig kapitalisering, behöver duett resultat som är NOMINAL( 0,08; 12) eller 7,72%.

Returtyp: Flyttal (som 1,3, 0,343 eller 253)

Syntax

NOMINAL(effektiv;perioder)

Parametrar
Kommentar: Effektiv ränta, Typ: Flyttal (som 1,3, 0,343 eller 253)
Kommentar: Perioder, Typ: Flyttal (som 1,3, 0,343 eller 253)

Exempel

NOMINAL(0,08;12) är lika med 0,0772

Liknande funktioner
EFFECT

8.1.6.31 NPER

Returnerar antal perioder för en investering.

Returtyp: Flyttal (som 1,3, 0,343 eller 253)

Syntax

NPER(Räntesats;Betalning;AV;FV;Typ)

Parametrar
Kommentar: Hastighet, Typ: Flyttal (som 1,3, 0,343 eller 253)
Kommentar: Betalning, Typ: Flyttal (som 1,3, 0,343 eller 253)
Kommentar: Aktuellt värde (AV), Typ: Flyttal (som 1,3, 0,343 eller 253)
Kommentar: Framtida värde (FV - valfritt), Typ: Flyttal (som 1,3, 0,343 eller 253)
Kommentar: Typ (valfri), Typ: Heltal (som 1, 132 eller 2344)
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Exempel
NPER(0,1; -100; 1000) är lika med 11

Exempel
NPER(0,06; 0; -10000; 20000 ;0) returnerar 11,906

Liknande funktioner
FV
RATE
PMT
PV

8.1.6.32 NPV

Det totala aktuella värdet (NPV) för en serie periodiska valutaflöden.

Beräknar det totala aktuella värdet för en serie periodiska valutaflöden med diskontot Diskonto.
Värden ska vara positiva om de tas emot som inkomster och negativa om de betalas som utgifter.

Returtyp: Flyttal (som 1,3, 0,343 eller 253)

Syntax
NPV(Diskonto; Värden)

Parametrar
Kommentar: Hastighet, Typ: Flyttal (som 1,3, 0,343 eller 253)
Kommentar: Värden (fält), Typ: Flyttal (som 1,3, 0,343 eller 253)

Exempel
NPV(100%;4;5;7) = 4,125

Liknande funktioner
FV
IRR
NPER
PMT
PV

8.1.6.33 ODDLPRICE

Funktionen ODDLPRICE beräknar värdet på ett värdepapper per 100 valutaenheter nominellt
värde. Värdepappret har ett oregelbundet sista räntedatum.

Returtyp: Flyttal (som 1,3, 0,343 eller 253)

Syntax

ODDLPRICE(Avräkning; Förfaller; Sista; Räntesats; Årlig avkastning; Andelsåterköp; Fre-
kvens [; Bas = 0 ])

Parametrar
Kommentar: Avräkning, Typ: Datum
Kommentar: Förfaller, Typ: Datum
Kommentar: Sista, Typ: Datum
Kommentar: Hastighet, Typ: Flyttal (som 1,3, 0,343 eller 253)
Kommentar: Årlig avkastning, Typ: Flyttal (som 1,3, 0,343 eller 253)
Kommentar: Andelsåterköp, Typ: Flyttal (som 1,3, 0,343 eller 253)
Kommentar: Frekvens, Typ: Flyttal (som 1,3, 0,343 eller 253)
Kommentar: Bas, Typ: Heltal (som 1, 132 eller 2344)
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Exempel
ODDLPRICE(DATE(1990;6;1);DATE(1995;12;31);DATE(1990;1;1);3%;5%;100;2) returnerar
90,991042345

8.1.6.34 ODDLYIELD

Funktionen ODDLYIELD beräknar avkastningen av ett värdepapper som har ett oregelbundet
sista räntedatum.
Returtyp: Flyttal (som 1,3, 0,343 eller 253)

Syntax
ODDLYIELD(Avräkning; Förfaller; Sista; Räntesats; Pris; Andelsåterköp; Frekvens [; Bas =
0 ])

Parametrar
Kommentar: Avräkning, Typ: Datum
Kommentar: Förfaller, Typ: Datum
Kommentar: Sista, Typ: Datum
Kommentar: Hastighet, Typ: Flyttal (som 1,3, 0,343 eller 253)
Kommentar: Pris, Typ: Flyttal (som 1,3, 0,343 eller 253)
Kommentar: Andelsåterköp, Typ: Flyttal (som 1,3, 0,343 eller 253)
Kommentar: Frekvens, Typ: Flyttal (som 1,3, 0,343 eller 253)
Kommentar: Bas, Typ: Heltal (som 1, 132 eller 2344)

Exempel
ODDLYIELD(DATE(1990;6;1);DATE(1995;12;31);DATE(1990;1;1);3%;91;100;2) returnerar
4,997775351

Liknande funktioner
ODDLPRICE

8.1.6.35 PMT

PMT returnerar storleken på betalningen för ett lån baserat på en konstant räntesats och konstan-
ta betalningar (varje betalning har samma belopp).

Returtyp: Flyttal (som 1,3, 0,343 eller 253)

Syntax
PMT(räntesats; aper ; nv [; fv = 0 [; typ = 0 ]] )

Parametrar
Kommentar: Hastighet, Typ: Flyttal (som 1,3, 0,343 eller 253)
Kommentar: Antal perioder (Aper), Typ: Flyttal (som 1,3, 0,343 eller 253)
Kommentar: Aktuellt värde (AV), Typ: Flyttal (som 1,3, 0,343 eller 253)
Kommentar: Framtida värde (FV - valfritt), Typ: Flyttal (som 1,3, 0,343 eller 253)
Kommentar: Typ (valfri), Typ: Heltal (som 1, 132 eller 2344)

Exempel
PMT(0,1; 4; 10000) är lika med -3154,71

Liknande funktioner
NPER
IPMT
PPMT
PV
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8.1.6.36 PPMT

PPMT beräknar beloppet för en betalning under en period som gäller amortering.

Räntesats är den periodiska räntesatsen.

Period är amorteringsperioden. 1 för den första och APER för den sista perioden.

APER är det totala antalet perioder som det periodiska beloppet betalas.

AV är aktuellt värde i följden av betalningar.

FV (valfritt) är det önskade (framtida) värdet. Förval: 0.

Typ (valfri) anger utfallsdatum. 1 för betalning i början av en period och 0 (förval) för betalning i
slutet av en period.

Returtyp: Flyttal (som 1,3, 0,343 eller 253)

Syntax

PPMT(Räntesats; Period; APer; NV [; FV = 9 [; Typ = 0 ]] )

Parametrar
Kommentar: Hastighet, Typ: Flyttal (som 1,3, 0,343 eller 253)
Kommentar: Period, Typ: Flyttal (som 1,3, 0,343 eller 253)
Kommentar: Antal perioder, Typ: Flyttal (som 1,3, 0,343 eller 253)
Kommentar: Aktuellt värde, Typ: Flyttal (som 1,3, 0,343 eller 253)
Kommentar: Framtida värde (valfritt), Typ: Flyttal (som 1,3, 0,343 eller 253)
Kommentar: Typ (valfri), Typ: Heltal (som 1, 132 eller 2344)

Exempel

PPMT(0,0875;1;36;5000;8000;1) är lika med -18,48

Liknande funktioner
IPMT
PMT
PV

8.1.6.37 PRICEMAT

PRICEMAT beräkna priset per 100 valutaenheter nominellt värde för värdepappret som betalar
ränta vid förfallodatum.
Basberäkningsmetod

0 Metod använd i Förenta staterna, 12 månader, varje månad med 30 dagar

1 Verkligt antal dagar under ett år, verkligt antal dagar i månader

2 360 dagar under ett år, verkligt antal dagar i månader

4 365 dagar under ett år, verkligt antal dagar i månader

5 Europeisk metod, 12 månader, där varje månad har 30 dagar

Returtyp: Flyttal (som 1,3, 0,343 eller 253)

Syntax

PRICEMAT(avräkning; förfaller; utgåva; räntesats; avkastning [; bas = 0 ])
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Parametrar
Kommentar: Avräkning, Typ: Datum
Kommentar: Förfaller, Typ: Datum
Kommentar: Utgåva, Typ: Datum
Kommentar: Kupongsats, Typ: Flyttal (som 1,3, 0,343 eller 253)
Kommentar: Avkastning, Typ: Flyttal (som 1,3, 0,343 eller 253)
Kommentar: Bas, Typ: Heltal (som 1, 132 eller 2344)

Exempel

PRICEMAT(DATE(1990;6;1);DATE(1995;12;31);DATE(1990;1;1);6%;5%) returnerar
103,819218241

8.1.6.38 PV

Funktionen PV() beräknar nuvärdet av en investering - dagens värde av en mängd pengar i
framtiden, givet räntesats eller inflation. Till exempel om du behöver 11664 kr för din nya dator,
du vill köpa den om två år och får 8 % ränta, måste du börja med PV(11664;0,08;2) eller 10000 kr.

Returtyp: Flyttal (som 1,3, 0,343 eller 253)

Syntax

PV(framtida värde;ränta;perioder)

Parametrar
Kommentar: Framtida värde, Typ: Flyttal (som 1,3, 0,343 eller 253)
Kommentar: Räntesats, Typ: Flyttal (som 1,3, 0,343 eller 253)
Kommentar: Perioder, Typ: Flyttal (som 1,3, 0,343 eller 253)

Exempel

PV(11664;0,08;2) är lika med 10000

8.1.6.39 PV_ANNUITY

Funktionen PV_ANNUITY() beräknar nuvärdet av årliga/periodiska insättningar. Till exempel:
En vinst på miljonlotteriet som betalar ut 500 000 kr om året under 20 år, med en räntesats på 5
% är egentligen värd PV_ANNUITY(500000;0,05;20) eller 6 231 105 kr. Denna funktion antar att
utbetalningar görs i slutet på varje period.

Returtyp: Flyttal (som 1,3, 0,343 eller 253)

Syntax

PV_ANNUITY(summa;ränta;perioder)

Parametrar
Kommentar: Betalning per period, Typ: Flyttal (som 1,3, 0,343 eller 253)
Kommentar: Räntesats, Typ: Flyttal (som 1,3, 0,343 eller 253)
Kommentar: Perioder, Typ: Flyttal (som 1,3, 0,343 eller 253)

Exempel

PV_ANNUITY(1000;0,05;5) är lika med 4329,48
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8.1.6.40 RATE

Funktionen RATE() beräknar den konstanta räntesatsen per period för en investering.

Returtyp: Flyttal (som 1,3, 0,343 eller 253)

Syntax

RATE(nper;bet;nuv;framv;typ;gissning)

Parametrar
Kommentar: Betalningsperiod, Typ: Flyttal (som 1,3, 0,343 eller 253)
Kommentar: Regelbundna betalningar, Typ: Flyttal (som 1,3, 0,343 eller 253)
Kommentar: Aktuellt värde, Typ: Flyttal (som 1,3, 0,343 eller 253)
Kommentar: Framtida värde, Typ: Flyttal (som 1,3, 0,343 eller 253)
Kommentar: Typ, Typ: Flyttal (som 1,3, 0,343 eller 253)
Kommentar: Gissning, Typ: Flyttal (som 1,3, 0,343 eller 253)

Exempel

RATE(4*12;-200;8000) är lika med 0,007701472

8.1.6.41 RECEIVED

Funktionen RECEIVED returnerar beloppet som erhålls vid förfallodatum för en investering i
värdepapper. Bas är dagberäkningsmetoden du vill använda: 0: amerikansk 30/360 (standard-
värde), 1: verkliga dagar, 2: verkliga dagar/360 3: verkliga dagar/365 eller 4: europeisk 30/365.
Avräkningsdatum måste vara innan förfallodatum.

Returtyp: Flyttal (som 1,3, 0,343 eller 253)

Syntax

RECEIVED(avräkning; förfaller; investering; kupongsats; bas)

Parametrar
Kommentar: Avräkning, Typ: Datum
Kommentar: Förfaller, Typ: Datum
Kommentar: Investering, Typ: Flyttal (som 1,3, 0,343 eller 253)
Kommentar: Kupongsats, Typ: Flyttal (som 1,3, 0,343 eller 253)
Kommentar: Bas, Typ: Heltal (som 1, 132 eller 2344)

Exempel

RECEIVED(˝2001-02-28˝; ˝2001-08-31˝; 1000; 0,05; 0) returnerar 1 025,787

8.1.6.42 RRI

Funktionen RRI beräknar räntesatsen som ges av vinsten (resultatet) av en investering.

Returtyp: Flyttal (som 1,3, 0,343 eller 253)

Syntax

RRI( P; Nv; Fv)

Parametrar
Kommentar: P, Typ: Heltal (som 1, 132 eller 2344)
Kommentar: Pv, Typ: Flyttal (som 1,3, 0,343 eller 253)
Kommentar: Fv, Typ: Flyttal (som 1,3, 0,343 eller 253)
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Exempel

RRI(1;100;200) returnerar 1

Liknande funktioner
FV
NPER
PMT
PV
RATE

8.1.6.43 SLN

Funktionen SLN() beräknar den linjära värdeminskningen för en tillgång under en enstaka pe-
riod. Kostnad är värdet du betalade för tillgången. Kvarvarande värde är värdet på tillgången
vid periodens slut. Livstid är antal perioder som tillgångens värdeminskning sker. SLN fördelar
kostnaden jämt över tillgångens livstid.

Returtyp: Flyttal (som 1,3, 0,343 eller 253)

Syntax

SLN(kostnad; kvarvarande värde; livstid)

Parametrar
Kommentar: Kostnad, Typ: Flyttal (som 1,3, 0,343 eller 253)
Kommentar: Kvarvarande, Typ: Flyttal (som 1,3, 0,343 eller 253)
Kommentar: Livstid, Typ: Flyttal (som 1,3, 0,343 eller 253)

Exempel

SLN(10000;700;10) är lika med 930

Liknande funktioner
SYD
DDB

8.1.6.44 SYD

Funktionen SYD() beräknar årliga summan för värdeminskningen av en tillgång baserad på dess
kostnad, kvarvarande värde, beräknad livstid, och en viss period. Den här metoden ökar värde-
minskningens hastighet, så att större värdeminskningskostnad sker under tidigare perioder än
under senare. Kostanden för värdeminskning är den verkliga kostnaden minus det kvarvarande
värdet. Den användbara livstiden är antalet perioder (typiskt år) under vilka tillgången minskar
i värde.
Returtyp: Flyttal (som 1,3, 0,343 eller 253)

Syntax

SYD(kostnad; kvarvarande värde; livstid; period)

Parametrar
Kommentar: Kostnad, Typ: Flyttal (som 1,3, 0,343 eller 253)
Kommentar: Kvarvarande, Typ: Flyttal (som 1,3, 0,343 eller 253)
Kommentar: Livstid, Typ: Flyttal (som 1,3, 0,343 eller 253)
Kommentar: Period, Typ: Flyttal (som 1,3, 0,343 eller 253)

Exempel

SYD(5000; 200; 5; 2) är lika med 1280
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Liknande funktioner
SLN
DDB

8.1.6.45 TBILLEQ

Funktionen TBILLEQ returnerar ekvivalent förlagsbevis för en statsskuldväxel. Förfallodatum
måste vara efter avräkningsdatum men inom 365 dagar.

Returtyp: Flyttal (som 1,3, 0,343 eller 253)

Syntax

TBILLEQ(avräkning; förfaller; kupongsats)

Parametrar
Kommentar: Avräkning, Typ: Datum
Kommentar: Förfaller, Typ: Datum
Kommentar: Kupongsats, Typ: Flyttal (som 1,3, 0,343 eller 253)

Exempel

TBILLEQ(˝2001-02-28˝; ˝2001-08-31˝; 0,1) returnerar 0,1068

Liknande funktioner
TBILLPRICE
TBILLYIELD

8.1.6.46 TBILLPRICE

Funktionen TBILLPRICE returnerar priset per 100 dollars värde för en statsskuldväxel. Förfallo-
datum måste vara efter avräkningsdatum men inom 365 dagar. Kupongsatsen måste vara positiv.

Returtyp: Flyttal (som 1,3, 0,343 eller 253)

Syntax

TBILLPRICE(avräkning; förfaller; kupongsats)

Parametrar
Kommentar: Avräkning, Typ: Datum
Kommentar: Förfaller, Typ: Datum
Kommentar: Kupongsats, Typ: Flyttal (som 1,3, 0,343 eller 253)

Exempel

TBILLPRICE(˝2001-02-28˝; ˝2001-08-31˝; 0,05) returnerar 97,4444

Liknande funktioner
TBILLEQ
TBILLYIELD
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8.1.6.47 TBILLYIELD

Funktionen TBILLYIELD returnerar avkastningen för en statsskuldväxel. Förfallodatum måste
vara efter avräkningsdatum men inom 365 dagar. Priset måste vara positivt.

Returtyp: Flyttal (som 1,3, 0,343 eller 253)

Syntax

TBILLYIELD(avräkning; förfaller; pris)

Parametrar
Kommentar: Avräkning, Typ: Datum
Kommentar: Förfaller, Typ: Datum
Kommentar: Pris per 100 dollar nominellt värde, Typ: Flyttal (som 1,3, 0,343 eller 253)

Exempel

TBILLYIELD(˝2001-02-28˝; ˝2001-08-31˝; 600) returnerar -1,63

Liknande funktioner
TBILLEQ
TBILLPRICE

8.1.6.48 VDB

VDB beräknar värdeminskning för en tillgång med ett ursprungligt värde, förväntat nyttig livs-
längd, och ett slutligt kvarvarande värde för en angiven period, genom att använda metoden
variabelt minskande värde.
Returtyp: Flyttal (som 1,3, 0,343 eller 253)

Syntax

VDB(kostnad; kvarvarande; livslängd; startperiod; slutperiod; [; värdeminskningsfaktor =
2 [; byt = false ]])

Parametrar
Kommentar: Avräkning, Typ: Datum
Kommentar: Förfaller, Typ: Datum
Kommentar: Pris, Typ: Flyttal (som 1,3, 0,343 eller 253)
Kommentar: Andelsåterköp, Typ: Flyttal (som 1,3, 0,343 eller 253)
Kommentar: Bas, Typ: Heltal (som 1, 132 eller 2344)

Exempel

VDB(10000;600;10;0;0.875;1,5) returnerar 1312,5

8.1.6.49 XIRR

Funktionen XIRR() beräknar den modifierade internräntan för en serie icke-periodiska valutaflö-
den.
Returtyp: Flyttal (som 1,3, 0,343 eller 253)

Syntax

XIRR(Värden; Datum [; Gissning = 0,1])
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Parametrar
Kommentar: Värden, Typ: Flyttal (som 1,3, 0,343 eller 253)
Kommentar: Datum, Typ: Datum
Kommentar: Gissning, Typ: Flyttal (som 1,3, 0,343 eller 253)

Exempel

XIRR(B1:B4;C1:C4) med antagandet att B1:B4 innehåller -20000, 4000, 12000, 8000
medan C1:C4 innehåller ˝=DATE(2000;1;1)˝, ˝=DATE(2000;6;1)˝, ˝=DATE(2000;12;30)˝,
˝=DATE(2001;3;1)˝ returnerar 0,2115964

Liknande funktioner
IRR

8.1.6.50 XNPV

Funktionen XNPV beräknar det totala aktuella värdet för en serie valutaflöden.
Returtyp: Flyttal (som 1,3, 0,343 eller 253)

Syntax

XNPV(Räntesats; Värden; Datum)

Parametrar
Kommentar: Hastighet, Typ: Flyttal (som 1,3, 0,343 eller 253)
Kommentar: Värden, Typ: Flyttal (som 1,3, 0,343 eller 253)
Kommentar: Datum, Typ: Datum

Exempel

XNPV(5%;B1:B4;C1:C4) med antagandet att B1:B4 innehåller -20000, 4000, 12000, 8000
medan C1:C4 innehåller ˝=DATE(2000;1;1)˝, ˝=DATE(2000;6;1)˝, ˝=DATE(2000;12;30)˝,
˝=DATE(2001;3;1)˝ returnerar 2907,83187

Liknande funktioner
NPV

8.1.6.51 YIELDDISC

YIELDDISC beräknar avkastningen för ett rabatterat värdepapper per 100 valutaenheter nomi-
nellt värde.
Returtyp: Flyttal (som 1,3, 0,343 eller 253)

Syntax

YIELDDISC(avräkning; förfaller; pris; andelsåterköp; bas)

Parametrar
Kommentar: Avräkning, Typ: Datum
Kommentar: Förfaller, Typ: Datum
Kommentar: Pris, Typ: Flyttal (som 1,3, 0,343 eller 253)
Kommentar: Andelsåterköp, Typ: Flyttal (som 1,3, 0,343 eller 253)
Kommentar: Bas, Typ: Heltal (som 1, 132 eller 2344)

Exempel

YIELDDISC(DATE(1990;6;1);DATE(1990;12;31);941.66667;1000) returnerar 0,106194684
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8.1.6.52 YIELDMAT

Funktionen YIELDMAT beräknar avkastningen för värdepappret som betalar ränta på förfallo-
datum.
Returtyp: Flyttal (som 1,3, 0,343 eller 253)

Syntax

YIELDMAT(Avräkning; Förfaller; Utgåva; Räntesats; Pris; Bas)

Parametrar
Kommentar: Avräkning, Typ: Datum
Kommentar: Förfaller, Typ: Datum
Kommentar: Utgåva, Typ: Datum
Kommentar: Kupongsats, Typ: Flyttal (som 1,3, 0,343 eller 253)
Kommentar: Pris, Typ: Flyttal (som 1,3, 0,343 eller 253)
Kommentar: Bas, Typ: Heltal (som 1, 132 eller 2344)

Exempel

YIELDMAT(DATE(1990;6;1);DATE(1995;12;31);DATE(1990; 1; 1); 6%;103,819218241) retur-
nerar 0,050000000

Liknande funktioner
YIELDDISC

8.1.6.53 ZERO_COUPON

Funktionen ZERO_COUPON() beräknar värdet av en nollobligationskupong. Till exem-
pel: om räntesatsen är 10%, så blir en 1000 kr obligation som förfaller på 20 år värd
ZERO_COUPON(1000;1;20) eller 148,64 kr.

Returtyp: Flyttal (som 1,3, 0,343 eller 253)

Syntax

ZERO_COUPON(valör;räntesats;år)

Parametrar
Kommentar: Valör, Typ: Flyttal (som 1,3, 0,343 eller 253)
Kommentar: Räntesats, Typ: Flyttal (som 1,3, 0,343 eller 253)
Kommentar: År, Typ: Flyttal (som 1,3, 0,343 eller 253)

Exempel

ZERO_COUPON(1000;0,1;20) är lika med 148,64

8.1.7 Information

8.1.7.1 ERRORTYPE

Funktionen ERRORTYPE() konverterar ett fel till ett tal. Om värdet inte är ett fel, returneras ett
fel. Annars returneras en numerisk kod. Felkoderna är modellerade efter Excel.
Returtyp: Heltal (som 1, 132 eller 2344)

Syntax

ERRORTYPE(värde)
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Parametrar
Kommentar: Fel, Typ: Vilket värde som helst

Exempel

ERRORTYPE(NA()) returnerar 7

Exempel

ERRORTYPE(0) returnerar ett fel

8.1.7.2 FILENAME

Returnerar det aktuella filnamnet. Om det aktuella dokumentet inte har sparats, så returneras en
tom sträng.

Returtyp: Text

Syntax

FILENAME()

Parametrar

8.1.7.3 FORMULA

Funktionen FORMULA() returnerar formeln i en cell som en sträng.

Returtyp: Text

Syntax

FORMULA(x)

Parametrar
Kommentar: Referens, Typ: Referens

Exempel

FORMULA(A1) returnerar ˝=SUM(1+2)˝ om cellen A1 innehåller en sådan formel.

8.1.7.4 INFO

Funktionen INFO() returnerar information om den aktuella miljön. Parameterns typ anger vilken
typ av information som ska returneras. Det är något av följande: ˝directory˝ returnerar sökvägen
till aktuell arbetskatalog, ˝numfile˝ returnerar antalet aktiva dokument, ˝release˝ returnerar Cal-
ligra Sheets version som text, ˝recalc˝ returnerar det aktuella beräkningsläget: ˝Automatic˝ eller
˝Manual˝, ˝system˝ returnerar namnet på operativsystemet, ˝osversion˝ returnerar versionen
för det aktuella operativsystemet.

Returtyp: Text

Syntax

INFO(typ)

Parametrar
Kommentar: Informationstyp, Typ: Text

135



Handbok Calligra Sheets

8.1.7.5 ISBLANK

Funktionen ISBLANK() returnerar True om parametern är tom, annars returneras False.

Returtyp: Ett booleskt värde (TRUE eller FALSE)

Syntax

ISBLANK(x)

Parametrar
Kommentar: Vilket värde som helst, Typ: Vilket värde som helst

Exempel

ISBLANK(A1) returnerar True om A1 är tom

Exempel

ISBLANK(A1) returnerar False om A1 innehåller ett värde

8.1.7.6 ISDATE

Funktionen ISDATE() returnerar True om parametern är ett datum värde, annars returneras False

Returtyp: Ett booleskt värde (TRUE eller FALSE)

Syntax

ISDATE(x)

Parametrar
Kommentar: Vilket värde som helst, Typ: Vilket värde som helst

Exempel

ISDATE(˝2000-2-2˝) returnerar True

Exempel

ISDATE(˝hallå˝) returnerar False

8.1.7.7 ISERR

Funktionen ISERR() returnerar sant om parametern är ett fel annat än INTE TILLGÄNGLIG.
Annars returnerar den falskt. Använd ISERROR() om du också vill att INTE TILLGÄNGLIG ska
ingå.

Returtyp: Ett booleskt värde (TRUE eller FALSE)

Syntax

ISERR(x)

Parametrar
Kommentar: Vilket värde som helst, Typ: Vilket värde som helst

Liknande funktioner
ISERROR
ISNA
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8.1.7.8 ISERROR

Funktionen ISERROR() returnerar sant om parametern är ett fel av någon typ. Annars returnerar
den falskt.
Returtyp: Ett booleskt värde (TRUE eller FALSE)

Syntax

ISERROR(x)

Parametrar
Kommentar: Vilket värde som helst, Typ: Vilket värde som helst

Liknande funktioner
ISERR
ISNA

8.1.7.9 ISEVEN

Funktionen ISEVEN() returnerar sant om talet är jämnt, annars returneras falskt.

Returtyp: Ett booleskt värde (TRUE eller FALSE)

Syntax

ISEVEN(x)

Parametrar
Kommentar: Vilket värde som helst, Typ: Vilket värde som helst

Exempel

ISEVEN(12) returnerar True

Exempel

ISEVEN(-7) returnerar False

8.1.7.10 ISFORMULA

Funktionen ISFORMULA() returnerar True om den refererade cellen innehåller en formel, annars
returnerar den False.
Returtyp: Ett booleskt värde (TRUE eller FALSE)

Syntax

ISFORMULA(x)

Parametrar
Kommentar: Referens, Typ: Referens

137



Handbok Calligra Sheets

8.1.7.11 ISLOGICAL

Funktionen ISLOGICAL() returnerar True om parametern är ett booleskt värde, annars returne-
ras False.
Returtyp: Ett booleskt värde (TRUE eller FALSE)

Syntax

ISLOGICAL(x)

Parametrar
Kommentar: Vilket värde som helst, Typ: Vilket värde som helst

Exempel

ISLOGICAL(A1 >A2) returnerar True

Exempel

ISLOGICAL(12) returnerar False

8.1.7.12 ISNA

Funktionen ISNA() returnerar sant om parametern är ett fel av typen INTE TILLGÄNGLIG. I alla
andra fall returnerar den falskt.
Returtyp: Ett booleskt värde (TRUE eller FALSE)

Syntax

ISNA(x)

Parametrar
Kommentar: Vilket värde som helst, Typ: Vilket värde som helst

Liknande funktioner
ISERR
ISERROR

8.1.7.13 ISNONTEXT

Funktionen ISNONTEXT() returnerar True om parametern inte är en textsträng, annars returne-
ras False. Den är samma som ISNOTTEXT.
Returtyp: Ett booleskt värde (TRUE eller FALSE)

Syntax

ISNONTEXT(x)

Parametrar
Kommentar: Vilket värde som helst, Typ: Vilket värde som helst

Exempel

ISNONTEXT(12) returnerar True

Exempel

ISNONTEXT(˝hello˝) returnerar False

Liknande funktioner
ISNOTTEXT
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8.1.7.14 ISNOTTEXT

Funktionen ISNOTTEXT() returnerar True om parametern inte är en textsträng, annars returneras
False. Den är samma som ISNONTEXT.
Returtyp: Ett booleskt värde (TRUE eller FALSE)

Syntax

ISNOTTEXT(x)

Parametrar
Kommentar: Vilket värde som helst, Typ: Vilket värde som helst

Exempel

ISNOTTEXT(12) returnerar True

Exempel

ISNOTTEXT(˝hello˝) returnerar False

Liknande funktioner
ISNONTEXT

8.1.7.15 ISNUM

Funktionen ISNUM() returnerar sant om parametern är ett numeriskt värde, annars returneras
falskt. Den är samma som ISNUMBER.
Returtyp: Ett booleskt värde (TRUE eller FALSE)

Syntax

ISNUM(x)

Parametrar
Kommentar: Vilket värde som helst, Typ: Vilket värde som helst

Exempel

ISNUM(12) returnerar True

Exempel

ISNUM(hello) returnerar False

Liknande funktioner
ISNUMBER

8.1.7.16 ISNUMBER

Funktionen ISNUMBER() returnerar sant om parametern är ett numeriskt värde, annars returne-
ras falskt. Den är samma som ISNUM.
Returtyp: Ett booleskt värde (TRUE eller FALSE)

Syntax

ISNUMBER(x)

Parametrar
Kommentar: Vilket värde som helst, Typ: Vilket värde som helst
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Exempel

ISNUMBER(12) returnerar True

Exempel

ISNUMBER(hello) returnerar False

Liknande funktioner
ISNUM

8.1.7.17 ISODD

Funktionen ISODD() returnerar sant om talet är udda, annars returneras falskt.

Returtyp: Ett booleskt värde (TRUE eller FALSE)

Syntax

ISODD(x)

Parametrar
Kommentar: Vilket värde som helst, Typ: Vilket värde som helst

Exempel

ISODD(12) returnerar False

Exempel

ISODD(-7) returnerar True

8.1.7.18 ISREF

Funktionen ISREF() returnerar True om parametern anger en referens, annars returneras False

Returtyp: Ett booleskt värde (TRUE eller FALSE)

Syntax

ISREF(x)

Parametrar
Kommentar: Vilket värde som helst, Typ: Vilket värde som helst

Exempel

ISREF(A12) returnerar true

Exempel

ISREF(˝hallå˝) returnerar false
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8.1.7.19 ISTEXT

Funktionen ISTEXT() returnerar True om parametern är en textsträng, annars returneras False

Returtyp: Ett booleskt värde (TRUE eller FALSE)

Syntax

ISTEXT(x)

Parametrar
Kommentar: Vilket värde som helst, Typ: Vilket värde som helst

Exempel

ISTEXT(12) returnerar False

Exempel

ISTEXT(˝hello˝) returnerar True

8.1.7.20 ISTIME

Funktionen ISTIME() returnerar sant om parametern är ett tidsvärde, annars returneras falskt.

Returtyp: Ett booleskt värde (TRUE eller FALSE)

Syntax

ISTIME(x)

Parametrar
Kommentar: Vilket värde som helst, Typ: Vilket värde som helst

Exempel

ISTIME(˝12:05˝) returnerar True

Exempel

ISTIME(˝hallå˝) returnerar False

8.1.7.21 N

Funktionen N() konverterar ett värdet till ett tal. Om värdet är, eller refererar till ett tal, så retur-
nerar funktionen talet. Om värdet är True, så returnerar funktionen 1. Om värdet är ett datum,
returnerar funktionen det datumets serienummer. Allt annat gör att funktionen returnerar 0.

Returtyp: Heltal (som 1, 132 eller 2344)

Syntax

N(värde)

Parametrar
Kommentar: Värde, Typ: Vilket värde som helst

Exempel

N(3,14) returnerar 3,14

Exempel

N(˝7˝) returnerar 0 (eftersom ˝7˝ är text)
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8.1.7.22 NA

Funktionen NA() returnerar det konstanta felvärdet, INTE TILLGÄNGLIG.

Returtyp: Fel

Syntax
NA()

Parametrar

Liknande funktioner
ISNA
ISERR
ISERROR

8.1.7.23 TYPE

Funktionen TYPE() returnerar 1 om värdet är ett tal, 2 om det är text, 4 om det är ett logiskt värde,
16 om det är ett felvärde eller 64 om värdet är en lista. Om cellen värdet representerar innehåller
en formel, returneras dess returtyp.

Returtyp: Heltal (som 1, 132 eller 2344)

Syntax
TYPE(x)

Parametrar
Kommentar: Vilket värde som helst, Typ: Vilket värde som helst

Exempel
TYPE(A1) returnerar 2, om A1 innehåller ˝Text˝

Exempel
TYPE(-7) returnerar 1

Exempel
TYPE(A2) returnerar 1, om A2 innehåller ˝=CURRENTDATE()˝

8.1.8 Logisk

8.1.8.1 AND

Funktionen AND() returnerar sant om alla värden är sanna, annars returneras falskt (om inte
något av värdena är fel, då returnerar den ett fel).

Returtyp: Ett booleskt värde (TRUE eller FALSE)

Syntax
AND(värde;värde;...)

Parametrar
Kommentar: Booleska värden, Typ: Ett område med booleska värden (TRUE eller FALSE)
Kommentar: Booleska värden, Typ: Ett område med booleska värden (TRUE eller FALSE)
Kommentar: Booleska värden, Typ: Ett område med booleska värden (TRUE eller FALSE)
Kommentar: Booleska värden, Typ: Ett område med booleska värden (TRUE eller FALSE)
Kommentar: Booleska värden, Typ: Ett område med booleska värden (TRUE eller FALSE)
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Exempel

AND(Sant;Sant;Sant) returnerar Sann

Exempel

AND(Sant;Falsk) returnerar Falsk

8.1.8.2 FALSE

Funktionen FALSE() returnerar det booleska värdet FALSK.

Returtyp: Ett booleskt värde (TRUE eller FALSE)

Syntax

FALSE()

Parametrar

Exempel

FALSE() returnerar FALSK

8.1.8.3 IF

Funktionen IF() är en villkorlig funktion. Denna funktion returnerar den andra parametern om
villkoret är sant, annars returneras den tredje parametern (som har standardvärdet falskt).

Returtyp: Vilket värde som helst

Syntax

IF(villkor;om_sant;om_falskt)

Parametrar
Kommentar: Villkor, Typ: Ett booleskt värde (TRUE eller FALSE)
Kommentar: om sant, Typ: Vilket värde som helst
Kommentar: om falskt, Typ: Vilket värde som helst

Exempel

A1=4;A2=6;IF(A1 >A2;5;3) returnerar 3

8.1.8.4 IFERROR

Returnera X om inte ett fel inträffar, returnera då ett alternativt värde.

Returtyp: Vilket värde som helst

Syntax

IFERROR(X;Alternativ)

Parametrar
Kommentar: X, Typ: Vilket värde som helst
Kommentar: Alternativ, Typ: Vilket värde som helst

Exempel

IFERROR(A1;A2) returnera innehållet i A1 om innehållet inte är ett felvärde, annars retur-
nera A2.
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8.1.8.5 IFNA

Returnera X om det inte är NA, returnera då ett alternativt värde.

Returtyp: Vilket värde som helst

Syntax

IFNA(X;Alternativ)

Parametrar
Kommentar: X, Typ: Vilket värde som helst
Kommentar: Alternativ, Typ: Vilket värde som helst

Exempel

IFNA(A1;A2) returnera innehållet i A1 om innehållet inte är ett #INTE TILLGÄNGLIG fel-
värde, annars returnera A2.

8.1.8.6 NAND

Funktionen NAND() returnerar sant om minst ett av värdena inte är sant, annars returneras
falskt.
Returtyp: Ett booleskt värde (TRUE eller FALSE)

Syntax

NAND(värde;värde;...)

Parametrar
Kommentar: Booleska värden, Typ: Ett område med booleska värden (TRUE eller FALSE)
Kommentar: Booleska värden, Typ: Ett område med booleska värden (TRUE eller FALSE)
Kommentar: Booleska värden, Typ: Ett område med booleska värden (TRUE eller FALSE)
Kommentar: Booleska värden, Typ: Ett område med booleska värden (TRUE eller FALSE)
Kommentar: Booleska värden, Typ: Ett område med booleska värden (TRUE eller FALSE)

Exempel

NAND(Sant;Falsk;Falsk) returnerar Sann

Exempel

NAND(Sann;Sann) returnerar Falsk

8.1.8.7 NOR

Funktionen NOR() returnerar sant om alla värden är av typen boolesk och har värdet falskt,
annars returnerar den falskt.
Returtyp: Ett booleskt värde (TRUE eller FALSE)

Syntax

NOR(värde;värde;...)

Parametrar
Kommentar: Booleska värden, Typ: Ett område med booleska värden (TRUE eller FALSE)
Kommentar: Booleska värden, Typ: Ett område med booleska värden (TRUE eller FALSE)
Kommentar: Booleska värden, Typ: Ett område med booleska värden (TRUE eller FALSE)
Kommentar: Booleska värden, Typ: Ett område med booleska värden (TRUE eller FALSE)
Kommentar: Booleska värden, Typ: Ett område med booleska värden (TRUE eller FALSE)
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Exempel

NOR(Sann;Falsk;Falsk) returnerar Falsk

Exempel

NOR(false;false) returnerar Sann

8.1.8.8 NOT

Funktionen NOT() returnerar sant om värdet är falskt och returnerar falskt om värdet är sant.
Den returnerar ett fel om indata är fel.
Returtyp: Ett booleskt värde (TRUE eller FALSE)

Syntax

NOT(boolesk)

Parametrar
Kommentar: Booleskt värde, Typ: Ett booleskt värde (TRUE eller FALSE)

Exempel

NOT(Falsk) returnerar Sann

Exempel

NOT(Sant) returnerar Falsk

8.1.8.9 OR

Funktionen OR() returnerar sant om minst ett av värdena är sant, annars returneras falskt (om
inte något av värdena är fel, då returnerar den ett fel).

Returtyp: Ett booleskt värde (TRUE eller FALSE)

Syntax

OR(värde;värde;...)

Parametrar
Kommentar: Booleska värden, Typ: Ett område med booleska värden (TRUE eller FALSE)
Kommentar: Booleska värden, Typ: Ett område med booleska värden (TRUE eller FALSE)
Kommentar: Booleska värden, Typ: Ett område med booleska värden (TRUE eller FALSE)
Kommentar: Booleska värden, Typ: Ett område med booleska värden (TRUE eller FALSE)
Kommentar: Booleska värden, Typ: Ett område med booleska värden (TRUE eller FALSE)

Exempel

OR(Falsk;Falsk;Falsk) returnerar Falsk

Exempel

OR(Sant;Falsk) returnerar Sann
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8.1.8.10 TRUE

Funktionen TRUE() returnerar det booleska värdet Sann.

Returtyp: Ett booleskt värde (TRUE eller FALSE)

Syntax

TRUE()

Parametrar

Exempel

TRUE() returnerar Sann

8.1.8.11 XOR

Funktionen XOR() returnerar falskt om antalet sanna värden är jämnt, annars returneras sant.
Den returnerar ett fel om något argument är fel.

Returtyp: Ett booleskt värde (TRUE eller FALSE)

Syntax

XOR(värde;värde;...)

Parametrar
Kommentar: Booleska värden, Typ: Ett område med booleska värden (TRUE eller FALSE)
Kommentar: Booleska värden, Typ: Ett område med booleska värden (TRUE eller FALSE)
Kommentar: Booleska värden, Typ: Ett område med booleska värden (TRUE eller FALSE)
Kommentar: Booleska värden, Typ: Ett område med booleska värden (TRUE eller FALSE)
Kommentar: Booleska värden, Typ: Ett område med booleska värden (TRUE eller FALSE)

Exempel

XOR(Falsk;Falsk;Falsk) returnerar Falsk

Exempel

XOR(Sant;Falskt) returnerar Sann

8.1.9 Uppslagning och referens

8.1.9.1 ADDRESS

ADDRESS skapar en celladress. Parametern rad är radnumret och kol är kolumnnumret.

Talet absolut anger referenstypen: 1 eller utelämnad = absolut, 2 = absolut rad, relativ kolumn, 3
= relativ rad, absolut kolumn och 4 = relativ.

A1-stil anger stilen för adressen som returneras. Om A1 är TRUE (förval) returneras adressen
med A1-stil. Om den är FALSE returneras adressen med R1C1-stil.
Arbetsbladsnamn är texten som anger namnet på bladet.

Returtyp: Text

Syntax

ADDRESS(rad; kol; absolut; stil; arbetsbladsnamn)
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Parametrar
Kommentar: Radnummer, Typ: Heltal (som 1, 132 eller 2344)
Kommentar: Kolumn-nummer, Typ: Heltal (som 1, 132 eller 2344)
Kommentar: Absolutvärde (valfritt), Typ: Heltal (som 1, 132 eller 2344)
Kommentar: A1-stil (valfri), Typ: Ett booleskt värde (TRUE eller FALSE)
Kommentar: Arbetsbladsnamn, Typ: Text

Exempel

ADDRESS(6; 4) returnerar $D$6

Exempel

ADDRESS(6; 4; 2) returnerar D$6

Exempel

ADDRESS(6; 4; 2; FALSE; ˝Blad1˝) returnerar Blad1!R6C[4]

Exempel

ADDRESS(6; 4; 1; FALSE; ˝Blad1˝) returnerar Blad1!R6C4

Exempel

ADDRESS(6; 4; 4; TRUE; ˝Blad1˝) returnerar Blad1!D6

8.1.9.2 AREAS

Returnerar antalet områden i referenssträngen. Ett område kan vara en enstaka cell eller ett antal
celler.
Returtyp: Heltal (som 1, 132 eller 2344)

Syntax

AREAS(referens)

Parametrar
Kommentar: Referens, Typ: Ett område med strängar

Exempel

AREAS(A1) returnerar 1

Exempel

AREAS((A1; A2:A4)) returnerar 2

8.1.9.3 CELL

Returnerar information om position, formatering eller innehåll i en referens.

Returtyp: Vilket värde som helst

Syntax

CELL(typ; referens)

Parametrar
Kommentar: Typ, Typ: Text
Kommentar: Referens, Typ: Referens
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Exempel

CELL(˝COL˝,C7) returnerar 3

Exempel

CELL(˝ROW˝, C7) returnerar 7

Exempel

CELL(˝ADDRESS˝, C7) returnerar $C$7

8.1.9.4 CHOOSE

Returnerar parametern som anges av index.

Returtyp: Vilket värde som helst

Syntax

CHOOSE(index; parameter1; parameter2; ...)

Parametrar
Kommentar: Index, Typ: Heltal (som 1, 132 eller 2344)
Kommentar: Argument, Typ:

Exempel

CHOOSE(1; ˝1:a˝; ˝2:a˝) returnerar ˝1:a˝

Exempel

CHOOSE(2; 3; 2; 4) returnerar 2

8.1.9.5 COLUMN

Funktionen COLUMN returnerar kolumnen för en given cellreferens. Om ingen parameter
anges, returneras kolumnen för den aktuella cellen.

Returtyp: Heltal (som 1, 132 eller 2344)

Syntax

COLUMN(referens)

Parametrar
Kommentar: Referens, Typ: Text

Exempel

COLUMN(A1) returnerar 1

Exempel

COLUMN(D2) returnerar 4

Liknande funktioner
COLUMNS
ROW
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8.1.9.6 COLUMNS

Funktionen COLUMNS() returnerar antal kolumner i en referens.

Returtyp: Heltal (som 1, 132 eller 2344)

Syntax

COLUMNS(referens)

Parametrar
Kommentar: Referens, Typ: Text

Exempel

COLUMNS(A1:C3) returnerar 3

Exempel

COLUMNS(D2) returnerar 1

Liknande funktioner
COLUMN
ROWS

8.1.9.7 HLOOKUP

Leta efter ett matchande värde i första raden av den angivna tabellen, och returnera värdet av
raden som hittas.
Slår upp ’uppslagningsvärde’ i den första raden av ’datakälla’. Om ett värde hittas, returneras
värdet i ’rad’ och den kolumn värdet hittades i. Om ’sorterad’ är sant (standardvärdet), antas
den första raden vara sorterad. Sökningen slutar om ’uppslagningsvärde’ är mindre än värdet
som jämförs med.

Returtyp: Sträng eller numerisk

Syntax

HLOOKUP(uppslagningsvärde; datakälla; rad; sorterad)

Parametrar
Kommentar: Uppslagningsvärde, Typ: Sträng eller numerisk
Kommentar: Datakälla, Typ: Fält
Kommentar: Rad, Typ: Heltal (som 1, 132 eller 2344)
Kommentar: Sorterad (valfritt), Typ: Ett booleskt värde (TRUE eller FALSE)

8.1.9.8 INDEX

Om ett intervall anges, returneras värdet lagrat i en given rad eller kolumn. Om en cell som
innehåller en lista anges, returneras ett element i listan.

Returtyp: Heltal (som 1, 132 eller 2344)

Syntax

INDEX(cell, rad, kolumn)

Parametrar
Kommentar: Referens, Typ: Text
Kommentar: Rad, Typ: Heltal (som 1, 132 eller 2344)
Kommentar: Kolumn, Typ: Heltal (som 1, 132 eller 2344)
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Exempel

INDEX(A1:C3;2;2), returnerar innehållet i B2

Exempel

INDEX(A1;2;2), om A1 är resultatet av en listberäkning returneras dess element (2,2).

8.1.9.9 INDIRECT

Returnerar innehållet i cellen som anges av referenstexten. Den andra parametern är valfri.

Returtyp: Heltal (som 1, 132 eller 2344)

Syntax

INDIRECT(referenstext, A1-stil)

Parametrar
Kommentar: Referens, Typ: Text
Kommentar: A1-stil (valfri), Typ: Ett booleskt värde (TRUE eller FALSE)

Exempel

INDIRECT(A1), A1 innehåller ˝B1˝, och B1 1 = > returnerar 1

Exempel

INDIRECT(˝A1˝), returnerar innehållet i A1

8.1.9.10 LOOKUP

Funktionen LOOKUP slår upp den första parametern i uppslagningsvektorn. Den returnerar ett
värde i resultatvektorn med samma index som det matchande värdet i uppslagningsvektorn.
Om värdet inte finns i uppslagningsvektorn tar den det närmsta mindre. Om inget värde i upp-
slagningsvektorn matchar returneras ett fel.Uppslagningsvektorn måste vara i stigande ordning
och uppslagnings- och resultatvektorn måste ha samma storlek. Numeriska värden, strängar och
Booleska värden känns igen. Jämförelse mellan strängar är skiftlägesokänsligt.

Returtyp: Heltal (som 1, 132 eller 2344)

Syntax

LOOKUP(värde; uppslagningsvektor; resultatvektor)

Parametrar
Kommentar: Uppslagningsvärde, Typ: Sträng eller numerisk
Kommentar: Uppslagningsvektor, Typ: Sträng eller numerisk
Kommentar: Resultatvektor, Typ: Sträng eller numerisk

Exempel

LOOKUP(1,232; A1:A6; B1:B6) för A1 = 1, A2 = 2 returnerar värdet på B1.
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8.1.9.11 MATCH

Hittar ett sökvärde i ett sökområde och returnerar dess position (med början på 1). Matchnings-
typ kan antingen vara -1, 0 eller 1, och bestämmer hur sökningen efter värdet görs. Om match-
ningstypen är 0, returneras index av det första värdet som är lika med sökvärdet. Om match-
ningstypen är 1 (eller utelämnas), returneras index av det första värdet som är mindre än eller
lika med sökvärdet. Om matchningstypen är -1, hittas det minsta värdet som är större än eller
lika med sökvärdet, och sökområdet måste vara sorterat i fallande ordning.

Returtyp: Heltal (som 1, 132 eller 2344)

Syntax

MATCH(Sökvärde; Sökområde; Matchningstyp)

Parametrar
Kommentar: Sökvärde, Typ: Sträng eller numerisk
Kommentar: Sökområde, Typ: Referens eller fält
Kommentar: Matchningstyp (valfri), Typ: Heltal (som 1, 132 eller 2344)

8.1.9.12 MULTIPLE.OPERATIONS

MULTIPLE.OPERATIONS utvärderar formeluttrycket som utpekas av Formelcell, och alla for-
meluttryck som den beror på medan alla referenser till Radcell ersätts med referenser till Rader-
sättning, och alla referenser till Kolumncell ersätts med referenser till Kolumnersättning. Funk-
tionen kan användas för att enkelt skapa tabeller med uttryck som beror på två inparametrar.

Returtyp: Sträng eller numerisk

Syntax

MULTIPLE.OPERATIONS(Formelcell; Radcell; Radersättning; Kolumncell; Kolumnersätt-
ning)

Parametrar
Kommentar: Formelcell, Typ: Referens
Kommentar: Radcell, Typ: Referens
Kommentar: Radersättning, Typ: Referens
Kommentar: Kolumncell (valfri), Typ: Referens
Kommentar: Kolumnersättning (valfri), Typ: Referens

8.1.9.13 OFFSET

Ändrar position och dimension hos en referens.

Returtyp: Referens

Syntax

OFFSET(Reference referens; Integer radförskjutning; Integer kolumnförskjutning; Integer
ny-höjd; Integer ny-bredd)

Parametrar
Kommentar: Referens eller intervall, Typ: Referens
Kommentar: Antal rader att förskjuta, Typ: Heltal (som 1, 132 eller 2344)
Kommentar: Antal kolumner att förskjuta, Typ: Heltal (som 1, 132 eller 2344)
Kommentar: Förskjutningsintervallets höjd (valfri), Typ: Heltal (som 1, 132 eller 2344)
Kommentar: Förskjutningsintervallets bredd (alternativ), Typ: Heltal (som 1, 132 eller 2344)
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8.1.9.14 ROW

Funktionen ROW() returnerar raden för en given cellreferens. Om ingen parameter anges, retur-
neras raden för den aktuella cellen.
Returtyp: Heltal (som 1, 132 eller 2344)

Syntax

ROW(referens)

Parametrar
Kommentar: Referens, Typ: Text

Exempel

ROW(A1) returnerar 1

Exempel

ROW(D2) returnerar 2

Liknande funktioner
ROWS
COLUMN

8.1.9.15 ROWS

Funktionen ROWS() returnerar antal rader i en referens.

Returtyp: Heltal (som 1, 132 eller 2344)

Syntax

ROWS(referens)

Parametrar
Kommentar: Referens, Typ: Text

Exempel

ROWS(A1:C3) returnerar 3

Exempel

ROWS(D2) returnerar 1

Liknande funktioner
ROW
COLUMNS

8.1.9.16 SHEET

Returnerar referensens sidnummer eller strängen som representerar sidans namn.

Returtyp: Heltal (som 1, 132 eller 2344)

Syntax

SHEET(referens)
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Parametrar
Kommentar: Referens, Typ: Referens

Exempel

SHEET(Blad1!C7) returnerar 1

Exempel

SHEET(Blad2!C7) returnerar 2

8.1.9.17 SHEETS

Returnerar antal blad i en referens eller nuvarande dokument.
Returtyp: Heltal (som 1, 132 eller 2344)

Syntax

SHEETS(referens)

Parametrar
Kommentar: Referens, Typ: Referens

8.1.9.18 VLOOKUP

Leta efter ett matchande värde i första kolumnen av den angivna tabellen, och returnera värdet
av kolumnen som hittas.
Slår upp ’uppslagningsvärde’ i den första kolumnen av ’datakälla’. Om ett värde hittas, retur-
neras värdet i ’kolumn’ och den rad värdet hittades i. Om ’sorterad’ är sant (standardvärdet),
antas den första kolumnen vara sorterad. Sökningen slutar om ’uppslagningsvärde’ är mindre
än värdet som jämförs med.

Returtyp: Sträng eller numerisk

Syntax

VLOOKUP(uppslagningsvärde; datakälla; kolumn; sorterad)

Parametrar
Kommentar: Uppslagningsvärde, Typ: Sträng eller numerisk
Kommentar: Datakälla, Typ: Fält
Kommentar: Kolumn, Typ: Heltal (som 1, 132 eller 2344)
Kommentar: Sorterad (valfritt), Typ: Ett booleskt värde (TRUE eller FALSE)

8.1.10 Matematik

8.1.10.1 ABS

Funktionen ABS() returnerar absolutvärdet av flyttalet x.

Returtyp: Flyttal (som 1,3, 0,343 eller 253)

Syntax

ABS(x)

Parametrar
Kommentar: Ett flyttalsvärde, Typ: Flyttal (som 1,3, 0,343 eller 253)
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Exempel

ABS(12,5) är lika med 12,5

Exempel

ABS(-12,5) är lika med 12,5

8.1.10.2 CEIL

Funktionen CEIL() avrundar x uppåt till närmaste heltal som är större än indata, och returnerat
värdet som ett dubbelt flyttal.

Returtyp: Ett heltal (som 0, -5, 14)

Syntax

CEIL(x)

Parametrar
Kommentar: Ett flyttalsvärde, Typ: Flyttal (som 1,3, 0,343 eller 253)

Exempel

CEIL(12,5) är lika med 13

Exempel

CEIL(-12,5) är lika med -12

Liknande funktioner
CEILING
FLOOR
ROUND
ROUNDUP

8.1.10.3 CEILING

Funktionen CEILING() avrundar x uppåt (från noll) till närmaste multipel av signifikansen. Stan-
dardvärdet för signifikansen är 1 (eller -1 om värdet är negativt), vilket betyder avrundning uppåt
till närmsta heltal. Om parametern Läge inte är noll, avrundar funktionen från noll, istället uppåt
till positiv oändlighet.

Returtyp: Ett heltal (som 0, -5, 14)

Syntax

CEILING(x)

Parametrar
Kommentar: Ett flyttalsvärde, Typ: Flyttal (som 1,3, 0,343 eller 253)
Kommentar: Signifikans (valfri), Typ: Flyttal (som 1,3, 0,343 eller 253)
Kommentar: Läge (valfritt), Typ: Flyttal (som 1,3, 0,343 eller 253)

Exempel

CEILING(12,5) är lika med 13

Exempel

CEILING(6,43; 4) är lika med 8
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Exempel
CEILING(-6,43; -4; 1) är lika med -8

Exempel
CEILING(-6,43; -4; 0) är lika med -4

Liknande funktioner
CEIL
FLOOR
ROUND
ROUNDUP

8.1.10.4 COUNT

Funktionen returnerar antalet heltals- eller flyttalsparametrar som skickas till den. Du kan räkna
med ett intervall, COUNT(A1:B5), eller en lista av värden, COUNT(12;5;12,5).
Returtyp: Flyttal (som 1,3, 0,343 eller 253)

Syntax
COUNT(värde;värde;värde...)

Parametrar
Kommentar: Värden, Typ: FLOAT

Exempel
COUNT(-5;˝kspread˝;2) returnerar 2

Exempel
COUNT(5) returnerar 1

Liknande funktioner
COUNTA
COUNTIF
SUM

8.1.10.5 COUNTA

Funktionen returnerar antalet parametrar som inte är tomma som skickas till den. Du kan räkna
med ett intervall, COUNTA(A1:B5), eller en lista av värden, COUNTA(12;5;12,5).
Returtyp: Flyttal (som 1,3, 0,343 eller 253)

Syntax
COUNTA(värde;värde;värde...)

Parametrar
Kommentar: Värden, Typ: FLOAT

Exempel
COUNTA(-5;˝kspread˝;2) returnerar 3

Exempel
COUNTA(5) returnerar 1

Liknande funktioner
COUNT
COUNTIF
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8.1.10.6 COUNTBLANK

Den här funktionen returnerar antalet tomma celler i området.
Returtyp: Flyttal (som 1,3, 0,343 eller 253)

Syntax
COUNTBLANK(område)

Parametrar
Kommentar: Cellområde, Typ: Intervall

Exempel
COUNTBLANK(A1:B5)

Liknande funktioner
COUNT
COUNTA
COUNTIF

8.1.10.7 COUNTIF

Funktionen COUNTIF() returnerar antalet celler i det angivna området som uppfyller angivet
villkor.
Returtyp: Heltal (som 1, 132 eller 2344)

Syntax
COUNTIF(område;villkor)

Parametrar
Kommentar: Intervall, Typ: Ett område med flyttalsvärden (som 1,3; 0,343 eller 253 )
Kommentar: Kriterier, Typ: Text

Exempel
COUNTIF(A2:A3;˝14˝) returnerar 1 om A2 är -4 och A3 är 14

Liknande funktioner
COUNT
SUMIF

8.1.10.8 CUR

Funktionen CUR(x) returnerar den ickenegativa tredje roten ur x.

Returtyp: Flyttal (som 1,3, 0,343 eller 253)

Syntax
CUR(x)

Parametrar
Kommentar: Ett flyttalsvärde, Typ: Flyttal (som 1,3, 0,343 eller 253)

Exempel
CUR(27) är lika med 3

Liknande funktioner
SQRT
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8.1.10.9 DIV

Funktionen DIV() dividerar det första värdet med övriga värden i tur och ordning.

Returtyp: Flyttal (som 1,3, 0,343 eller 253)

Syntax

DIV(värde;värde;...)

Parametrar
Kommentar: Värden, Typ: FLOAT

Exempel

DIV(20;2;2) returnerar 5

Exempel

DIV(25;2,5) returnerar 10

Liknande funktioner
MULTIPLY
MOD

8.1.10.10 EPS

EPS() returnerar datorns epsilon. Det här är skillnaden mellan 1 och det närmast större flyttalet.
Eftersom datorer använder ett ändligt antal siffror, är avrundningsfel ofrånkomliga (men oftast
utan betydelse) för alla beräkningar.

Returtyp: Flyttal (som 1,3, 0,343 eller 253)

Syntax

EPS()

Parametrar

Exempel

På de flesta system, returnerar det här 2ˆ-52 = 2,2204460492503131e-16

Exempel

0,5*EPS() returnerar ˝enhetsavrundningen˝. Det här värdet är intressant eftersom det är
det största talet x, där (1+x) - 1 = 0 (på grund av avrundningsfel).

Exempel

EPS() är så litet att Calligra Sheets visar 1 + eps() som 1

Exempel

Välj ett tal x mellan 0 och EPS(). Observera att 1 + x antingen avrundar x till 0 eller EPS()
genom att använda ekvationen (1+x) - 1
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8.1.10.11 EVEN

Funktionen EVEN() returnerar talet avrundat till närmast större (till absolutvärde) jämna heltal.

Returtyp: Flyttal (som 1,3, 0,343 eller 253)

Syntax
EVEN(värde)

Parametrar
Kommentar: Flyttalsvärde, Typ: Flyttal (som 1,3, 0,343 eller 253)

Exempel
EVEN(1,2) returnerar 2

Exempel
EVEN(2) returnerar 2

Liknande funktioner
ODD

8.1.10.12 EXP

Funktionen EXP(x) returnerar värdet e (basen för naturliga logaritmer) upphöjt till x.

Returtyp: Flyttal (som 1,3, 0,343 eller 253)

Syntax
EXP(x)

Parametrar
Kommentar: Ett flyttalsvärde, Typ: Flyttal (som 1,3, 0,343 eller 253)

Exempel
EXP(9) är lika med 8 103,08392758

Exempel
EXP(-9) är lika med 0,00012341

Liknande funktioner
LN

8.1.10.13 FACT

Funktionen FACT() beräknar fakulteten av parametern. Det matematiska uttrycket är (värde).

Returtyp: Flyttal (som 1,3, 0,343 eller 253)

Syntax
FACT(tal)

Parametrar
Kommentar: Ett flyttalsvärde, Typ: Flyttal (som 1,3, 0,343 eller 253)

Exempel
FACT(10) returnerar 3628800

Exempel
FACT(0) returnerar 1
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8.1.10.14 FACTDOUBLE

Funktionen FACTDOUBLE() beräknar dubbla fakulteten av ett tal, dvs. x!!.

Returtyp: Flyttal (som 1,3, 0,343 eller 253)

Syntax

FACTDOUBLE(tal)

Parametrar
Kommentar: Ett flyttalsvärde, Typ: Flyttal (som 1,3, 0,343 eller 253)

Exempel

FACTDOUBLE(6) returnerar 48

Exempel

FACTDOUBLE(7) returnerar 105

8.1.10.15 FIB

Funktionen FIB beräknar N:e termen i en Fibonacci-följd (1, 1, 2, 3, 5, 8, 13, 21...), där varje tal
efter de två första, är summan av de omedelbart föregående två talen. FIB(0) definieras som 0.

Returtyp: Flyttal (som 1,3, 0,343 eller 253)

Syntax

FIB(n)

Parametrar
Kommentar: N.e termen, Typ: Flyttal (som 1,3, 0,343 eller 253)

Exempel

FIB(9) returnerar 34

Exempel

FIB(26) returnerar 121393

8.1.10.16 FLOOR

Avrunda talet X neråt till närmaste multipel av den andra parametern, Signifikans.

Funktionen FLOOR() avrundar x neråt (mot noll) till närmaste multipel av Signifikans. Normal-
värdet för Signifikans är 1, om X är positivt. Det är -1, om X är negativt, vilket betyder avrundning
uppåt till närmaste heltal. Om läge anges och är skilt från noll, avrundas X-värdet mot noll till en
multipel av Signifikans och därefter läggs tecknet till. Annars avrundas mot negativ oändlighet.
Om någon av de två parametrarna X eller Signifikans är noll, är resultatet noll.

Returtyp: Ett heltal (som 0, -5, 14)

Syntax

FLOOR(x)

Parametrar
Kommentar: Ett flyttalsvärde, Typ: Flyttal (som 1,3, 0,343 eller 253)
Kommentar: Signifikans (valfri), Typ: Flyttal (som 1,3, 0,343 eller 253)
Kommentar: Läge (valfritt), Typ: Flyttal (som 1,3, 0,343 eller 253)
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Exempel

FLOOR(12,5) är lika med 12

Exempel

FLOOR(-12,5) är lika med -13

Exempel

FLOOR(5; 2) är lika med 4

Exempel

FLOOR(5; 2,2) är lika med 4,4

Liknande funktioner
CEIL
CEILING
ROUND
ROUNDDOWN

8.1.10.17 GAMMA

Funktionen GAMMA() returnerar gammafunktionens värde.

Returtyp: Flyttal (som 1,3, 0,343 eller 253)

Syntax

GAMMA(värde)

Parametrar
Kommentar: Flyttalsvärde, Typ: Flyttal (som 1,3, 0,343 eller 253)

Exempel

GAMMA(1) returnerar 1

Liknande funktioner
FACT

8.1.10.18 GCD

Funktionen GCD() returnerar den största gemensamma nämnaren för två eller flera heltal.

Returtyp: Heltal (som 1, 132 eller 2344)

Syntax

GCD(värde; värde)

Parametrar
Kommentar: Första talet, Typ: Ett område med heltal (som 1, 132 eller 2344)
Kommentar: Andra talet, Typ: Ett område med heltal (som 1, 132 eller 2344)
Kommentar: Tredje talet, Typ: Ett område med heltal (som 1, 132 eller 2344)

Exempel

GCD(6;4) returnerar 2

Exempel

GCD(10;20) returnerar 10
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Exempel

GCD(20;15;10) returnerar 5

Liknande funktioner
LCM

8.1.10.19 G_PRODUCT

Funktionen G_PRODUCT() är samma som KPRODUCT. Den tillhandahålls för kompatibilitet
med Gnumeric.
Returtyp: Flyttal (som 1,3, 0,343 eller 253)

Syntax

G_PRODUCT(värde;värde;...)

Parametrar
Kommentar: Värden, Typ: FLOAT

Liknande funktioner
KPRODUCT

8.1.10.20 INT

Funktionen INT() returnerar heltalsdelen av värdet.

Returtyp: Heltal (som 1, 132 eller 2344)

Syntax

INT(x)

Parametrar
Kommentar: Ett flyttalsvärde, Typ: Flyttal (som 1,3, 0,343 eller 253)

Exempel

INT(12,55) är lika med 12

Exempel

INT(15) är lika med 15

Liknande funktioner
FLOOR
QUOTIENT

8.1.10.21 INV

Funktionen multiplicerar varje värde med -1.

Returtyp: Flyttal (som 1,3, 0,343 eller 253)

Syntax

INV(värde)
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Parametrar
Kommentar: Flyttalsvärde, Typ: Flyttal (som 1,3, 0,343 eller 253)

Exempel

INV(-5) är lika med 5

Exempel

INV(5) är lika med -5

Exempel

INV(0) är lika med -0

8.1.10.22 KPRODUCT

Funktionen KPRODUCT() beräknar produkten av alla parametervärdena. Du kan beräkna pro-
dukten av ett intervall, KPRODUCT(A1:B5), eller en lista av värden, KPRODUCT(12;5;12,5). Om
inga numeriska värden hittas, returneras 1.

Returtyp: Flyttal (som 1,3, 0,343 eller 253)

Syntax

KPRODUCT(värde;värde;...)

Parametrar
Kommentar: Värden, Typ: FLOAT

Exempel

KPRODUCT(3;5;7) är lika med 105

Exempel

KPRODUCT(12,5;2) är lika med 25

Liknande funktioner
G_PRODUCT
MULTIPLY
PRODUCT

8.1.10.23 LCM

Funktionen LCM() returnerar den minsta gemensamma multipeln av två eller flera flyttal

Returtyp: Flyttal (som 1,3, 0,343 eller 253)

Syntax

LCM(värde; värde)

Parametrar
Kommentar: Första talet, Typ: FLOAT
Kommentar: Andra talet, Typ: FLOAT

Exempel

LCM(6;4) returnerar 12

Exempel

LCM(1,5;2,25) returnerar 4,5
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Exempel

LCM(2;3;4) returnerar 12

Liknande funktioner
GCD

8.1.10.24 LN

Funktionen LN() returnerar den naturliga logaritmen av x.

Returtyp: Flyttal (som 1,3, 0,343 eller 253)

Syntax

LN(x)

Parametrar
Kommentar: Ett flyttalsvärde, Typ: Flyttal (som 1,3, 0,343 eller 253)

Exempel

LN(0,8) är lika med -0,22314355

Exempel

LN(0) är lika med -inf

Liknande funktioner
LOG
LOG10
LOG2

8.1.10.25 LOG

Funktionen LOG(x) returnerar logaritmen med bas 10 av x.

Returtyp: Flyttal (som 1,3, 0,343 eller 253)

Syntax

LOG(x)

Parametrar
Kommentar: Ett flyttalsvärde större än noll, Typ: Flyttal (som 1,3, 0,343 eller 253)

Exempel

LOG(0,8) är lika med -0,09691001

Exempel

LOG(0) är felaktigt.

Liknande funktioner
LN
LOGN
LOG10
LOG2
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8.1.10.26 LOG10

Funktionen LOG10() returnerar logaritmen med bas 10 av argumentet.

Returtyp: Flyttal (som 1,3, 0,343 eller 253)

Syntax

LOG10(x)

Parametrar
Kommentar: Ett positivt flyttal, Typ: Flyttal (som 1,3, 0,343 eller 253)

Exempel

LOG10(10) är lika med 1.

Exempel

LOG10(0) är felaktigt.

Liknande funktioner
LN
LOGN
LOG
LOG2

8.1.10.27 LOG2

Funktionen LOG2(x) returnerar bas 2 logaritmen av x.

Returtyp: Flyttal (som 1,3, 0,343 eller 253)

Syntax

LOG2(x)

Parametrar
Kommentar: Ett flyttalsvärde, Typ: Flyttal (som 1,3, 0,343 eller 253)

Exempel

LOG2(0,8) är lika med -0,32192809

Exempel

LOG2(0) är lika med -inf.

Liknande funktioner
LN
LOGN
LOG
LOG10
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8.1.10.28 LOGN

Funktionen LOGn(x;n) returnerar bas-n logaritmen av x.

Returtyp: Flyttal (som 1,3, 0,343 eller 253)

Syntax

LOGn(värde;bas)

Parametrar
Kommentar: Ett flyttalsvärde, Typ: Flyttal (som 1,3, 0,343 eller 253)
Kommentar: Bas, Typ: Flyttal (som 1,3, 0,343 eller 253)

Exempel

LOGn(12;10) är lika med 1,07918125

Exempel

LOGn(12;2) är lika med 3,5849625

Liknande funktioner
LOG
LN
LOG10
LOG2

8.1.10.29 MAX

Funktionen MAX() returnerar det största av parametervärdena. Strängar och logiska värden ig-
noreras.
Returtyp: Flyttal (som 1,3, 0,343 eller 253)

Syntax

MAX(värde;värde;...)

Parametrar
Kommentar: Värden, Typ: FLOAT

Exempel

MAX(12;5;7) returnerar 12

Exempel

MAX(12,5;2) returnerar 12,5

Exempel

MAX(0,5; 0,4; TRUE; 0,2) returnerar 0,5

Liknande funktioner
COUNT
COUNTA
MAXA
MIN
MINA
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8.1.10.30 MAXA

Funktionen MAXA() returnerar det största av parametervärdena. TRUE utvärderas som 1, FAL-
SE som 0. Strängvärden ignoreras.

Returtyp: Flyttal (som 1,3, 0,343 eller 253)

Syntax

MAXA(värde;värde;...)

Parametrar
Kommentar: Värden, Typ: FLOAT

Exempel

MAXA(12;5;7) returnerar 12

Exempel

MAXA(12,5;2) returnerar 12,5

Exempel

MAXA(0,5; 0,4; TRUE; 0,2) returnerar 1

Liknande funktioner
COUNT
COUNTA
MAX
MIN
MINA

8.1.10.31 MDETERM

Funktionen MDETERM returnerar den givna matrisens determinant. Matrisen måste ha typen n
x n.
Returtyp: Flyttal (som 1,3, 0,343 eller 253)

Syntax

MDETERM(matris)

Parametrar
Kommentar: Intervall, Typ: Ett område med flyttalsvärden (som 1,3; 0,343 eller 253 )

Exempel

MDETERM(A1:C3)

Liknande funktioner
MMULT
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8.1.10.32 MIN

Funktionen MIN() returnerar det minsta av parametervärdena. Stängar och logiska värden igno-
reras.
Returtyp: Flyttal (som 1,3, 0,343 eller 253)

Syntax

MIN(värde;värde;...)

Parametrar
Kommentar: Värden, Typ: FLOAT

Exempel

MIN(12;5;7) returnerar 5

Exempel

MIN(12,5; 2) returnerar 2

Exempel

MIN(0,4; 2; FALSE; 0,7) returnerar 0,4

Liknande funktioner
COUNT
COUNTA
MAX
MAXA
MINA

8.1.10.33 MINA

Funktionen MINA() returnerar det minsta av parametervärdena. TRUE utvärderas som 1, FALSE
som 0. Strängvärden ignoreras.

Returtyp: Flyttal (som 1,3, 0,343 eller 253)

Syntax

MINA(värde;värde;...)

Parametrar
Kommentar: Värden, Typ: FLOAT

Exempel

MINA(12;5;7) returnerar 5

Exempel

MINA(12,5; 2) returnerar 2

Exempel

MIN(0,4; 2; FALSE; 0,7) returnerar 0.

Liknande funktioner
COUNT
COUNTA
MAX
MAXA
MIN
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8.1.10.34 MINVERSE

Beräknar matrisens invers.
Matrisen multiplicerad med sin invers ger enhetsmatrisen av samma dimension som resultat.

Matriser som kan inverteras har en determinant skild från noll.
Returtyp: Ett område med flyttalsvärden (som 1,3; 0,343 eller 253 )

Syntax

MINVERSE(matris)

Parametrar
Kommentar: Matris, Typ: Ett område med flyttalsvärden (som 1,3; 0,343 eller 253 )

Exempel

MINVERSE(A1:C3)

Liknande funktioner
MDETERM
MUNIT

8.1.10.35 MMULT

Funktionen MMULT multiplicerar två matriser. Antal kolumner i den första matrisen måste vara
samma som antal rader i den andra. Resultatet är en matris.
Returtyp: Ett område med flyttalsvärden (som 1,3; 0,343 eller 253 )

Syntax

MMULT(matris1;matris2)

Parametrar
Kommentar: Första matrisen, Typ: Ett område med flyttalsvärden (som 1,3; 0,343 eller 253 )
Kommentar: Andra matrisen, Typ: Ett område med flyttalsvärden (som 1,3; 0,343 eller 253 )

Exempel

MMULT(A1:C3)

Liknande funktioner
MDETERM

8.1.10.36 MOD

Funktionen MOD() returnerar resten efter en division. Om den andra parametern är noll retur-
neras #DIV/0.

Returtyp: Heltal (som 1, 132 eller 2344)

Syntax

MOD(värde;värde)

Parametrar
Kommentar: Flyttalsvärde, Typ: Heltal (som 1, 132 eller 2344)
Kommentar: Flyttalsvärde, Typ: Heltal (som 1, 132 eller 2344)
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Exempel

MOD(12;5) returnerar 2

Exempel

MOD(5;5) returnerar 0

Liknande funktioner
DIV

8.1.10.37 MROUND

Funktionen MROUND() returnerar värdet avrundat till den angivna multipeln. Värdet och mul-
tipeln måste ha samma tecken.

Returtyp: Flyttal (som 1,3, 0,343 eller 253)

Syntax

MROUND(värde; multipel)

Parametrar
Kommentar: Flyttalsvärde, Typ: Flyttal (som 1,3, 0,343 eller 253)
Kommentar: Multipel, Typ: Flyttal (som 1,3, 0,343 eller 253)

Exempel

MROUND(1,252; 0,5) är lika med 1,5

Exempel

MROUND(-1,252;-0,5) är lika med -1,5

Liknande funktioner
ROUND

8.1.10.38 MULTINOMIAL

Funktionen MULTINOMIAL() returnera multinominalvärdet för alla tal i parametrarna. Den an-
vänder den här formeln för MULTINOMIAL(a,b,c):

(a+b+c)! / a!b!c!

Returtyp: Flyttal (som 1,3, 0,343 eller 253)

Syntax

MULTINOMIAL(värde;värde;...)

Parametrar
Kommentar: Värden, Typ: FLOAT

Exempel

MULTINOMIAL(3;4;5) är lika med 27720
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8.1.10.39 MULTIPLY

Funktionen MULTIPLY() multiplicerar alla parametervärdena. Du kan multiplicera ett värden
givna av ett intervall, MULTIPLY(A1:B5), eller en lista av värden som MULTIPLY(12;5;12,5). Den
är ekvivalent med PRODUCT.
Returtyp: Flyttal (som 1,3, 0,343 eller 253)

Syntax

MULTIPLY(värde;värde;...)

Parametrar
Kommentar: Värden, Typ: FLOAT

Exempel

MULTIPLY(12;5;7) är lika med 420

Exempel

MULTIPLY(12,5;2) är lika med 25

Liknande funktioner
DIV
PRODUCT
KPRODUCT

8.1.10.40 MUNIT

Skapar enhetsmatrisen av den givna dimensionen.

Returtyp: Ett område med flyttalsvärden (som 1,3; 0,343 eller 253 )

Syntax

MUNIT(dimension)

Parametrar
Kommentar: Dimensioner, Typ: Heltal (som 1, 132 eller 2344)

Exempel

MUNIT(3) skapar en 3x3 enhetsmatris

Liknande funktioner
MINVERSE

8.1.10.41 ODD

Funktionen ODD() returnerar värdet avrundat uppåt (eller neråt för negativa värden) till närmast
udda heltal. Definitionsmässigt är ODD(0) lika med 1.

Returtyp: Flyttal (som 1,3, 0,343 eller 253)

Syntax

ODD(värde)

Parametrar
Kommentar: Flyttalsvärde, Typ: Flyttal (som 1,3, 0,343 eller 253)
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Exempel

ODD(1,2) returnerar 3

Exempel

ODD(2) returnerar 3

Exempel

ODD(-2) returnerar -3

Liknande funktioner
EVEN

8.1.10.42 POW

Funktionen POW(x;y) returnerar värdet av x upphöjt till y. Den är samma sak som POWER.

Returtyp: Flyttal (som 1,3, 0,343 eller 253)

Syntax

POW(värde;värde)

Parametrar
Kommentar: Flyttalsvärde, Typ: Flyttal (som 1,3, 0,343 eller 253)
Kommentar: Flyttalsvärde, Typ: Flyttal (som 1,3, 0,343 eller 253)

Exempel

POW(1,2;3,4) är lika med 1,8572

Exempel

POW(2;3) är lika med 8

Liknande funktioner
POWER

8.1.10.43 POWER

Funktionen POWER(x;y) returnerar värdet av x upphöjt till y.

Returtyp: Flyttal (som 1,3, 0,343 eller 253)

Syntax

POWER(värde;värde)

Parametrar
Kommentar: Flyttalsvärde, Typ: Flyttal (som 1,3, 0,343 eller 253)
Kommentar: Flyttalsvärde, Typ: Flyttal (som 1,3, 0,343 eller 253)

Exempel

POWER(1,2;3,4) är lika med 1,8572

Exempel

POWER(2;3) är lika med 8

Liknande funktioner
POW

171



Handbok Calligra Sheets

8.1.10.44 PRODUCT

Funktionen PRODUCT() beräknar produkten av alla parametervärdena. Du kan beräkna pro-
dukten av ett intervall, PRODUCT(A1:B5), eller en lista av värden, PRODUCT(12;5;12,5). Om
inga numeriska värden hittas, returneras 0.

Returtyp: Flyttal (som 1,3, 0,343 eller 253)

Syntax
PRODUCT(värde;värde;...)

Parametrar
Kommentar: Värden, Typ: FLOAT

Exempel
PRODUCT(3;5;7) är lika med 105

Exempel
PRODUCT(12,5;2) är lika med 25

Liknande funktioner
MULTIPLY
KPRODUCT

8.1.10.45 QUOTIENT

Funktionen QUOTIENT returnerar heltalsdelen av täljare/nämnare.

Returtyp: Heltal (som 1, 132 eller 2344)

Syntax
QUOTIENT(täljare;nämnare)

Parametrar
Kommentar: Nämnare, Typ: Flyttal (som 1,3, 0,343 eller 253)
Kommentar: Nämnare, Typ: Flyttal (som 1,3, 0,343 eller 253)

Exempel
QUOTIENT(21;4) returnerar 5

Liknande funktioner
INT

8.1.10.46 RAND

Funktionen RAND() returnerar ett pseudoslumptal mellan 0 och 1.

Returtyp: Flyttal (som 1,3, 0,343 eller 253)

Syntax
RAND()

Parametrar

Exempel
RAND() kan till exempel vara lika med 0,78309922...

Liknande funktioner
RANDBETWEEN
RANDEXP
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8.1.10.47 RANDBERNOULLI

Funktionen RANDBERNOULLI() returnerar ett Bernoullifördelat slumptal.

Returtyp: Flyttal (som 1,3, 0,343 eller 253)

Syntax
RANDBERNOULLI(x)

Parametrar
Kommentar: Ett flyttalsvärde (mellan 0 och 1), Typ: Flyttal (som 1,3, 0,343 eller 253)
Kommentar: Ett flyttalsvärde, Typ: Flyttal (som 1,3, 0,343 eller 253)

Exempel
RANDBERNOULLI(0,45)

Liknande funktioner
RAND

8.1.10.48 RANDBETWEEN

Funktionen RANDBETWEEN() returnerar ett pseudoslumptal mellan den undre och övre grän-
sen. Om undre gräns är större än övre gräns returneras Fel.

Returtyp: Flyttal (som 1,3, 0,343 eller 253)

Syntax
RANDBETWEEN(undre;övre)

Parametrar
Kommentar: Undre gräns, Typ: Heltal (som 1, 132 eller 2344)
Kommentar: Övre gräns, Typ: Heltal (som 1, 132 eller 2344)

Exempel
RANDBETWEEN(12;78) kan till exempel vara lika med 61,0811...

Liknande funktioner
RAND

8.1.10.49 RANDBINOM

Funktionen RANDBINOM() returnerar ett binomialfördelat slumptal.

Returtyp: Flyttal (som 1,3, 0,343 eller 253)

Syntax
RANDBINOM(x)

Parametrar
Kommentar: Ett flyttalsvärde (mellan 0 och 1), Typ: Flyttal (som 1,3, 0,343 eller 253)
Kommentar: Försök (större än 0), Typ: Heltal (som 1, 132 eller 2344)

Exempel
RANDBINOM(4)

Liknande funktioner
RAND
RANDNEGBINOM
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8.1.10.50 RANDEXP

Funktionen RANDEXP() returnerar ett exponentialfördelat pseudoslumptal.

Returtyp: Flyttal (som 1,3, 0,343 eller 253)

Syntax

RANDEXP(x)

Parametrar
Kommentar: Ett flyttalsvärde (större än 0), Typ: Flyttal (som 1,3, 0,343 eller 253)

Exempel

RANDEXP(0,88)

Liknande funktioner
RAND

8.1.10.51 RANDNEGBINOM

Funktionen RANDNEGBINOM() returnerar ett negativt binomialfördelat pseudoslumptal.

Returtyp: Flyttal (som 1,3, 0,343 eller 253)

Syntax

RANDNEGBINOM(x)

Parametrar
Kommentar: Ett flyttalsvärde (mellan 0 och 1), Typ: Flyttal (som 1,3, 0,343 eller 253)
Kommentar: Misslyckade (större än 0), Typ: Heltal (som 1, 132 eller 2344)

Exempel

RANDNEGBINOM(4)

Liknande funktioner
RAND
RANDBINOM

8.1.10.52 RANDNORM

Funktionen RANDNORM() returnerar ett normalfördelat (Gaussiskt) slumptal.

Returtyp: Flyttal (som 1,3, 0,343 eller 253)

Syntax

RANDNORM(my; sigma)

Parametrar
Kommentar: Normalfördelningens medelvärde, Typ: Flyttal (som 1,3, 0,343 eller 253)
Kommentar: Normalfördelningens standardavvikelse, Typ: Flyttal (som 1,3, 0,343 eller 253)

Exempel

RANDNORM(0; 1)

Liknande funktioner
RAND
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8.1.10.53 RANDPOISSON

Funktionen RANDPOISSON() returnerar ett Poissonfördelat pseudoslumptal.

Returtyp: Flyttal (som 1,3, 0,343 eller 253)

Syntax

RANDPOISSON(x)

Parametrar
Kommentar: Ett flyttalsvärde (större än 0), Typ: Flyttal (som 1,3, 0,343 eller 253)
Kommentar: Ett flyttalsvärde, Typ: Flyttal (som 1,3, 0,343 eller 253)

Exempel

RANDPOISSON(4)

Liknande funktioner
RAND

8.1.10.54 ROOTN

Funktionen ROOTN() returnerar den ickenegativa n:te roten ur x.

Returtyp: Flyttal (som 1,3, 0,343 eller 253)

Syntax

ROOTN(x;n)

Parametrar
Kommentar: Ett flyttalsvärde, Typ: Flyttal (som 1,3, 0,343 eller 253)
Kommentar: Värde, Typ: Heltal (som 1, 132 eller 2344)

Exempel

ROOTN(9;2) är lika med 3

Liknande funktioner
SQRT

8.1.10.55 ROUND

Funktionen ROUND(värde[;siffror]) avrundar värdet. Siffror anger antalet siffror som du vill
avrunda värdet till. Om siffror är noll eller inte anges, avrundas värdet uppåt till närmsta heltal.
Om siffror är mindre än noll, så avrundas motsvarande heltalsdel av värdet.

Returtyp: Flyttal (som 1,3, 0,343 eller 253)

Syntax

ROUND(värde[;siffror])

Parametrar
Kommentar: Flyttalsvärde, Typ: Flyttal (som 1,3, 0,343 eller 253)
Kommentar: Decimaler, Typ: Heltal (som 1, 132 eller 2344)

Exempel

ROUND(1,252;2) är lika med 1,25
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Exempel

ROUND(-1,252;2) är lika med -1,25

Exempel

ROUND(1,258;2) är lika med 1,26

Exempel

ROUND(-12,25;-1) är lika med -10

Exempel

ROUND(-1,252;0) är lika med -1

Liknande funktioner
MROUND
ROUNDDOWN
ROUNDUP

8.1.10.56 ROUNDDOWN

Funktionen ROUNDDOWN(värde[;decimaler]) returnerar värdet avrundat så att dess absolut-
värde är mindre. Decimaler är det antal siffror som du vill avrunda talet. Om Decimaler är noll
eller inte anges, avrundas värdet neråt till närmsta heltal.

Returtyp: Flyttal (som 1,3, 0,343 eller 253)

Syntax

ROUNDDOWN(värde[;decimaler])

Parametrar
Kommentar: Flyttalsvärde, Typ: Flyttal (som 1,3, 0,343 eller 253)
Kommentar: Decimaler, Typ: Heltal (som 1, 132 eller 2344)

Exempel

ROUNDDOWN(1.252) är lika med 1

Exempel

ROUNDDOWN(1,252;2) är lika med 1,25

Exempel

ROUNDDOWN(-1.252;2) är lika med -1.25

Exempel

ROUNDDOWN(-1.252) är lika med -1

Liknande funktioner
ROUND
ROUNDUP
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8.1.10.57 ROUNDUP

Funktionen ROUNDUP(värde[;decimaler]) returnerar värdet avrundat så att dess absolutvärde
är större. Decimaler är det antal siffror som du vill avrunda talet. Om Decimaler är noll eller inte
anges, avrundas värdet uppåt till närmsta heltal.

Returtyp: Flyttal (som 1,3, 0,343 eller 253)

Syntax

ROUNDUP(värde[;decimaler])

Parametrar
Kommentar: Flyttalsvärde, Typ: Flyttal (som 1,3, 0,343 eller 253)
Kommentar: Decimaler, Typ: Heltal (som 1, 132 eller 2344)

Exempel

ROUNDUP(1.252) är lika med 2

Exempel

ROUNDUP(1,252;2) är lika med 1,26

Exempel

ROUNDUP(-1.252;2) är lika med -1.26

Exempel

ROUNDUP(-1.252) är lika med -2

Liknande funktioner
ROUND
ROUNDDOWN

8.1.10.58 SERIESSUM

Funktionen SERIESSUM() returnerar summan av en potensserie.

Returtyp: Flyttal (som 1,3, 0,343 eller 253)

Syntax

SERIESSUM( X; N; M; Koefficienter)

Parametrar
Kommentar: X är den oberoende variabeln i potensserien, Typ: Flyttal (som 1,3, 0,343 eller
253)
Kommentar: N är det ursprungliga värdet som X ska upphöjas till, Typ: Flyttal (som 1,3, 0,343
eller 253)
Kommentar: M är det inkrementella värde som N ska ökas med för varje term i serien, Typ:
Flyttal (som 1,3, 0,343 eller 253)
Kommentar: Koefficienter är mängden koefficienter som varje successiv potens av variabeln
X multipliceras med, Typ: FLOAT

Exempel

SERIESSUM(2;0;2;{1;2}) returnerar 9
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8.1.10.59 SIGN

Funktionen sign() returnerar -1 om talet är negativt, 0 om det är noll och 1 om talet är positivt.

Returtyp: Heltal (som 1, 132 eller 2344)

Syntax
SIGN(värde)

Parametrar
Kommentar: Flyttalsvärde, Typ: Flyttal (som 1,3, 0,343 eller 253)

Exempel
SIGN(5) är lika med 1

Exempel
SIGN(0) är lika med -0

Exempel
SIGN(-5) är lika med -1

8.1.10.60 SQRT

Funktionen SQRT() returnerar den ickenegativa kvadratroten ur argumentet. Det är ett fel om
argumentet är negativt.

Returtyp: Flyttal (som 1,3, 0,343 eller 253)

Syntax
SQRT(x)

Parametrar
Kommentar: Ett flyttalsvärde, Typ: Flyttal (som 1,3, 0,343 eller 253)

Exempel
SQRT(9) är lika med 3

Exempel
SQRT(-9) är felaktigt

Liknande funktioner
IMSQRT

8.1.10.61 SQRTPI

Funktionen SQRTPI() returnerar den ickenegativa kvadratroten ur x * pi. Det är ett fel om argu-
mentet är negativt.

Returtyp: Flyttal (som 1,3, 0,343 eller 253)

Syntax
SQRTPI(x)

Parametrar
Kommentar: Ett flyttalsvärde, Typ: Flyttal (som 1,3, 0,343 eller 253)

Exempel
SQRTPI(2) är lika med 2,506628
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8.1.10.62 SUBTOTAL

Funktionen SUBTOTAL() returnerar en delberäkning av en given parameterlista, och ignorerar
övriga delberäkningar som ingår i listan. Funktionen kan vara ett av följande värden: 1 - Average,
2 - Count, 3 - CountA, 4 - Max, 5 - Min, 6 - Product, 7 - StDev, 8 - StDevP, 9 - Sum, 10 - Var, 11 -
VarP.
Returtyp: Flyttal (som 1,3, 0,343 eller 253)

Syntax

SUBTOTAL(funktion; värde)

Parametrar
Kommentar: Funktion, Typ: Heltal (som 1, 132 eller 2344)
Kommentar: Värden, Typ: FLOAT

Exempel

Om A1:A5 innehåller 7, 24, 23, 56 och 9:

Exempel

SUBTOTAL(1; A1:A5) returnerar 23,8

Exempel

SUBTOTAL(4; A1:A5) returnerar 56

Exempel

SUBTOTAL(9; A1:A5) returnerar 119

Exempel

SUBTOTAL(11; A1:A5) returnerar 307,76

Liknande funktioner
AVERAGE
COUNT
COUNTA
MAX
MIN
PRODUCT
STDEV
STDEVP
SUM
VAR
VARP

8.1.10.63 SUM

Funktionen SUM() beräknar summan av alla parametervärdena. Du kan beräkna summan av ett
intervall, SUM(A1:B5), eller en lista av värden, SUM(12;5;12,5).

Returtyp: Flyttal (som 1,3, 0,343 eller 253)

Syntax

SUM(värde;värde;...)

Parametrar
Kommentar: Värden, Typ: FLOAT
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Exempel

SUM(12;5;7) är lika med 24

Exempel

SUM(12,5;2) är lika med 14,5

Liknande funktioner
SUMA
SUMSQ
SUMIF

8.1.10.64 SUMA

Funktionen SUMA() beräknar summan av alla parametervärdena. Du kan beräkna summan av
ett intervall, SUMA(A1:B5), eller en lista av värden, som SUMA(12;5;12,5). Om en parameter
innehåller text eller det booleska värdet FALSE, räknas den som 0. Om en parameter ger resultatet
TRUE, räknas den som 1.

Returtyp: Flyttal (som 1,3, 0,343 eller 253)

Syntax

SUM(värde;värde;...)

Parametrar
Kommentar: Värden, Typ: FLOAT

Exempel

SUMA(12;5;7) är lika med 24

Exempel

SUMA(12,5; 2; TRUE) är lika med 15,5

Liknande funktioner
SUM
SUMSQ

8.1.10.65 SUMIF

Funktionen SUMIF() beräknar summan av alla värden angivna som parametrar som motsvarar
kriterierna. Summeringsområdet är valfritt. Om det inte anges summeras värden i kontrollområ-
det. Längden på kontrollområdet ska vara lika med eller mindre än längden på summeringsom-
rådet.
Returtyp: Flyttal (som 1,3, 0,343 eller 253)

Syntax

SUMIF(kontrollområde;villkor;summeringsområde)

Parametrar
Kommentar: Kontrollområde, Typ: Ett område med flyttalsvärden (som 1,3; 0,343 eller 253 )
Kommentar: Kriterier, Typ: Text
Kommentar: Summeringsområde, Typ: Ett område med flyttalsvärden (som 1,3; 0,343 eller
253 )

Exempel

SUMIF(A1:A4;˝ >1˝) summerar alla värden i området A1:A4 som uppfyller villkoret >1
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Exempel

SUMIF(A1:A4;˝=0˝;B1:B4) summerar alla värden i området B1:B4 om motsvarande värden
i A1:A4 uppfyller villkoret =1

Liknande funktioner
SUM
COUNTIF

8.1.10.66 SUMSQ

Funktionen SUMSQ() beräknar summan av kvadraterna på parametervärdena. Du kan beräkna
summan av ett intervall, SUMSQ(A1:B5), eller en lista av värden, SUMSQ(12;5;12,5).

Returtyp: Flyttal (som 1,3, 0,343 eller 253)

Syntax

SUMSQ(värde;värde;...)

Parametrar
Kommentar: Värden, Typ: FLOAT

Exempel

SUMSQ(12;5;7) är lika med 218

Exempel

SUMSQ(12,5;2) är lika med 160,25

Liknande funktioner
SUM

8.1.10.67 TRANSPOSE

Returnerar den transponerade matrisen, dvs. rader och kolumner i matrisen har bytts mot
varandra.
Returtyp: Ett område med flyttalsvärden (som 1,3; 0,343 eller 253 )

Syntax

TRANSPOSE(matris)

Parametrar
Kommentar: Matris, Typ: Ett område med flyttalsvärden (som 1,3; 0,343 eller 253 )

Exempel

TRANSPOSE(A1:C3)
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8.1.10.68 TRUNC

Funktionen TRUNC() avkortar ett numeriskt värde till en viss noggrannhet. Om noggrannheten
utelämnas, antas 0.

Returtyp: Flyttal (som 1,3, 0,343 eller 253)

Syntax

TRUNC(värde, noggrannhet)

Parametrar
Kommentar: Flyttalsvärde, Typ: Flyttal (som 1,3, 0,343 eller 253)
Kommentar: Precision, Typ: Heltal (som 1, 132 eller 2344)

Exempel

TRUNC(1,2) returnerar 1

Exempel

TRUNC(213,232; 2) returnerar 213,23

Liknande funktioner
ROUND
ROUNDDOWN
ROUNDUP

8.1.11 Statistik

8.1.11.1 AVEDEV

Funktionen AVEDEV() beräknar medelvärdet av absoluta avvikelsen av en datamängd från me-
delvärdet.
Returtyp: Flyttal (som 1,3, 0,343 eller 253)

Syntax

AVEDEV(värde;värde;...)

Parametrar
Kommentar: Flyttalsvärden, Typ: Ett område med flyttalsvärden (som 1,3; 0,343 eller 253 )
Kommentar: Flyttalsvärden, Typ: Ett område med flyttalsvärden (som 1,3; 0,343 eller 253 )
Kommentar: Flyttalsvärden, Typ: Ett område med flyttalsvärden (som 1,3; 0,343 eller 253 )
Kommentar: Flyttalsvärden, Typ: Ett område med flyttalsvärden (som 1,3; 0,343 eller 253 )
Kommentar: Flyttalsvärden, Typ: Ett område med flyttalsvärden (som 1,3; 0,343 eller 253 )

Exempel

AVEDEV(11,4;17,3;21,3;25,9;40,1) returnerar 7,84

Exempel

AVEDEV(A1:A5) ...
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8.1.11.2 AVERAGE

Funktionen AVERAGE() beräknar medelvärdet av alla angivna parametrar. Du kan beräkna me-
delvärdet av ett intervall AVERAGE(A1:B5) eller en lista av värden som AVERAGE(12;5;12.5)

Returtyp: Flyttal (som 1,3, 0,343 eller 253)

Syntax

AVERAGE(värde;värde;...)

Parametrar
Kommentar: Flyttalsvärden, Typ: Ett område med flyttalsvärden (som 1,3; 0,343 eller 253 )
Kommentar: Flyttalsvärden, Typ: Ett område med flyttalsvärden (som 1,3; 0,343 eller 253 )
Kommentar: Flyttalsvärden, Typ: Ett område med flyttalsvärden (som 1,3; 0,343 eller 253 )
Kommentar: Flyttalsvärden, Typ: Ett område med flyttalsvärden (som 1,3; 0,343 eller 253 )
Kommentar: Flyttalsvärden, Typ: Ett område med flyttalsvärden (som 1,3; 0,343 eller 253 )

Exempel

AVERAGE(12;5;7) är lika med 8

Exempel

AVERAGE(12,5;2) är lika med 7,25

8.1.11.3 AVERAGEA

Funktionen AVERAGEA() beräknar medelvärdet av angivna argument. Nummer, text och logis-
ka värden tas också med i beräkningen. Om cellen innehåller text, eller argumentet utvärderas
till FALSE, så räknas det som värdet noll (0). Om argumentet utvärderas som TRUE, räknas det
som ett (1). Observera att tomma celler räknas inte.

Returtyp: Flyttal (som 1,3, 0,343 eller 253)

Syntax

AVERAGEA(värde;värde;...)

Parametrar
Kommentar: Flyttalsvärden, Typ: Ett område med flyttalsvärden (som 1,3; 0,343 eller 253 )
Kommentar: Strängvärden, Typ: Text

Exempel

AVERAGEA(11,4;17,3;˝litetext˝;25,9;40,1) är lika med 18,94

8.1.11.4 BETADIST

Funktionen BETADIST() returnerar värdet av fördelningsfunktionen för betafördelningen.

Den tredje och fjärde parametern är valfria. De anger undre och övre gräns, som annars får vär-
dena 0,0 och 1,0.

Returtyp: Flyttal (som 1,3, 0,343 eller 253)

Syntax

BETADIST(tal;alfa;beta;start;slut;[ackumulerat=TRUE])
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Parametrar
Kommentar: Nummer, Typ: Flyttal (som 1,3, 0,343 eller 253)
Kommentar: Alfaparameter, Typ: Flyttal (som 1,3, 0,343 eller 253)
Kommentar: Betaparameter, Typ: Flyttal (som 1,3, 0,343 eller 253)
Kommentar: Start, Typ: Flyttal (som 1,3, 0,343 eller 253)
Kommentar: Slut, Typ: Flyttal (som 1,3, 0,343 eller 253)
Kommentar: Ackumulerat, Typ: Ett booleskt värde (TRUE eller FALSE)

Exempel
BETADIST(0,2859;0,2606;0,8105) är lika med 0,675444

Exempel
BETADIST(0,2859;0,2606;0,8105;0,2;0,9) är lika med 0,537856

8.1.11.5 BETAINV

Funktionen BETAINV() returnerar inversen av BETADIST(x;alfa;beta;a;b;TRUE()).
Den start- och slutparametern är valfria. De anger undre och övre gräns, som annars får värdena
0,0 och 1,0.
Returtyp: Flyttal (som 1,3, 0,343 eller 253)

Syntax
BETAINV(tal;alfa;beta [; start=0 [; end=1]])

Parametrar
Kommentar: Nummer, Typ: Flyttal (som 1,3, 0,343 eller 253)
Kommentar: Alfaparameter, Typ: Flyttal (som 1,3, 0,343 eller 253)
Kommentar: Betaparameter, Typ: Flyttal (som 1,3, 0,343 eller 253)
Kommentar: Start, Typ: Flyttal (som 1,3, 0,343 eller 253)
Kommentar: Slut, Typ: Flyttal (som 1,3, 0,343 eller 253)

Exempel
BETADIST(BETAINV(0,1;3;4);3;4) är lika med 0,1

Exempel
BETADIST(BETAINV(0.3;3;4);3;4) är lika med 0,3

8.1.11.6 BINO

Funktionen BINO() returnerar binomialfördelningen.

Den första parametern är antalet försök, den andra parametern är antalet lyckade försök och
den tredje är sannolikheten att lyckas. Antalet försök ska vara fler än antalet lyckade försök och
sannolikheten att lyckas ska vara mindre än eller lika med 1.

Returtyp: Flyttal (som 1,3, 0,343 eller 253)

Syntax
BINO(försök;lyckade;sannolikhet)

Parametrar
Kommentar: Antal försök, Typ: Heltal (som 1, 132 eller 2344)
Kommentar: Antal lyckade försök, Typ: Heltal (som 1, 132 eller 2344)
Kommentar: Sannolikhet att lyckas, Typ: Dubbel

Exempel
BINO(12;9;0.8) returnerar 0.236223201
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8.1.11.7 CHIDIST

Funktionen CHDIST() returnerar sannolikhetsvärdet från den angivna chi-kvadraten att en hy-
potes är bekräftad.

CHIDIST jämför Chi-kvadrat värdet som ska anges för ett slumpmässigt urval som beräknas
från summan av (observerat värde - förväntat värde)ˆ2/förväntat värde, för alla värden med
den teoretiska Chi-kvadrat fördelningen, och avgör utgående från detta sannolikheten för fel i
hypotesen som ska provas.

Returtyp: Flyttal (som 1,3, 0,343 eller 253)

Syntax

CHIDIST(tal;frihetsgrader)

Parametrar
Kommentar: Nummer, Typ: Flyttal (som 1,3, 0,343 eller 253)
Kommentar: Frihetsgrader, Typ: Heltal (som 1, 132 eller 2344)

Exempel

CHIDIST(13,27;5) returnerar 0,021

8.1.11.8 COMBIN

Funktionen COMBIN() beräknar antalet möjliga kombinationer. Den första parametern är antalet
element. Den andra parametern är antalet element att välja. Båda parametrarna ska vara positiva,
och den första parametern ska inte vara mindre än den andra. Annars returneras ett fel.

Returtyp: Heltal (som 1, 132 eller 2344)

Syntax

COMBIN(total;valda)

Parametrar
Kommentar: Totalt antal element, Typ: Heltal (som 1, 132 eller 2344)
Kommentar: Antal element att välja, Typ: Heltal (som 1, 132 eller 2344)

Exempel

COMBIN(12;5) returnerar 792

Exempel

COMBIN(5;5) returnerar 1

8.1.11.9 COMBINA

Funktionen COMBINA() beräknar antalet möjliga kombinationer. Den första parametern är an-
talet element. Den andra parametern är antalet element att välja. Båda parametrarna ska vara
positiva, och den första parametern ska inte vara mindre än den andra. Annars returnerar funk-
tionen ett fel.
Returtyp: Heltal (som 1, 132 eller 2344)

Syntax

COMBIN(total;valda)
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Parametrar
Kommentar: Totalt antal element, Typ: Heltal (som 1, 132 eller 2344)
Kommentar: Antal element att välja, Typ: Heltal (som 1, 132 eller 2344)

Exempel

COMBIN(12;5) returnerar 792

Exempel

COMBIN(5;5) returnerar 1

8.1.11.10 CONFIDENCE

Funktionen CONFIDENCE() returnerar konfidensintervallet för medelvärdet av en population.

Parametern alfa måste vara mellan 0 och 1 (0 och 1 får inte ingå), STD måste vara positivt och
storlek måste vara större än eller lika med 1.
Returtyp: Flyttal (som 1,3, 0,343 eller 253)

Syntax

CONFIDENCE(alfa;STD;storlek)

Parametrar
Kommentar: Nivå för konfidensintervall, Typ: Flyttal (som 1,3, 0,343 eller 253)
Kommentar: Den totala populationens standardavvikelse, Typ: Flyttal (som 1,3, 0,343 eller
253)
Kommentar: Storlek av hela populationen, Typ: Heltal (som 1, 132 eller 2344)

Exempel

CONFIDENCE(0,05;1,5;100) är lika med 0,294059

8.1.11.11 CORREL

Funktionen CORREL() beräknar korrelationskoefficienten för två cellområden.

Returtyp: Flyttal (som 1,3, 0,343 eller 253)

Syntax

CORREL(område1; område2)

Parametrar
Kommentar: Ett område med cellvärden, Typ: Dubbel
Kommentar: Andra området med cellvärden, Typ: Dubbel

Exempel

CORREL(A1:A3; B1:B3)

Liknande funktioner
PEARSON
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8.1.11.12 COVAR

Funktionen COVAR() beräknar kovariansen för två cellområden.
Returtyp: Flyttal (som 1,3, 0,343 eller 253)

Syntax
COVAR(område1; område2)

Parametrar
Kommentar: Ett område med cellvärden, Typ: Dubbel
Kommentar: Andra området med cellvärden, Typ: Dubbel

Exempel
COVAR(A1:A3; B1:B3)

8.1.11.13 DEVSQ

Funktionen DEVSQ() beräknar summan av kvadraterna på avvikelser.
Returtyp: Flyttal (som 1,3, 0,343 eller 253)

Syntax
DEVSQ(värde; värde;...)

Parametrar
Kommentar: Flyttalsvärden, Typ: Dubbel
Kommentar: Flyttalsvärden, Typ: Dubbel
Kommentar: Flyttalsvärden, Typ: Dubbel
Kommentar: Flyttalsvärden, Typ: Dubbel
Kommentar: Flyttalsvärden, Typ: Dubbel

Exempel
DEVSQ(A1:A5)

Exempel
DEVSQ(21; 33; 54; 23) returnerar 684,75

8.1.11.14 EXPONDIST

Funktionen EXPONDIST() returnerar exponentialfördelningen.
Parametern lambda måste vara positiv.
Ackumulera = 0 beräknar frekvensfunktionen, ackumulera = 1 beräknar fördelningsfunktionen.
Returtyp: Flyttal (som 1,3, 0,343 eller 253)

Syntax
EXPONDIST(tal;lambda;ackumulera)

Parametrar
Kommentar: Nummer, Typ: Flyttal (som 1,3, 0,343 eller 253)
Kommentar: Lambdaparameter, Typ: Flyttal (som 1,3, 0,343 eller 253)
Kommentar: 0 = frekvensfunktion, 1 = fördelningsfunktion, Typ: Heltal (som 1, 132 eller 2344)

Exempel
EXPONDIST(3;0,5;0) är lika med 0,111565

Exempel
EXPONDIST(3;0,5;1) är lika med 0,776870
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8.1.11.15 FDIST

Funktionen FDIST() returnerar f-fördelningen.

Returtyp: Flyttal (som 1,3, 0,343 eller 253)

Syntax

FDIST(tal;frihetsgrader_1;frihetsgrader_2)

Parametrar
Kommentar: Nummer, Typ: Flyttal (som 1,3, 0,343 eller 253)
Kommentar: Frihetsgrader 1, Typ: Heltal (som 1, 132 eller 2344)
Kommentar: Frihetsgrader 2, Typ: Heltal (som 1, 132 eller 2344)

Exempel

FDIST(0,8;8;12) ger 0,61

8.1.11.16 FINV

Funktionen FINV() returnerar det unika icke-negativa talet x så att FDIST(x;r1;r2) = p.

Returtyp: Flyttal (som 1,3, 0,343 eller 253)

Syntax

FINV(tal; r1; r2)

Parametrar
Kommentar: Nummer, Typ: Flyttal (som 1,3, 0,343 eller 253)
Kommentar: Nummer r1, Typ: Heltal (som 1, 132 eller 2344)
Kommentar: Nummer r2, Typ: Heltal (som 1, 132 eller 2344)

Exempel

FDIST(FINV(0,1;3;4);3;4) är lika med 0,1

8.1.11.17 FISHER

Funktionen FISHER() returnerar Fisher-överföringsfunktionen för x och skapar en funktion nära
en normalfördelning.

Returtyp: Flyttal (som 1,3, 0,343 eller 253)

Syntax

FISHER(tal)

Parametrar
Kommentar: Nummer, Typ: Flyttal (som 1,3, 0,343 eller 253)

Exempel

FISHER(0,2859) är lika med 0,294096

Exempel

FISHER(0,8105) är lika med 1,128485
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8.1.11.18 FISHERINV

Funktionen FISHERINV() returnerar inversen av Fisher-överföringsfunktionen för x och skapar
en funktion nära en normalfördelning.

Returtyp: Flyttal (som 1,3, 0,343 eller 253)

Syntax

FISHERINV(tal)

Parametrar
Kommentar: Nummer, Typ: Flyttal (som 1,3, 0,343 eller 253)

Exempel

FISHERINV(0,2859) är lika med 0,278357

Exempel

FISHERINV(0,8105) är lika med 0,669866

8.1.11.19 FREQUENCY

Räknar antal värden i varje område angivet av gränsvärden i den andra parametern.

Värdena i den andra parametern bestämmer de övre gränserna för områdena. Den övre gränsen
ingår i områdena. Fältet som returneras är en kolumnvektor och har ett element mer än den
andra parametern. Det sista elementet representerar antalet element som är större än det sista
värdet i den andra parametern. Om den andra parametern är tom, räknas alla värden i den första
parametern.

Returtyp: Flyttal (som 1,3, 0,343 eller 253)

Syntax

FREQUENCY(Intervalldata; Intervallområden)

Parametrar
Kommentar: Flyttalsvärden som ska räknas., Typ: Ett område med flyttalsvärden (som 1,3;
0,343 eller 253 )
Kommentar: Flyttalsvärden som representerar områdenas övre gränser., Typ: Ett område
med flyttalsvärden (som 1,3; 0,343 eller 253 )

8.1.11.20 GAMMADIST

Funktionen GAMMADIST() returnerar gammafördelningen.

Om den sista parametern (ackumulera) är 0, beräknar den frekvensfunktionen. Om den är 1,
returneras fördelningensfunktionen. De första tre parametrarna måste vara positiva.

De tre första parametrarna måste vara positiva.

Returtyp: Flyttal (som 1,3, 0,343 eller 253)

Syntax

GAMMADIST(tal;alfa;beta;ackumulera)
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Parametrar
Kommentar: Nummer, Typ: Flyttal (som 1,3, 0,343 eller 253)
Kommentar: Alfaparameter, Typ: Flyttal (som 1,3, 0,343 eller 253)
Kommentar: Betaparameter, Typ: Flyttal (som 1,3, 0,343 eller 253)
Kommentar: Ackumuleringsflagga, Typ: Heltal (som 1, 132 eller 2344)

Exempel

GAMMADIST(0,758;0,1;0,35;1) är lika med 0,995450

Exempel

GAMMADIST(0,758;0,1;0,35;0) är lika med 0,017179

8.1.11.21 GAMMAINV

Funktionen GAMMAINV() returnerar det unika tal x ≥ 0 så att GAMMAINV(x;alfa;beta;TRUE())
= p.

Returtyp: Flyttal (som 1,3, 0,343 eller 253)

Syntax

GAMMAINV(tal;alfa;beta)

Parametrar
Kommentar: Nummer, Typ: Flyttal (som 1,3, 0,343 eller 253)
Kommentar: Alfaparameter, Typ: Flyttal (som 1,3, 0,343 eller 253)
Kommentar: Betaparameter, Typ: Flyttal (som 1,3, 0,343 eller 253)

Exempel

GAMMADIST(GAMMAINV(0,1;3;4);3;4) är lika med 0,1

Exempel

GAMMADIST(GAMMAINV(0,3;3;4);3;4) är lika med 0,3

8.1.11.22 GAMMALN

Funktionen GAMMALN() returnerar den naturliga logaritmen av gammafunktionen: G(x). Pa-
rametern tal måste vara positiv.

Returtyp: Flyttal (som 1,3, 0,343 eller 253)

Syntax

GAMMALN(tal)

Parametrar
Kommentar: Nummer, Typ: Flyttal (som 1,3, 0,343 eller 253)

Exempel

GAMMALN(2) returnerar 0
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8.1.11.23 GAUSS

Funktionen GAUSS() returnerar heltalsvärden av fördelningsfunktionen för normalfördelningen.

Returtyp: Flyttal (som 1,3, 0,343 eller 253)

Syntax

GAUSS(värde)

Parametrar
Kommentar: Talet som ska användas för att beräkna heltalsvärdet av normalfördelningen,
Typ: Flyttal (som 1,3, 0,343 eller 253)

Exempel

GAUSS(0,25) är lika med 0,098706

8.1.11.24 GEOMEAN

Funktionen GEOMEAN() returnerar det geometriska medelvärdet av givna argument. Detta är
samma sak som N:te roten ur produkten av termerna.

Returtyp: Flyttal (som 1,3, 0,343 eller 253)

Syntax

GEOMEAN(värde;värde;...)

Parametrar
Kommentar: Flyttalsvärden, Typ: Dubbel
Kommentar: Flyttalsvärden, Typ: Dubbel
Kommentar: Flyttalsvärden, Typ: Dubbel
Kommentar: Flyttalsvärden, Typ: Dubbel
Kommentar: Flyttalsvärden, Typ: Dubbel

Exempel

GEOMEAN(A1:A5)

Exempel

GEOMEAN(21; 33; 54; 23) returnerar 30,45886

Liknande funktioner
HARMEAN

8.1.11.25 HARMEAN

Funktionen HARMEAN() beräknar det harmoniska medelvärdet av N värden (N delat med sum-
man av värdenas invers).

Returtyp: Flyttal (som 1,3, 0,343 eller 253)

Syntax

HARMEAN(värde; värde;...)
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Parametrar
Kommentar: Flyttalsvärden, Typ: Dubbel
Kommentar: Flyttalsvärden, Typ: Dubbel
Kommentar: Flyttalsvärden, Typ: Dubbel
Kommentar: Flyttalsvärden, Typ: Dubbel
Kommentar: Flyttalsvärden, Typ: Dubbel

Exempel

HARMEAN(A1:A5)

Exempel

HARMEAN(21; 33; 54; 23) returnerar 28,588

Liknande funktioner
GEOMEAN

8.1.11.26 HYPGEOMDIST

Funktionen HYPGEOMDIST() returnerar den hypergeometriska fördelningen.

Returtyp: Flyttal (som 1,3, 0,343 eller 253)

Syntax

HYPGEOMDIST(x; n; M; N)

Parametrar
Kommentar: Antal lyckade försök i urvalet, Typ: Heltal (som 1, 132 eller 2344)
Kommentar: Antal försök, Typ: Heltal (som 1, 132 eller 2344)
Kommentar: Totalt antal lyckade försök, Typ: Heltal (som 1, 132 eller 2344)
Kommentar: Populationens storlek, Typ: Heltal (som 1, 132 eller 2344)

Exempel

HYPGEOMDIST(2; 5; 6; 20) returnerar 0,3522

8.1.11.27 INTERCEPT

Funktionen INTERCEPT() beräknar skärningen av den linjära regressionslinjen med Y-axeln.

Returtyp: Flyttal (som 1,3, 0,343 eller 253)

Syntax

INTERCEPT(y;x)

Parametrar
Kommentar: y-värden (fält), Typ: Flyttal (som 1,3, 0,343 eller 253)
Kommentar: x-värden (fält), Typ: Flyttal (som 1,3, 0,343 eller 253)
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8.1.11.28 INVBINO

Funktionen INVBINO() returnerar den negativa binomialfördelningen. Den första parametern är
antalet försök, den andra parametern är antalet misslyckade försök och den tredje är sannolikhe-
ten att misslyckas. Antalet försök ska vara fler än antalet misslyckade försök och sannolikheten
ska vara mindre än eller lika med 1.
Returtyp: Flyttal (som 1,3, 0,343 eller 253)

Syntax

INVBINO(försök;misslyckade;sannolikhet_att_misslyckas)

Parametrar
Kommentar: Antal försök, Typ: Heltal (som 1, 132 eller 2344)
Kommentar: Antal misslyckade försök, Typ: Heltal (som 1, 132 eller 2344)
Kommentar: Sannolikhet att misslyckas, Typ: Dubbel

Exempel

INVBINO(12;3;0.2) returnerar 0.236223201

8.1.11.29 KURT

Funktionen KURT() beräknar en uppskattning av en datamängds excess utan systematiskt fel.
Du måste ange minst fyra värden, annars returneras ett fel.

Returtyp: Flyttal (som 1,3, 0,343 eller 253)

Syntax

KURT(värde; värde;...)

Parametrar
Kommentar: Flyttalsvärden, Typ: Dubbel
Kommentar: Flyttalsvärden, Typ: Dubbel
Kommentar: Flyttalsvärden, Typ: Dubbel
Kommentar: Flyttalsvärden, Typ: Dubbel
Kommentar: Flyttalsvärden, Typ: Dubbel

Exempel

KURT(A1:A5)

Exempel

KURT(21; 33; 54; 23) returnerar 1,344239

Liknande funktioner
KURTP

8.1.11.30 KURTP

Funktionen KURTP() beräknar en uppskattning av en datamängds excess för en population. Du
måste ange minst fyra värden, annars returneras ett fel.

Returtyp: Flyttal (som 1,3, 0,343 eller 253)

Syntax

KURTP(värde; värde;...)
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Parametrar
Kommentar: Flyttalsvärden, Typ: Dubbel
Kommentar: Flyttalsvärden, Typ: Dubbel
Kommentar: Flyttalsvärden, Typ: Dubbel
Kommentar: Flyttalsvärden, Typ: Dubbel
Kommentar: Flyttalsvärden, Typ: Dubbel

Exempel

KURTP(A1:A5)

Exempel

KURTP(21; 33; 54; 23) returnerar -1,021

Liknande funktioner
KURT

8.1.11.31 Ännu större

Funktionen LARGE() returnerar det k största värdet i datamängden.

Returtyp: Flyttal (som 1,3, 0,343 eller 253)

Syntax

LARGE(område; k)

Parametrar
Kommentar: Ett område med cellvärden, Typ: Dubbel
Kommentar: Position (från den största), Typ: Heltal (som 1, 132 eller 2344)

Exempel

A1: 3, A2: 1, A3: 5 = > LARGE(A1:A3; 2) returnerar 3

8.1.11.32 LEGACYFDIST

Funktionen LEGACYFDIST() returnerar f-fördelningen.

Returtyp: Flyttal (som 1,3, 0,343 eller 253)

Syntax

LEGACYFDIST(tal;frihetsgrader_1;frihetsgrader_2)

Parametrar
Kommentar: Nummer, Typ: Flyttal (som 1,3, 0,343 eller 253)
Kommentar: Frihetsgrader 1, Typ: Heltal (som 1, 132 eller 2344)
Kommentar: Frihetsgrader 2, Typ: Heltal (som 1, 132 eller 2344)

Exempel

LEGACYFDIST(0,8;8;12) ger 0,61
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8.1.11.33 LOGINV

Funktionen LOGINV() beräknar inversen av logaritmiska fördelningsfunktionen för normalför-
delningen.

Returtyp: Flyttal (som 1,3, 0,343 eller 253)

Syntax
LOGINV(p; medelvärde; standardavvikelse)

Parametrar
Kommentar: Sannolikhet, Typ: Flyttal (som 1,3, 0,343 eller 253)
Kommentar: Logaritmfördelningens medelvärde, Typ: Flyttal (som 1,3, 0,343 eller 253)
Kommentar: Logaritmfördelningens standardavvikelse, Typ: Flyttal (som 1,3, 0,343 eller 253)

Exempel
LOGINV(0,1;0;1) är lika med 0,2776

8.1.11.34 LOGNORMDIST

Funktionen LOGNORMDIST() returnerar den logaritmiska fördelningsfunktionen för normal-
fördelningen.

Returtyp: Flyttal (som 1,3, 0,343 eller 253)

Syntax
LOGNORMDIST(tal;MV;STD)

Parametrar
Kommentar: Sannolikhetsvärde som ska användas för att beräkna logaritmfördelningen,
Typ: Flyttal (som 1,3, 0,343 eller 253)
Kommentar: Logaritmfördelningens medelvärde, Typ: Flyttal (som 1,3, 0,343 eller 253)
Kommentar: Logaritmfördelningens standardavvikelse, Typ: Flyttal (som 1,3, 0,343 eller 253)

Exempel
LOGNORMDIST(0,1;0;1) är lika med 0,01

8.1.11.35 MEDIAN

Funktionen MEDIAN() beräknar medianen av alla parametervärdena. Du kan beräkna medianen
av ett intervall, som MEDIAN(A1:B5), eller en lista av värden som MEDIAN(12;5;12,5). Tomma
celler anses vara noll, och celler med text ignoreras.

Returtyp: Flyttal (som 1,3, 0,343 eller 253)

Syntax
MEDIAN(värde;värde;...)

Parametrar
Kommentar: Flyttalsvärde eller område med värden, Typ: Ett område med flyttalsvärden
(som 1,3; 0,343 eller 253 )
Kommentar: Flyttalsvärden eller område med värden, Typ: Ett område med flyttalsvärden
(som 1,3; 0,343 eller 253 )
Kommentar: Flyttalsvärden eller område med värden, Typ: Ett område med flyttalsvärden
(som 1,3; 0,343 eller 253 )
Kommentar: Flyttalsvärden eller område med värden, Typ: Ett område med flyttalsvärden
(som 1,3; 0,343 eller 253 )
Kommentar: Flyttalsvärden eller område med värden, Typ: Ett område med flyttalsvärden
(som 1,3; 0,343 eller 253 )
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Exempel

MEDIAN(12; 5; 5,5) är lika med 5,5

Exempel

MEDIAN(12; 7; 8; 2) är lika med 7,5

8.1.11.36 MODE

Funktionen MODE() returnerar det oftast förekommande värdet i datamängden.

Returtyp: Flyttal (som 1,3, 0,343 eller 253)

Syntax

MODE(nummer; nummer2; ...)

Parametrar
Kommentar: Flyttal, Typ: Dubbel
Kommentar: Flyttal, Typ: Dubbel
Kommentar: Flyttal, Typ: Dubbel
Kommentar: Flyttal, Typ: Dubbel

Exempel

MODE(12; 14; 12; 15) returnerar 12

8.1.11.37 NEGBINOMDIST

Funktionen NEGBINOMDIST() returnerar den negativa binomialfördelningen.

Returtyp: Flyttal (som 1,3, 0,343 eller 253)

Syntax

NEGBINOMDIST(misslyckade; lyckade; sannolikhet att lyckas)

Parametrar
Kommentar: Antal misslyckade försök, Typ: Heltal (som 1, 132 eller 2344)
Kommentar: Antal lyckade försök, Typ: Heltal (som 1, 132 eller 2344)
Kommentar: Sannolikhet att lyckas, Typ: Dubbel

Exempel

NEGBINOMDIST(2;5;0.55) returnerar 0,152872629

8.1.11.38 NORMDIST

Funktionen NORMDIST() returnerar fördelningsfunktionen för normalfördelningen.

Tal är värdet av fördelningen som ska användas för att beräkna normalfördelningen.

MV är det linjära medelvärdet för fördelningen.

STD är standardavvikelsen för fördelningen.

K = 0 beräknar frekvensfunktion, K = 1 beräknar fördelningsfunktion.

Returtyp: Flyttal (som 1,3, 0,343 eller 253)
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Syntax

NORMDIST(tal;MV;STD;K)

Parametrar
Kommentar: Nummer, Typ: Flyttal (som 1,3, 0,343 eller 253)
Kommentar: Linjärt medelvärde för fördelningen, Typ: Flyttal (som 1,3, 0,343 eller 253)
Kommentar: Fördelningens standardavvikelse, Typ: Flyttal (som 1,3, 0,343 eller 253)
Kommentar: 0 = frekvensfunktion, 1 = fördelningsfunktion, Typ: Heltal (som 1, 132 eller 2344)

Exempel

NORMDIST(0,859;0,6;0,258;0) är lika med 0,934236

Exempel

NORMDIST(0,859;0,6;0,258;1) är lika med 0,842281

8.1.11.39 NORMINV

Funktionen NORMINV() returnerar inversen av normalfördelningen. Talet måste vara mellan 0
och 1 (0 och 1 får inte ingå) och STD måste vara positivt.

Returtyp: Flyttal (som 1,3, 0,343 eller 253)

Syntax

NORMINV(tal;MV;STD)

Parametrar
Kommentar: Sannolikhetsvärde som ska användas för att beräkna logaritmfördelningen,
Typ: Flyttal (som 1,3, 0,343 eller 253)
Kommentar: Medelvärde för normalfördelningen, Typ: Flyttal (som 1,3, 0,343 eller 253)
Kommentar: Normalfördelningens standardavvikelse, Typ: Flyttal (som 1,3, 0,343 eller 253)

Exempel

NORMINV(0,9;63;5) är lika med 69,41

8.1.11.40 NORMSDIST

Funktionen NORMSDIST() returnerar standardnormalfördelningen.

Returtyp: Flyttal (som 1,3, 0,343 eller 253)

Syntax

NORMSDIST(tal)

Parametrar
Kommentar: Värdet som normalfördelningen beräknas för, Typ: Flyttal (som 1,3, 0,343 eller
253)

Exempel

NORMSDIST(1) är lika med 0,84
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8.1.11.41 NORMSINV

Funktionen NORMSINV() returnerar inversen av fördelningsfunktionen för normalfördelning-
en. Talet måste vara mellan 0 och 1 (0 och 1 får inte ingå).

Returtyp: Flyttal (som 1,3, 0,343 eller 253)

Syntax

NORMSINV(tal)

Parametrar
Kommentar: Nummer, Typ: Flyttal (som 1,3, 0,343 eller 253)

Exempel

NORMSINV(0,908789) returnerar 1,3333

8.1.11.42 PEARSON

Funktionen PEARSON() beräknar korrelationskoefficienten för två cellområden. Den är samma
som funktionen CORREL.
Returtyp: Flyttal (som 1,3, 0,343 eller 253)

Syntax

PEARSON(område1; område2)

Parametrar
Kommentar: Ett område med cellvärden, Typ: Dubbel
Kommentar: Andra området med cellvärden, Typ: Dubbel

Exempel

PEARSON(A1:A3; B1:B3)

Liknande funktioner
CORREL

8.1.11.43 PERCENTILE

Funktionen PERCENTILE() returnerar det x:te samplade percetilen av datavärden i Data. En
percentil returnerar det skalade värdet för en dataserie, som går från det minsta (alfa = 0) till det
största värdet (alfa = 1) i en dataserie. För alfa = 25 %, betyder percentilen den första kvartilen,
alfa = 50 % är medianen. Tomma celler anses vara noll, och celler med text ignoreras.

Returtyp: Flyttal (som 1,3, 0,343 eller 253)

Syntax

PERCENTILE(data;alfa)

Parametrar
Kommentar: Intervall av värden, Typ: Ett område med flyttalsvärden (som 1,3; 0,343 eller 253
)
Kommentar: Percentilvärdet mellan 0 och 1, inklusive 0 och 1., Typ: Flyttal (som 1,3, 0,343
eller 253)

Liknande funktioner
MEDIAN
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8.1.11.44 PERMUT

Funktionen PERMUT() returnerar antalet permutationer. den första parametern är antalet ele-
ment och den andra parametern är antalet element använda i permutationen.

Returtyp: Heltal (som 1, 132 eller 2344)

Syntax

PERMUT(total;permuterade)

Parametrar
Kommentar: Totalt antal element, Typ: Heltal (som 1, 132 eller 2344)
Kommentar: Antal element att permutera, Typ: Heltal (som 1, 132 eller 2344)

Exempel

PERMUT(8;5) är lika med 6 720

Exempel

PERMUT(1;1) är lika med 1

8.1.11.45 PERMUTATIONA

Funktionen PERMUTATIONA() returnerar antalet ordnade permutationer när upprepning
tillåts. Den första parametern är antalet element och den andra parametern är antalet element
att välja. Båda parametrar måste vara positiva.

Returtyp: Heltal (som 1, 132 eller 2344)

Syntax

PERMUTATIONA(total;valda)

Parametrar
Kommentar: Totalt antal element, Typ: Heltal (som 1, 132 eller 2344)
Kommentar: Antal element att välja, Typ: Heltal (som 1, 132 eller 2344)

Exempel

PERMUTATIONA(2;3) returnerar 8

Exempel

PERMUTATIONA(0;0) returnerar 1

8.1.11.46 PHI

Funktionen PHI() returnerar värdet på fördelningsfunktionen för en normalfördelning.

Returtyp: Flyttal (som 1,3, 0,343 eller 253)

Syntax

PHI(värde)

Parametrar
Kommentar: Talet som ska användas för att beräkna normalfördelningen, Typ: Flyttal (som
1,3, 0,343 eller 253)

Exempel

PHI(0,25) är lika med 0,86668
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8.1.11.47 POISSON

Funktionen POISSON() returnerar Poissonfördelningen.
Parametrarna lambda och tal måste vara positiva.
Ackumulera = 0 beräknar frekvensfunktionen, ackumulera = 1 beräknar fördelningsfunktionen.
Returtyp: Flyttal (som 1,3, 0,343 eller 253)

Syntax
POISSON(tal;lambda;ackumulera)

Parametrar
Kommentar: Nummer, Typ: Flyttal (som 1,3, 0,343 eller 253)
Kommentar: Lambdaparametern (mittenvärdet), Typ: Flyttal (som 1,3, 0,343 eller 253)
Kommentar: 0 = frekvensfunktion, 1 = fördelningsfunktion, Typ: Heltal (som 1, 132 eller 2344)

Exempel
POISSON(60;50;0) är lika med 0,020105

Exempel
POISSON(60;50;1) är lika med 0,927840

8.1.11.48 RANK

Funktionen RANK() returnerar rangordningen av ett tal i en lista med tal.
Ordning anger hur talen rangordnas:
Om 0 eller utelämnad, rangordnas data i fallande ordning.
Om skild från 0, rangordnas data i stigande ordning.
Returtyp: Flyttal (som 1,3, 0,343 eller 253)

Syntax
RSQ(Värde; Data; Ordning)

Parametrar
Kommentar: Värde, Typ: Flyttal (som 1,3, 0,343 eller 253)
Kommentar: Data (fält), Typ: Flyttal (som 1,3, 0,343 eller 253)
Kommentar: Ordning, Typ: Flyttal (som 1,3, 0,343 eller 253)

Exempel
RANK (2;{1;2;3}) är lika med 2

8.1.11.49 RSQ

Funktionen RSQ() returnerar kvadraten av Pearson produkt-moments korrelationskoefficienten
genom datapunkter i kända y och kända x.
Om ˝fältet y˝ och ˝fältet x˝ är tomma eller har olika antal datapunkter, returneras #INTE TILL-
GÄNGLIG.
Returtyp: Flyttal (som 1,3, 0,343 eller 253)

Syntax
RSQ(kända Y; kända X)

Parametrar
Kommentar: kända y (fält), Typ: Flyttal (som 1,3, 0,343 eller 253)
Kommentar: kända x (fält), Typ: Flyttal (som 1,3, 0,343 eller 253)
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8.1.11.50 SKEW

Funktionen SKEW() returnerar en uppskattning av skevheten hos en fördelning.

Returtyp: Flyttal (som 1,3, 0,343 eller 253)

Syntax

SKEW(nummer; nummer2; ...)

Parametrar
Kommentar: Flyttal, Typ: Dubbel
Kommentar: Flyttal, Typ: Dubbel
Kommentar: Flyttal, Typ: Dubbel
Kommentar: Flyttal, Typ: Dubbel

Exempel

SKEW(11,4; 17,3; 21,3; 25,9; 40,1) returnerar 0,9768

Liknande funktioner
SKEWP

8.1.11.51 SKEWP

Funktionen SKEWP() returnerar populationens skevhet för en fördelning.

Returtyp: Flyttal (som 1,3, 0,343 eller 253)

Syntax

SKEWP(nummer; nummer2; ...)

Parametrar
Kommentar: Flyttal, Typ: Dubbel
Kommentar: Flyttal, Typ: Dubbel
Kommentar: Flyttal, Typ: Dubbel
Kommentar: Flyttal, Typ: Dubbel

Exempel

SKEWP(11,4; 17,3; 21,3; 25,9; 40,1) returnerar 0,6552

Liknande funktioner
SKEW

8.1.11.52 SLOPE

Funktionen SLOPE() beräknar lutningen av den linjära regressionslinjen.

Returtyp: Flyttal (som 1,3, 0,343 eller 253)

Syntax

SLOPE(y;x)

Parametrar
Kommentar: y-värden (fält), Typ: Flyttal (som 1,3, 0,343 eller 253)
Kommentar: x-värden (fält), Typ: Flyttal (som 1,3, 0,343 eller 253)
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8.1.11.53 SMALL

Funktionen SMALL() returnerar det k minsta värdet i datamängden.

Returtyp: Flyttal (som 1,3, 0,343 eller 253)

Syntax

SMALL(område; k)

Parametrar
Kommentar: Ett område med cellvärden, Typ: Dubbel
Kommentar: Position (från den minsta), Typ: Heltal (som 1, 132 eller 2344)

Exempel

A1: 3, A2: 1, A3: 5 = > SMALL(A1:A3; 1) returnerar 1

8.1.11.54 STANDARDIZE

Funktionen STANDARDIZE() beräknar ett normaliserat värde.

Returtyp: Flyttal (som 1,3, 0,343 eller 253)

Syntax

STANDARDIZE(x; medelvärde, standardavvikelse)

Parametrar
Kommentar: Tal som ska normaliseras, Typ: Dubbel
Kommentar: Fördelningens medelvärde, Typ: Dubbel
Kommentar: Standardavvikelse, Typ: Dubbel

Exempel

STANDARDIZE(4; 3; 7) returnerar 0,1429

8.1.11.55 STDEV

Funktionen STDEV() returnerar den uppskattade standardavvikelse baserad på ett urval. Stan-
dardavvikelsen är ett mått på hur mycket värden avviker från medelvärdet.

Returtyp: Flyttal (som 1,3, 0,343 eller 253)

Syntax

STDEV(värde;värde;...)

Parametrar
Kommentar: Flyttalsvärden, Typ: Ett område med flyttalsvärden (som 1,3; 0,343 eller 253 )
Kommentar: Flyttalsvärden, Typ: Ett område med flyttalsvärden (som 1,3; 0,343 eller 253 )
Kommentar: Flyttalsvärden, Typ: Ett område med flyttalsvärden (som 1,3; 0,343 eller 253 )
Kommentar: Flyttalsvärden, Typ: Ett område med flyttalsvärden (som 1,3; 0,343 eller 253 )
Kommentar: Flyttalsvärden, Typ: Ett område med flyttalsvärden (som 1,3; 0,343 eller 253 )

Exempel

STDEV(6;7;8) är lika med 1

Liknande funktioner
STDEVP
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8.1.11.56 STDEVA

Funktionen STDEVA() returnerar den uppskattade standardavvikelsen baserad på ett urval.
Standardavvikelsen är ett mått på hur mycket värden avviker från medelvärdet. Om en refe-
renscell innehåller text eller det booleska värdet FALSE, räknas den som 0. Om det booleska
värdet är TRUE, räknas den som 1.

Returtyp: Flyttal (som 1,3, 0,343 eller 253)

Syntax

STDEVA(värde;värde;...)

Parametrar
Kommentar: Flyttalsvärden, Typ: Ett område med flyttalsvärden (som 1,3; 0,343 eller 253 )
Kommentar: Flyttalsvärden, Typ: Ett område med flyttalsvärden (som 1,3; 0,343 eller 253 )
Kommentar: Flyttalsvärden, Typ: Ett område med flyttalsvärden (som 1,3; 0,343 eller 253 )
Kommentar: Flyttalsvärden, Typ: Ett område med flyttalsvärden (som 1,3; 0,343 eller 253 )
Kommentar: Flyttalsvärden, Typ: Ett område med flyttalsvärden (som 1,3; 0,343 eller 253 )

Exempel

STDEVA(6; 7; A1; 8) är lika med 1, om A1 är tom

Exempel

STDEVA(6; 7; A1; 8) är lika med 3,109, om A1 är TRUE

Liknande funktioner
STDEV
STDEVP

8.1.11.57 STDEVP

Funktionen STDEVP() beräknar standardavvikelsen baserad på hela populationen.

Returtyp: Flyttal (som 1,3, 0,343 eller 253)

Syntax

STDEVP(värde;värde;...)

Parametrar
Kommentar: Flyttalsvärden, Typ: Ett område med flyttalsvärden (som 1,3; 0,343 eller 253 )
Kommentar: Flyttalsvärden, Typ: Ett område med flyttalsvärden (som 1,3; 0,343 eller 253 )
Kommentar: Flyttalsvärden, Typ: Ett område med flyttalsvärden (som 1,3; 0,343 eller 253 )
Kommentar: Flyttalsvärden, Typ: Ett område med flyttalsvärden (som 1,3; 0,343 eller 253 )
Kommentar: Flyttalsvärden, Typ: Ett område med flyttalsvärden (som 1,3; 0,343 eller 253 )

Exempel

STDEVP(6;7;8) är lika med 0,816497...

Liknande funktioner
STDEV
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8.1.11.58 STDEVPA

Funktionen STDEVPA() returnerar standardavvikelsen baserad på en hel population. Om en re-
ferenscell innehåller text eller det booleska värdet FALSE, räknas den som 0. Om det booleska
värdet är TRUE, räknas den som 1.

Returtyp: Flyttal (som 1,3, 0,343 eller 253)

Syntax

STDEVPA(värde;värde;...)

Parametrar
Kommentar: Flyttalsvärden, Typ: Ett område med flyttalsvärden (som 1,3; 0,343 eller 253 )
Kommentar: Flyttalsvärden, Typ: Ett område med flyttalsvärden (som 1,3; 0,343 eller 253 )
Kommentar: Flyttalsvärden, Typ: Ett område med flyttalsvärden (som 1,3; 0,343 eller 253 )
Kommentar: Flyttalsvärden, Typ: Ett område med flyttalsvärden (som 1,3; 0,343 eller 253 )
Kommentar: Flyttalsvärden, Typ: Ett område med flyttalsvärden (som 1,3; 0,343 eller 253 )

Exempel

STDEVPA(6; 7; A1; 8) är lika med 0,816497..., om A1 är tom

Exempel

STDEVPA(6; 7; A1; 8) är lika med 2,69..., om A1 är TRUE

Exempel

STDEVPA(6; 7; A1; 8) är lika med 3,11..., om A1 är FALSE

Liknande funktioner
STDEV
STDEVP

8.1.11.59 STEYX

Funktionen STEYX() beräknar standardfelet för det predikterade Y-värdet för varje X i regressio-
nen.
Returtyp: Flyttal (som 1,3, 0,343 eller 253)

Syntax

SLOPE(y;x)

Parametrar
Kommentar: y-värden (fält), Typ: Flyttal (som 1,3, 0,343 eller 253)
Kommentar: x-värden (fält), Typ: Flyttal (som 1,3, 0,343 eller 253)

8.1.11.60 SUM2XMY

Returtyp: Flyttal (som 1,3, 0,343 eller 253)

Syntax

SLOPE(y;x)

Parametrar
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8.1.11.61 SUMPRODUCT

Funktionen SUMPRODUCT() (summa xy) beräknar summan av produkterna av elementen i två
listor (skalärprodukt). Listorna måste vara lika långa annars returneras Fel.

Returtyp: Flyttal (som 1,3, 0,343 eller 253)

Syntax

SUMPRODUCT(lista1;lista2)

Parametrar
Kommentar: Värde (lista), Typ: Dubbel
Kommentar: Värde (lista), Typ: Dubbel

Exempel

SUMPRODUCT(A1:A2;B1:B2) med A1=2, A2=5, B1=3 och B2=5 returnerar 31

8.1.11.62 SUMX2MY2

Funktionen SUMX2MY2() (summa x²-y²) beräknar differenserna mellan kvadraterna på dessa
värden. Antalet värden i de två listorna måste vara lika. Annars returnerar den här funktionen
Fel.
Returtyp: Flyttal (som 1,3, 0,343 eller 253)

Syntax

SUMX2MY2(lista1;lista2)

Parametrar
Kommentar: Värde (lista), Typ: Dubbel
Kommentar: Värde (lista), Typ: Dubbel

Exempel

SUMX2MY2(A1:A2;B1:B2) med A1=2, A2=5, B1=3 och B2=5 returnerar -5

8.1.11.63 SUMX2PY2

Funktionen SUMX2PY2() (summa x²²²²²²²²ˆ2²+yˆ2²) beräknar summan av kvadraterna på elemen-
ten i listorna. Listorna måste vara lika långa annars returneras Err.

Returtyp: Flyttal (som 1,3, 0,343 eller 253)

Syntax

SUMX2PY2(lista1;lista2)

Parametrar
Kommentar: Värde (lista), Typ: Dubbel
Kommentar: Värde (lista), Typ: Dubbel

Exempel

SUMX2PY2(A1:A2;B1:B2) med A1=2, A2=5, B1=3 och B2=5 returnerar 63
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8.1.11.64 SUMXMY2

Funktionen SUMXMY2() (SUM((X-Y)²)) returnerar kvadraten av skillnaderna av dessa värden.
Antal värden i de två fälten ska vara lika många, annars returnerar funktionen Err.

Returtyp: Flyttal (som 1,3, 0,343 eller 253)

Syntax

SUMXMY2(fält1;fält2)

Parametrar
Kommentar: Värde (lista), Typ: Dubbel
Kommentar: Värde (lista), Typ: Dubbel

Exempel

SUMXMY2(A1:A2;B1:B2) med A1=2, A2=5, B1=3 och B2=5, returnerar 1

8.1.11.65 TDIST

Funktionen TDIST() returnerar t-fördelningen.

Läge = 1 returnerar endelad test, läge = 2 returnerar tvådelad test.

Returtyp: Flyttal (som 1,3, 0,343 eller 253)

Syntax

TDIST(tal;frihetsgrader;läge)

Parametrar
Kommentar: Nummer, Typ: Flyttal (som 1,3, 0,343 eller 253)
Kommentar: Frihetsgrader för t-fördelningen, Typ: Heltal (som 1, 132 eller 2344)
Kommentar: Läge (1 eller 2), Typ: Heltal (som 1, 132 eller 2344)

Exempel

TDIST(12;5;1) returnerar 0,000035

8.1.11.66 TREND

Funktionen TREND() beräknar en följd av värden baserat på en linjär regression av kända vär-
depar.

Begränsningar: COUNT(kända_Y) = COUNT(kända_x).

Returtyp: Flyttal (som 1,3, 0,343 eller 253)

Syntax

TREND(kända_y[;kända_x[;nya_x[;tillåt-förskjutning = TRUE]]])

Parametrar
Kommentar: Kända_Y, Typ: Flyttal (som 1,3, 0,343 eller 253)
Kommentar: Kända_X, Typ: Flyttal (som 1,3, 0,343 eller 253)
Kommentar: Talföljd nya_x, Typ: Flyttal (som 1,3, 0,343 eller 253)
Kommentar: tillåt-förskjutning, Typ: Ett booleskt värde (TRUE eller FALSE)

206



Handbok Calligra Sheets

8.1.11.67 TRIMMEAN

Funktionen TRIMMEAN() beräknar medelvärdet av datamängdens bråkdelar.

Returtyp: Flyttal (som 1,3, 0,343 eller 253)

Syntax
TRIMMEAN(datamängd; brytbråkdel)

Parametrar
Kommentar: datamängd, Typ: Flyttal (som 1,3, 0,343 eller 253)
Kommentar: brytbråkdel, Typ: Flyttal (som 1,3, 0,343 eller 253)

8.1.11.68 TTEST

Funktionen TTEST() beräknar sannolikheten av ett T-prov.

Returtyp: Flyttal (som 1,3, 0,343 eller 253)

Syntax
TTEST(x; y; typ; läge)

Parametrar
Kommentar: x (fält), Typ: Flyttal (som 1,3, 0,343 eller 253)
Kommentar: y (fält), Typ: Flyttal (som 1,3, 0,343 eller 253)
Kommentar: typ, Typ: Heltal (som 1, 132 eller 2344)
Kommentar: läge, Typ: Heltal (som 1, 132 eller 2344)

8.1.11.69 VAR

Funktionen VAR() beräknar uppskattade variansen baserad på ett urval.

Returtyp: Flyttal (som 1,3, 0,343 eller 253)

Syntax
VAR(värde;värde;...)

Parametrar
Kommentar: Flyttalsvärden, Typ: Ett område med flyttalsvärden (som 1,3; 0,343 eller 253 )
Kommentar: Flyttalsvärden, Typ: Ett område med flyttalsvärden (som 1,3; 0,343 eller 253 )
Kommentar: Flyttalsvärden, Typ: Ett område med flyttalsvärden (som 1,3; 0,343 eller 253 )
Kommentar: Flyttalsvärden, Typ: Ett område med flyttalsvärden (som 1,3; 0,343 eller 253 )
Kommentar: Flyttalsvärden, Typ: Ett område med flyttalsvärden (som 1,3; 0,343 eller 253 )

Exempel
VAR(12;5;7) är lika med 13

Exempel
VAR(15;80;3) är lika med 1716,333...

Exempel
VAR(6;7;8) är lika med 1

Liknande funktioner
VARIANCE
VARA
VARP
VARPA
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8.1.11.70 VARA

Funktionen VAR() beräknar uppskattade variansen baserad på ett urval.
Returtyp: Flyttal (som 1,3, 0,343 eller 253)

Syntax
VARA(värde;värde;...)

Parametrar
Kommentar: Flyttalsvärden, Typ: Ett område med flyttalsvärden (som 1,3; 0,343 eller 253 )
Kommentar: Flyttalsvärden, Typ: Ett område med flyttalsvärden (som 1,3; 0,343 eller 253 )
Kommentar: Flyttalsvärden, Typ: Ett område med flyttalsvärden (som 1,3; 0,343 eller 253 )
Kommentar: Flyttalsvärden, Typ: Ett område med flyttalsvärden (som 1,3; 0,343 eller 253 )
Kommentar: Flyttalsvärden, Typ: Ett område med flyttalsvärden (som 1,3; 0,343 eller 253 )

Exempel
VARA(12;5;7) är lika med 13

Exempel
VARA(15;80;3) är lika med 1716,333...

Exempel
VARA(6;7;8) är lika med 1

Liknande funktioner
VAR
VARP
VARPA

8.1.11.71 VARIANCE

Funktionen VARIANCE() beräknar uppskattade variansen baserad på ett urval. Den är samma
som funktionen VAR.
Returtyp: Flyttal (som 1,3, 0,343 eller 253)

Syntax
VARIANCE(värde;värde;...)

Parametrar
Kommentar: Flyttalsvärden, Typ: Ett område med flyttalsvärden (som 1,3; 0,343 eller 253 )
Kommentar: Flyttalsvärden, Typ: Ett område med flyttalsvärden (som 1,3; 0,343 eller 253 )
Kommentar: Flyttalsvärden, Typ: Ett område med flyttalsvärden (som 1,3; 0,343 eller 253 )
Kommentar: Flyttalsvärden, Typ: Ett område med flyttalsvärden (som 1,3; 0,343 eller 253 )
Kommentar: Flyttalsvärden, Typ: Ett område med flyttalsvärden (som 1,3; 0,343 eller 253 )

Exempel
VARIANCE(12;5;7) är lika med 13

Exempel
VARIANCE(15;80;3) är lika med 1716,333...

Exempel
VARIANCE(6;7;8) är lika med 1

Liknande funktioner
VAR
VARA
VARP
VARPA
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8.1.11.72 VARP

Funktionen VARP() beräknar variansen baserad på hela populationen.
Returtyp: Flyttal (som 1,3, 0,343 eller 253)

Syntax
VARP(värde;värde;...)

Parametrar
Kommentar: Flyttalsvärden, Typ: Ett område med flyttalsvärden (som 1,3; 0,343 eller 253 )
Kommentar: Flyttalsvärden, Typ: Ett område med flyttalsvärden (som 1,3; 0,343 eller 253 )
Kommentar: Flyttalsvärden, Typ: Ett område med flyttalsvärden (som 1,3; 0,343 eller 253 )
Kommentar: Flyttalsvärden, Typ: Ett område med flyttalsvärden (som 1,3; 0,343 eller 253 )
Kommentar: Flyttalsvärden, Typ: Ett område med flyttalsvärden (som 1,3; 0,343 eller 253 )

Exempel
VARP(12;5;7) är lika med 8,666...

Exempel
VARP(15;80;3) är lika med 1144,22...

Exempel
VARP(6;7;8) är lika med 0.6666667...

Liknande funktioner
VAR
VARA
VARPA

8.1.11.73 VARPA

Funktionen VARPA() beräknar variansen baserad på en hel population. Text och booleska värde
som ger resultatet FALSE, räknas som 0. Ett booleskt värde som ger resultatet TRUE, räknas som
1.
Returtyp: Flyttal (som 1,3, 0,343 eller 253)

Syntax
VARPA(värde;värde;...)

Parametrar
Kommentar: Flyttalsvärden, Typ: Ett område med flyttalsvärden (som 1,3; 0,343 eller 253 )
Kommentar: Flyttalsvärden, Typ: Ett område med flyttalsvärden (som 1,3; 0,343 eller 253 )
Kommentar: Flyttalsvärden, Typ: Ett område med flyttalsvärden (som 1,3; 0,343 eller 253 )
Kommentar: Flyttalsvärden, Typ: Ett område med flyttalsvärden (som 1,3; 0,343 eller 253 )
Kommentar: Flyttalsvärden, Typ: Ett område med flyttalsvärden (som 1,3; 0,343 eller 253 )

Exempel
VARPA(12;5;7) är lika med 8,666...

Exempel
VARPA(15;80;3) är lika med 1144,22...

Exempel
VARPA(6;7;8) är lika med 0.6666667...

Liknande funktioner
VAR
VARA
VARP
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8.1.11.74 WEIBULL

Funktionen WEIBULL() returnerar Weibullfördelningen.

Parametrarna alfa och beta måste vara positiva, talet (den första parametern) får inte vara negativ.

Ackumulera = 0 beräknar frekvensfunktionen, ackumulera = 1 beräknar fördelningsfunktionen.

Returtyp: Flyttal (som 1,3, 0,343 eller 253)

Syntax
WEIBULL(tal;alfa;beta;ackumulera)

Parametrar
Kommentar: Nummer, Typ: Flyttal (som 1,3, 0,343 eller 253)
Kommentar: Alfaparameter, Typ: Flyttal (som 1,3, 0,343 eller 253)
Kommentar: Betaparameter, Typ: Flyttal (som 1,3, 0,343 eller 253)
Kommentar: 0 = frekvensfunktion, 1 = fördelningsfunktion, Typ: Heltal (som 1, 132 eller 2344)

Exempel
WEIBULL(2;1;1;0) är lika med 0,135335

Exempel
WEIBULL(2;1;1;1) är lika med 0,864665

8.1.11.75 ZTEST

Funktionen ZTEST() beräknar tvådelade sannolikheten av ett Z-test med normalfördelning.

Utför ett prov av nollhypotesen att Urval är ett urval från en normaldistribuerad slumpvariabel
med medelvärdet Medelvärde och standardavvikelsen Sigma. Returvärdet 1 anger att nollhypo-
tesen inte uppfylldes, dvs. urvalet är inte en slumpmässigt urval från normalfördelningen. Om
Sigma utelämnas, uppskattas den från urvalet med STDEV.

Returtyp: Flyttal (som 1,3, 0,343 eller 253)

Syntax
ZTEST(x; medelvärde; standardavvikelse)

Parametrar
Kommentar: x (fält), Typ: Flyttal (som 1,3, 0,343 eller 253)
Kommentar: medelvärde, Typ: Flyttal (som 1,3, 0,343 eller 253)
Kommentar: standardavvikelse, Typ: Flyttal (som 1,3, 0,343 eller 253)

8.1.12 Text

8.1.12.1 ASC

Funktionen ASC() returnerar tecknen med halv bredd som motsvarar argumentet med full bredd.
Returtyp: Text

Syntax
ASC(text)

Parametrar
Kommentar: Tecken med full bredd, Typ: Text

Liknande funktioner
JIS
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8.1.12.2 BAHTTEXT

Funktionen BAHTTEXT() konverterar ett värde till text med thailändska tecken (Baht).

Returtyp: Text

Syntax

BAHTTEXT(tal)

Parametrar
Kommentar: Nummer, Typ: Heltal (som 1, 132 eller 2344)

Exempel

BAHTTEXT(23) returnerar ˝&#3618;&#3637;&#3656;&#3626;&#3636;&#3610;&#3626;&#3634;&#3617;&#3610;&#3634;&#3607;&#3606;&#3657;&#3623;&#3609;˝

8.1.12.3 CHAR

Funktionen CHAR() returnerar tecknet som anges av ett nummer.

Returtyp: Text

Syntax

CHAR(kod)

Parametrar
Kommentar: Teckenkod, Typ: Heltal (som 1, 132 eller 2344)

Exempel

CHAR(65) returnerar ˝A˝

Liknande funktioner
CODE

8.1.12.4 CLEAN

Funktionen CLEAN() tar bort alla tecken som inte kan skrivas ut från strängen.

Returtyp: Text

Syntax

CLEAN(text)

Parametrar
Kommentar: Källsträng, Typ: Text

Exempel

CLEAN(AsciiToChar(7) + ˝HALLÅ˝) returnerar ˝HALLÅ˝
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8.1.12.5 CODE

Funktionen CODE() returnerar en numerisk kod för första tecknet i en textsträng.

Returtyp: Heltal (som 1, 132 eller 2344)

Syntax

CODE(text)

Parametrar
Kommentar: Text, Typ: Text

Exempel

CODE(˝KDE˝) returnerar 75

Liknande funktioner
CHAR

8.1.12.6 COMPARE

Funktionen COMPARE() returnerar 0 om dessa två strängar är lika, -1 om den första kommer
före den andra, annars 1.

Returtyp: Heltal (som 1, 132 eller 2344)

Syntax

COMPARE(sträng1; sträng2; TRUE|FALSE)

Parametrar
Kommentar: Första strängen, Typ: Text
Kommentar: Sträng att jämföra med, Typ: Text
Kommentar: Jämförelsen är skiftlägeskänslig (true/false), Typ: Ett booleskt värde (TRUE el-
ler FALSE)

Exempel

COMPARE(˝Calligra˝; ˝Calligra˝, true) returnerar 0

Exempel

COMPARE(˝calligra˝; ˝Calligra˝, true) returnerar 1

Exempel

COMPARE(˝kspread˝; ˝Calligra˝, false) returnerar 1

Liknande funktioner
EXACT

8.1.12.7 CONCATENATE

Funktionen CONCATENATE() returnerar en sträng som är resultatet av att sätta ihop de strängar
som är parametrar.

Returtyp: Text

Syntax

CONCATENATE(värde;värde;...)
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Parametrar
Kommentar: Strängvärden, Typ: Ett område med strängar
Kommentar: Strängvärden, Typ: Ett område med strängar
Kommentar: Strängvärden, Typ: Ett område med strängar
Kommentar: Strängvärden, Typ: Ett område med strängar
Kommentar: Strängvärden, Typ: Ett område med strängar

Exempel

CONCATENATE(˝Sheets˝;˝Calligra˝;˝KDE˝) returnerar ˝SheetsCalligraKDE˝

8.1.12.8 DOLLAR

Funktionen DOLLAR() konverterar ett tal till text med valutaformat, med antal decimaler avrun-
dade till angivet antal. Även om namnet är DOLLAR, så gör funktionen konverteringen enligt
aktuell landsinställning.

Returtyp: Text

Syntax

DOLLAR(nummer,siffror)

Parametrar
Kommentar: Nummer, Typ: Dubbel
Kommentar: Decimaler, Typ: Heltal (som 1, 132 eller 2344)

Exempel

DOLLAR(1403,77) returns ˝1 403,77 kr˝

Exempel

DOLLAR(-0,123;4) returns ˝-0,1230 kr˝

8.1.12.9 EXACT

Funktionen EXACT() returnerar sant om dessa två strängar är lika annars returneras falskt.

Returtyp: Ett booleskt värde (TRUE eller FALSE)

Syntax

EXACT(sträng1;sträng2)

Parametrar
Kommentar: Sträng, Typ: Text
Kommentar: Sträng, Typ: Text

Exempel

EXACT(˝Calligra˝;˝Calligra˝) returnerar True

Exempel

EXACT(˝kspread˝;˝Calligra˝) returnerar False

Liknande funktioner
COMPARE
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8.1.12.10 FIND

Funktionen FIND() hittar en textsträng (söktext) i en annan textsträng (text) och returnerar num-
ret på startpositionen av söktext, från tecknet längst till vänster i text.
Parametern startnummer anger tecknet där sökningen startar. Det första tecknet har nummer 1.
Om startnummer utelämnas, så antas det vara 1.
Du kan också använda funktionen SEARCH, men i motsats till SEARCH så är FIND storleks-
känslig och tillåter inte jokertecken.
Returtyp: Heltal (som 1, 132 eller 2344)

Syntax
FIND(söktext;text;startnummer)

Parametrar
Kommentar: Texten du vill söka efter, Typ: Text
Kommentar: Texten som kan innehålla söktext, Typ: Text
Kommentar: Anger ett index där sökningen ska starta, Typ: Heltal (som 1, 132 eller 2344)

Exempel
FIND(˝Cal˝;˝Calligra˝) returnerar 1

Exempel
FIND(˝i˝;˝Calligra˝) returnerar 4

Exempel
FIND(˝a˝;˝Sheets i Calligra˝;4) returnerar 12

Liknande funktioner
FINDB
SEARCH
REPLACE
SEARCHB
REPLACEB

8.1.12.11 FINDB

Funktionen FINDB() hittar en textsträng (söktext) i en annan textsträng (text) och returnerar num-
ret på startpositionen av söktext, från tecknet längst till vänster i text med användning av byte-
positioner.
Parametern byteposition anger tecknet där sökningen startar. Det första tecknet har nummer 2.
Om startnummer utelämnas, så antas det vara 2.
Returtyp: Heltal (som 1, 132 eller 2344)

Syntax
FINDB(söktext;text;byteposition start)

Parametrar
Kommentar: Texten du vill söka efter, Typ: Text
Kommentar: Texten som kan innehålla söktext, Typ: Text
Kommentar: Anger byte-position där sökningen ska starta, Typ: Heltal (som 1, 132 eller 2344)

Liknande funktioner
FIND
SEARCH
REPLACE
SEARCHB
REPLACEB
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8.1.12.12 FIXED

Funktionen FIXED() avrundar ett tal till det angivna antalet siffror, formaterar talet som en sträng
med decimalformat, och returnerar resultatet som text. Om siffror är negativt, så avrundas talet
till vänster om decimalkommat. Om siffror utelämnas, så antas det vara 2. Om den valfria para-
metern ingen_tusenseparator är True, så visas inte tusenseparatorn.

Returtyp: Text

Syntax

FIXED(nummer,siffror,ingen_tusenseparator)

Parametrar
Kommentar: Nummer, Typ: Dubbel
Kommentar: Decimaler, Typ: Heltal (som 1, 132 eller 2344)
Kommentar: Ingen_tusenseparator, Typ: Ett booleskt värde (TRUE eller FALSE)

Exempel

FIXED(1234,567;1) returnerar ˝1 234,6˝

Exempel

FIXED(1234.567;1;FALSE) returnerar ˝1234.6˝

Exempel

FIXED(44,332) returnerar ˝44,33˝

8.1.12.13 JIS

Funktionen JIS() returnerar tecknen med full bredd som motsvarar argumentet med halv bredd.

Returtyp: Text

Syntax

JIS(text)

Parametrar
Kommentar: Tecken med halv bredd, Typ: Text

Liknande funktioner
ASC

8.1.12.14 LEFT

Funktionen LEFT() returnerar en delsträng som består av det angivna antalet första tecknen i
strängen. Om angiven längd är större än hela strängen så returneras hela strängen. Det är ett fel
om antal tecken är mindre än 0.
Returtyp: Text

Syntax

LEFT(text;längd)

Parametrar
Kommentar: Källsträng, Typ: Text
Kommentar: Antal tecken, Typ: Heltal (som 1, 132 eller 2344)

215



Handbok Calligra Sheets

Exempel

LEFT(˝hallå˝;2) returnerar ˝ha˝

Exempel

LEFT(˝Kspread˝;10) returnerar ˝Kspread˝

Exempel

LEFT(˝Kspread˝) returnerar ˝K˝

Liknande funktioner
RIGHT
MID
RIGHTB
MIDB

8.1.12.15 LEFTB

Funktionen LEFTB() returnerar en delsträng som består av det angivna antalet första tecknen i
strängen med användning av byte-positioner. Om angiven längd är större än hela strängen så
returneras hela strängen. Det är ett fel om antal tecken är mindre än 0.

Returtyp: Text

Syntax

LEFTB(text;bytelängd)

Parametrar
Kommentar: Källsträng, Typ: Text
Kommentar: Bytelängd, Typ: Heltal (som 1, 132 eller 2344)

Liknande funktioner
RIGHT
MID
RIGHTB
MIDB

8.1.12.16 LEN

Funktionen LEN() returnerar längden på strängen.

Returtyp: Heltal (som 1, 132 eller 2344)

Syntax

LEN(text)

Parametrar
Kommentar: Sträng, Typ: Text

Exempel

LEN(˝hallå˝) returnerar 5

Exempel

LEN(˝Kspread˝) returnerar 7

Liknande funktioner
LENB
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8.1.12.17 LENB

Funktionen LENB() returnerar längden på strängen med användning av byte-positioner.

Returtyp: Heltal (som 1, 132 eller 2344)

Syntax

LENB(text)

Parametrar
Kommentar: Sträng, Typ: Text

8.1.12.18 LOWER

Funktionen LOWER() konverterar en sträng till små bokstäver.

Returtyp: Text

Syntax

LOWER(text)

Parametrar
Kommentar: Källsträng, Typ: Text

Exempel

LOWER(˝hallå˝) returnerar ˝hallå˝

Exempel

LOWER(˝HALLÅ˝) returnerar ˝hallå˝

Liknande funktioner
UPPER
TOGGLE

8.1.12.19 MID

Funktionen MID() returnerar en delsträng med längd tecken av denna sträng, och som börjar vid
angiven position.

Returtyp: Text

Syntax

MID(text;position;längd)

Parametrar
Kommentar: Källsträng, Typ: Text
Kommentar: Position, Typ: Heltal (som 1, 132 eller 2344)
Kommentar: Längd, Typ: Heltal (som 1, 132 eller 2344)

Exempel

MID(˝Calligra˝;2;3) returnerar ˝all˝

Exempel

MID(˝Calligra˝;2) returnerar ˝alligra˝
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Liknande funktioner
LEFT
RIGHT
LEFTB
RIGHTB
MIDB

8.1.12.20 MIDB

Funktionen MIDB() returnerar en delsträng med längd tecken av denna sträng, och som börjar
vid angiven position med användning av byte-positioner.

Returtyp: Text

Syntax
MIDB(text;byteposition start;bytelängd)

Parametrar
Kommentar: Källsträng, Typ: Text
Kommentar: Byteposition, Typ: Heltal (som 1, 132 eller 2344)
Kommentar: Bytelängd, Typ: Heltal (som 1, 132 eller 2344)

Liknande funktioner
LEFT
RIGHT
LEFTB
RIGHTB
MID

8.1.12.21 PROPER

Funktionen PROPER() konverterar första bokstaven i varje ord till stor bokstav och gör resten till
små bokstäver.
Returtyp: Text

Syntax
PROPER(sträng)

Parametrar
Kommentar: Sträng, Typ: Text

Exempel

PROPER(˝det här är en titel˝) returnerar ˝Det Här Är En Titel˝

8.1.12.22 REGEXP

Returnerar en del av strängen som matchar ett reguljärt uttryck. Om strängen inte matchar det
givna reguljära uttrycket, returneras värdet som anges som förval.

Om en bakåtreferens anges, returneras bakåtreferensens värde.

Om inget förvalt värde anges, antas en tom sträng. Om ingen bakåtreferens anges, antas 0 (så att
hela delen som matchar returneras).
Returtyp: Text
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Syntax
REGEXP(text; reguljärt uttryck; förval; bakåtreferens)

Parametrar
Kommentar: Söktext, Typ: Text
Kommentar: Reguljärt uttryck, Typ: Text
Kommentar: Förvalt värde (valfritt), Typ: Text
Kommentar: Bakåtreferens (valfri), Typ: Nummer

Exempel
REGEXP(˝Talet är 15.˝;˝[0-9]+˝) = ˝15˝

Exempel
REGEXP(˝15, 20, 26, 41˝;˝([0-9]+), *[0-9]+$˝;˝˝;1) = ˝26˝

8.1.12.23 REGEXPRE

Ersätter allt som matchar ett reguljärt uttryck med ersättningstexten

Returtyp: Text

Syntax
REGEXPRE(text; reguljärt uttryck; ersättning)

Parametrar
Kommentar: Söktext, Typ: Text
Kommentar: Reguljärt uttryck, Typ: Text
Kommentar: Ersättning, Typ: Text

Exempel
REGEXPRE(˝14 och 15 och 16˝;˝[0-9]+˝;˝tal˝) returerar ˝tal och tal och tal˝

8.1.12.24 REPLACE

Funktionen REPLACE() ersätter en del av en textsträng med en annan textsträng.

Returtyp: Text

Syntax
REPLACE(text;position;längd;ny_text)

Parametrar
Kommentar: Text där du vill byta några tecken, Typ: Text
Kommentar: Position för tecknen som ska ersättas, Typ: Heltal (som 1, 132 eller 2344)
Kommentar: Antal tecken som ska ersättas, Typ: Heltal (som 1, 132 eller 2344)
Kommentar: Texten som kommer att ersätta tecken i den gamla texten, Typ: Text

Exempel
REPLACE(˝abcdefghijk˝;6;5;˝-˝) returnerar ˝abcde-k˝

Exempel
REPLACE(˝2002˝;3;2;˝03˝) returnerar ˝2003˝

Liknande funktioner
FIND
MID
FINDB
MIDB
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8.1.12.25 REPLACEB

Funktionen REPLACEB() ersätter en del av en textsträng med en annan textsträng med använd-
ning av byte-positioner.

Returtyp: Text

Syntax

REPLACEB(text;byteposition;bytelängd;ny_text)

Parametrar
Kommentar: Text där du vill byta några tecken med användning av byte-position, Typ: Text
Kommentar: Byte-position för tecknen som ska ersättas, Typ: Heltal (som 1, 132 eller 2344)
Kommentar: Bytelängden för tecken som ska ersättas, Typ: Heltal (som 1, 132 eller 2344)
Kommentar: Texten som kommer att ersätta tecken i den gamla texten, Typ: Text

Liknande funktioner
FINDB
MIDB
FIND
MID

8.1.12.26 REPT

Funktionen REPT() repeterar den första parametern det antal gånger som anges av den andra pa-
rametern. Den andra parametern får inte vara negativt, och funktionen returnerar en tom sträng
om den andra parametern är noll (eller avrundas neråt till noll).

Returtyp: Text

Syntax

REPT(text;antal)

Parametrar
Kommentar: Källsträng, Typ: Text
Kommentar: Antal repetitioner, Typ: Heltal (som 1, 132 eller 2344)

Exempel

REPT(˝kspread˝;3) returnerar ˝kspreadkspreadkspread˝

Exempel

REPT(˝KSpread˝;0) returnerar ˝˝

8.1.12.27 RIGHT

Funktionen RIGHT() returnerar en delsträng som består av det angivna antalet sista tecknen i
strängen. Om angiven längd är större än hela strängen så returneras hela strängen.

Returtyp: Text

Syntax

RIGHT(text;längd)
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Parametrar
Kommentar: Källsträng, Typ: Text
Kommentar: Antal tecken, Typ: Heltal (som 1, 132 eller 2344)

Exempel

RIGHT(˝hallå˝;2) returnerar ˝lå˝

Exempel

RIGHT(˝Kspread˝;10) returnerar ˝Kspread˝

Exempel

RIGHT(˝Kspread˝) returnerar ˝d˝

Liknande funktioner
LEFT
MID
LEFTB
MIDB

8.1.12.28 RIGHTB

Funktionen RIGHTB() returnerar en delsträng som består av det angivna antalet sista tecknen i
strängen med byte-positioner. Om angiven längd är större än hela strängen så returneras hela
strängen.

Returtyp: Text

Syntax

RIGHTB(text;bytelängd)

Parametrar
Kommentar: Källsträng, Typ: Text
Kommentar: Bytelängd, Typ: Heltal (som 1, 132 eller 2344)

Liknande funktioner
LEFT
MID
LEFTB
MIDB

8.1.12.29 ROT13

Funktionen ROT13() krypterar en text genom att flytta varje tecken 13 positioner i det engelska
alfabetet. Efter bokstaven Z, börjar alfabetet igen med A (rotation).

Genom att använda krypteringsfunktionen på den resulterade texten igen, så kan du avkoda
texten.
Returtyp: Text

Syntax

ROT13(text)

Parametrar
Kommentar: Text, Typ: Text
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Exempel

ROT13(˝KSpread˝) returnerar ˝XFcernq˝

Exempel

ROT13(˝XFcernq˝) returnerar ˝KSpread˝

8.1.12.30 SEARCH

Funktionen SEARCH() hittar en textsträng (söktext) i en annan textsträng (text) och returnerar
numret på startpositionen av söktext, från tecknet längst till vänster i text.

Du kan använda jokertecken, frågetecken (?) och asterisk (*). Ett frågetecken matchar alla ensam-
ma tecken, och en asterisk matchar alla följder av tecken.

Parametern startnummer anger tecknet där sökningen startar. Det första tecknet har nummer 1.
Om startnummer utelämnas, så antas det vara 1. SEARCH skiljer inte på små och stora bokstäver.

Returtyp: Heltal (som 1, 132 eller 2344)

Syntax

SEARCH(söktext,text,startnummer)

Parametrar
Kommentar: Texten du vill söka efter, Typ: Text
Kommentar: Texten som kan innehålla söktext, Typ: Text
Kommentar: Angivet index där sökningen startar, Typ: Heltal (som 1, 132 eller 2344)

Exempel

SEARCH(˝s˝;˝Slutsatser˝;6) returns 8

Exempel

SEARCH(˝marginal˝;˝vinstmarginal˝) returns 6

Liknande funktioner
FIND
FINDB
SEARCHB

8.1.12.31 SEARCHB

Funktionen SEARCHB() hittar en textsträng (söktext) i en annan textsträng (text) och returnerar
numret på startpositionen av söktext, från tecknet längst till vänster i text med användning av
byte-positioner.

Du kan använda jokertecken, frågetecken (?) och asterisk (*). Ett frågetecken matchar alla ensam-
ma tecken, och en asterisk matchar alla följder av tecken.

Parametern byteposition anger tecknet där sökningen startar. Det första tecknet har nummer 2.
Om byteposition utelämnas, så antas det vara 2. SEARCHB skiljer inte på små och stora bokstä-
ver.
Returtyp: Heltal (som 1, 132 eller 2344)

Syntax

SEARCHB(söktext,text,byteposition start)

222



Handbok Calligra Sheets

Parametrar
Kommentar: Texten du vill söka efter, Typ: Text
Kommentar: Texten som kan innehålla söktext, Typ: Text
Kommentar: Angiven byteposition där sökningen startar, Typ: Heltal (som 1, 132 eller 2344)

Liknande funktioner
FINDB
FIND
SEARCH

8.1.12.32 SLEEK

Funktionen SLEEK() tar bort alla mellanslag från strängen.

Returtyp: Text

Syntax

SLEEK(text)

Parametrar
Kommentar: Källsträng, Typ: Text

Exempel

SLEEK(˝Det här är en text ˝) returnerar ˝Dethärärentext˝

Liknande funktioner
TRIM

8.1.12.33 SUBSTITUTE

Funktionen SUBSTITUTE() ersätter ny_text med gammal_text i en textsträng. Om förekomst
anges, så ersätts bara den förekomsten av gammal_text. Annars ersätts alla förekomster av gam-
mal_text med ny_text. Använd SUBSTITUTE när du vill ersätta särskild text, använd REPLACE
när du vill ersätta vilken text som helst på en särskild plats.

Returtyp: Text

Syntax

SUBSTITUTE(text; gammal_text; ny_text; förekomst)

Parametrar
Kommentar: Text som du vill ersätta i, Typ: Text
Kommentar: Del av texten du vill ersätta, Typ: Text
Kommentar: Ny text som kommer att ersätta, Typ: Text
Kommentar: Vilken förekomst som ska ersättas, Typ: Heltal (som 1, 132 eller 2344)

Exempel

SUBSTITUTE(˝Kostnadsdata˝;˝Kostnad˝;˝Försäljning˝) returnerar ˝Försäljningsdata˝

Exempel

SUBSTITUTE(˝Kvartal 1, 2001˝;˝1˝;˝3˝;1) returnerar ˝Kvartal 3, 2001˝

Exempel

SUBSTITUTE(˝Kvartal 1, 2001˝;˝1˝;˝3˝;4) returns ˝Kvartal 3, 2003˝
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Liknande funktioner
REPLACE
REPLACEB
FIND
FINDB

8.1.12.34 T

Funktionen T() returnerar texten som värdet anger. Om värdet är, eller refererar till text, så retur-
neras värdet. Om värdet inte refererar till text, så returnerar T tom text.

Returtyp: Text

Syntax

T(värde)

Parametrar
Kommentar: Värde, Typ: Vilket värde som helst

Exempel

T(˝Calligra˝) returnerar ˝Calligra˝

Exempel

T(1,2) returns ˝˝ (tom text)

8.1.12.35 TEXT

Funktionen TEXT() konverterar ett värde till text.

Returtyp: Text

Syntax

TEXT(värde)

Parametrar
Kommentar: Värde, Typ: Vilket värde som helst

Exempel

TEXT(1234,56) returnerar ˝1234,56˝

Exempel

TEXT(˝Kspread˝) returnerar ˝Kspread˝

8.1.12.36 TOGGLE

Funktionen TOGGLE() konverterar tecken som är skrivna med små bokstäver till stora bokstäver,
och tecken skrivna med stora bokstäver till små bokstäver.
Returtyp: Text

Syntax

TOGGLE(text)
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Parametrar
Kommentar: Källsträng, Typ: Text

Exempel

TOGGLE(˝hallå˝) returnerar ˝HALLÅ˝

Exempel

TOGGLE(˝HALLÅ˝) returnerar ˝hallå˝

Exempel

TOGGLE(˝HaLlÅ˝) returnerar ˝hAlLå˝

Liknande funktioner
UPPER
LOWER

8.1.12.37 TRIM

Funktionen TRIM() returnerar text med endast ett mellanslag mellan ord.

Returtyp: Text

Syntax

TRIM(text)

Parametrar
Kommentar: Sträng, Typ: Text

Exempel

TRIM(˝hallå Kspread ˝) returnerar ˝hallå Kspread˝

8.1.12.38 UNICHAR

Funktionen UNICHAR() returnerar tecknet som anges av en Unicode kodpunkt.

Returtyp: Text

Syntax

UNICHAR(kod)

Parametrar
Kommentar: Teckenkod, Typ: Heltal (som 1, 132 eller 2344)

Exempel

UNICHAR(65) returnerar ˝A˝

Liknande funktioner
UNICODE
CHAR
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8.1.12.39 UNICODE

Funktionen UNICODE() returnerar en Unicode kodpunkt för det första tecknet i en textsträng.

Returtyp: Heltal (som 1, 132 eller 2344)

Syntax

UNICODE(text)

Parametrar
Kommentar: Text, Typ: Text

Exempel

UNICODE(˝KDE˝) returnerar 75

Liknande funktioner
UNICHAR
CODE

8.1.12.40 UPPER

Funktionen UPPER() konverterar en sträng till stora bokstäver.

Returtyp: Text

Syntax

UPPER(text)

Parametrar
Kommentar: Källsträng, Typ: Text

Exempel

UPPER(˝hallå˝) returnerar ˝HALLÅ˝

Exempel

UPPER(˝HALLÅ˝) returnerar ˝HALLÅ˝

Liknande funktioner
LOWER
TOGGLE

8.1.12.41 VALUE

Konverterar en sträng som representerar ett värde till det riktiga värdet.

Returtyp: Dubbel

Syntax

VALUE(text)

Parametrar
Kommentar: Text, Typ: Text

Exempel

VALUE(˝14,03˝) returnerar 14,03
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8.1.13 Trigonometrisk

8.1.13.1 ACOS

Funktionen ACOS() returnerar arcus cosinus i radianer och värdet är bara matematiskt definierat
mellan 0 och PI (inklusive).

Returtyp: Flyttal (som 1,3, 0,343 eller 253)

Syntax

ACOS(flyttal)

Parametrar
Kommentar: Vinkel (radianer), Typ: Flyttal (som 1,3, 0,343 eller 253)

Exempel

ACOS(0,8) är lika med 0,6435011

Exempel

ACOS(0) är lika med 1,57079633

Liknande funktioner
COS

8.1.13.2 ACOSH

Funktionen ACOSH() beräknar arcus hyperbolisk cosinus av x; det vill säga det värde vars hy-
perboliska cosinus är x. Om absoluttalet av x är mindre än 1,0 returnerar atanh() not-a-number
(NaN) och felkod ställs in.

Returtyp: Flyttal (som 1,3, 0,343 eller 253)

Syntax

ACOSH(flyttal)

Parametrar
Kommentar: Vinkel (radianer), Typ: Flyttal (som 1,3, 0,343 eller 253)

Exempel

ACOSH(5) är lika med 2,29243167

Exempel

ACOSH(0) är lika med NaN

Liknande funktioner
COSH
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8.1.13.3 ACOT

Funktionen ACOT() returnerar arcus cotangens för ett tal.

Returtyp: Flyttal (som 1,3, 0,343 eller 253)

Syntax
ACOT(flyttal)

Parametrar
Kommentar: Vinkel (radianer), Typ: Flyttal (som 1,3, 0,343 eller 253)

Exempel
ACOT(0) är lika med 1,57079633

8.1.13.4 ASIN

Funktionen ASIN() returnerar arcus sinus i radianer och värdet är bara definierat mellan -PI/2
och PI/2 (inklusive).
Returtyp: Flyttal (som 1,3, 0,343 eller 253)

Syntax
ASIN(flyttal)

Parametrar
Kommentar: Vinkel (radianer), Typ: Flyttal (som 1,3, 0,343 eller 253)

Exempel
ASIN(0,8) är lika med 0,92729522

Exempel
ASIN(0) är lika med 0

Liknande funktioner
SIN

8.1.13.5 ASINH

Funktionen ASINH() beräknar arcus hyperbolisk sinus av x; det vill säga det värde vars hyper-
boliska sinus är x.
Returtyp: Flyttal (som 1,3, 0,343 eller 253)

Syntax
ASINH(flyttal)

Parametrar
Kommentar: Vinkel (radianer), Typ: Flyttal (som 1,3, 0,343 eller 253)

Exempel
ASINH(0,8) är lika med 0,73266826

Exempel
ASINH(0) är lika med 0

Liknande funktioner
SINH
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8.1.13.6 ATAN

Funktionen ATAN() returnerar arcus tangent i radianer och värdet är bara definierat mellan -PI/2
och PI/2 (inklusive).

Returtyp: Flyttal (som 1,3, 0,343 eller 253)

Syntax

ATAN(flyttal)

Parametrar
Kommentar: Vinkel (radianer), Typ: Flyttal (som 1,3, 0,343 eller 253)

Exempel

ATAN(0,8) är lika med 0,67474094

Exempel

ATAN(0) är lika med 0

Liknande funktioner
TAN
ATAN2

8.1.13.7 ATAN2

Denna funktion beräknar arcus tangent för variablerna x och y. Det liknar att beräkna arcus tan-
gent av y/x, förutom att tecknen på båda parametrarna används för att bestämma resultatets
kvadrant.
Returtyp: Flyttal (som 1,3, 0,343 eller 253)

Syntax

ATAN2(värde;värde)

Parametrar
Kommentar: Vinkel (radianer), Typ: Flyttal (som 1,3, 0,343 eller 253)
Kommentar: Vinkel (radianer), Typ: Flyttal (som 1,3, 0,343 eller 253)

Exempel

ATAN2(0,5;1,0) är lika med 1,107149

Exempel

ATAN2(-0,5;2,0) är lika med 1,815775

Liknande funktioner
ATAN

8.1.13.8 ATANH

Funktionen ATANH() beräknar arcus hyperbolisk tangent av x; det vill säga det värde vars hy-
perboliska tangent är x. Om absolutvärdet av x är större än 1,0 returnerar ATANH() not-a-number
(NaN).

Returtyp: Flyttal (som 1,3, 0,343 eller 253)
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Syntax
ATANH(flyttal)

Parametrar
Kommentar: Vinkel (radianer), Typ: Flyttal (som 1,3, 0,343 eller 253)

Exempel
ATANH(0,8) är lika med 1,09861229

Exempel
ATANH(0) är lika med 0

Liknande funktioner
TANH

8.1.13.9 COS

Funktionen COS() returnerar cosinus av x, där x är i radianer.
Returtyp: Flyttal (som 1,3, 0,343 eller 253)

Syntax
COS(flyttal)

Parametrar
Kommentar: Vinkel (radianer), Typ: Flyttal (som 1,3, 0,343 eller 253)

Exempel
COS(0) är lika med 1,0

Exempel
COS(PI()/2) är lika med 0

Liknande funktioner
SIN
ACOS

8.1.13.10 COSH

Funktionen COSH() returnerar hyperbolisk cosinus av x, som definieras matematiskt som (exp(x)
+ exp(-x)) / 2.

Returtyp: Flyttal (som 1,3, 0,343 eller 253)

Syntax
COSH(flyttal)

Parametrar
Kommentar: Vinkel (radianer), Typ: Flyttal (som 1,3, 0,343 eller 253)

Exempel
COSH(0,8) är lika med 1,33743495

Exempel
COSH(0) är lika med 1

Liknande funktioner
ACOSH
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8.1.13.11 CSC

Funktionen CSC() returnerar cosekant av x, där x anges i radianer.

Returtyp: Flyttal (som 1,3, 0,343 eller 253)

Syntax

CSC(flyttal)

Parametrar
Kommentar: Vinkel (radianer), Typ: Flyttal (som 1,3, 0,343 eller 253)

Exempel

CSC(PI()/2) är lika med 1

8.1.13.12 CSCH

Funktionen CSCH() returnerar hyperbolisk cosekant av x, där x anges i radianer.

Returtyp: Flyttal (som 1,3, 0,343 eller 253)

Syntax

CSCH(flyttal)

Parametrar
Kommentar: Vinkel (radianer), Typ: Flyttal (som 1,3, 0,343 eller 253)

Exempel

CSCH(PI()/2) är lika med 0.434537208...

8.1.13.13 DEGREES

Denna funktion omvandlar en vinkel i radianer till en vinkel i grader.

Returtyp: Flyttal (som 1,3, 0,343 eller 253)

Syntax

DEGREES(flyttal)

Parametrar
Kommentar: Vinkel (radianer), Typ: Flyttal (som 1,3, 0,343 eller 253)

Exempel

DEGREES(0,78) är lika med 44,69

Exempel

DEGREES(1) är lika med 57,29

Liknande funktioner
RADIANS
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8.1.13.14 PI

Funktionen PI() returnerar värdet av PI.

Returtyp: Flyttal (som 1,3, 0,343 eller 253)

Syntax

PI()

Parametrar

Exempel

PI() är lika med 3,141592654...

8.1.13.15 RADIANS

Denna funktion omvandlar en vinkel i grader till en vinkel i radianer.

Returtyp: Flyttal (som 1,3, 0,343 eller 253)

Syntax

RADIANS(flyttal)

Parametrar
Kommentar: Vinkel (grader), Typ: Flyttal (som 1,3, 0,343 eller 253)

Exempel

RADIANS(75) är lika med 1,308

Exempel

RADIANS(90) är lika med 1,5707

Liknande funktioner
DEGREES

8.1.13.16 SEC

Funktionen SEC() returnerar sekanten av x, där x anges i radianer.

Returtyp: Flyttal (som 1,3, 0,343 eller 253)

Syntax

SEC(flyttal)

Parametrar
Kommentar: Vinkel (radianer), Typ: Flyttal (som 1,3, 0,343 eller 253)

Exempel

SEC(0) är lika med 1
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8.1.13.17 SECH

Funktionen SECH() returnerar hyperbolisk sekant av x, där x anges i radianer.

Returtyp: Flyttal (som 1,3, 0,343 eller 253)

Syntax
SECH(flyttal)

Parametrar
Kommentar: Vinkel (radianer), Typ: Flyttal (som 1,3, 0,343 eller 253)

Exempel
SECH(0) är lika med 1

8.1.13.18 SIN

Funktionen SIN() returnerar sinus av x, där x är i radianer.
Returtyp: Flyttal (som 1,3, 0,343 eller 253)

Syntax
SIN(flyttal)

Parametrar
Kommentar: Vinkel (radianer), Typ: Flyttal (som 1,3, 0,343 eller 253)

Exempel
SIN(0) är lika med 0

Exempel
SIN(PI()/2) är lika med 1

Liknande funktioner
COS
ASIN

8.1.13.19 SINH

Funktionen SINH() returnerar hyperbolisk sinus av x, som definieras matematiskt som (exp(x) -
exp(-x)) / 2.

Returtyp: Flyttal (som 1,3, 0,343 eller 253)

Syntax
SINH(flyttal)

Parametrar
Kommentar: Vinkel (radianer), Typ: Flyttal (som 1,3, 0,343 eller 253)

Exempel
SINH(0,8) är lika med 0,88810598

Exempel
SINH(0) är lika med 0

Liknande funktioner
ASINH
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8.1.13.20 TAN

Funktionen TAN() returnerar tangens av x, där x är angiven i radianer.

Returtyp: Flyttal (som 1,3, 0,343 eller 253)

Syntax

TAN(flyttal)

Parametrar
Kommentar: Vinkel (radianer), Typ: Flyttal (som 1,3, 0,343 eller 253)

Exempel

TAN(0,7) är lika med 0,84228838

Exempel

TAN(0) är lika med 0

Liknande funktioner
ATAN

8.1.13.21 TANH

Funktionen TANH() returnerar hyperbolisk tangent av x, som definieras matematiskt som
sinh(x)/cosh(x).

Returtyp: Flyttal (som 1,3, 0,343 eller 253)

Syntax

TANH(flyttal)

Parametrar
Kommentar: Vinkel (radianer), Typ: Flyttal (som 1,3, 0,343 eller 253)

Exempel

TANH(0,8) är lika med 0,66403677

Exempel

TANH(0) är lika med 0

Liknande funktioner
ATANH
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Kapitel 9
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